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Preface

This document describes the steps for installing and configuring the components of
the Argus Safety Solution application.

Intended Audience

This document is intended for administrators of the Argus Safety system for
configuring Argus Safety.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

About This Book

This guide contains the following chapters:
Chapter 1, "Introduction”

Chapter 2, "Access Management"

Chapter 3, "Business Configuration"
Chapter 4, "System Configuration”
Chapter 5, "Code List Configuration"
Chapter 6, "Accessing Tools"

Chapter 7, "Using Advanced Conditions"
Chapter 8, "Best Practices"



Conventions

The following text conventions are used in this document:

Convention

Meaning

boldface

"between quotation
marks"

Note
Important
Tip

Bold Underline
ALL CAPITALS

Initial Capitals

Boldface type indicates graphical user interface elements associated
with an action such as Buttons, Dialog boxes, Check boxes, Combo
boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs, Text
boxes, etc.

Information that may appear as-is on screen, or information provided
by the user.

Information that should be noted before proceeding with the
instructions.

Important information that must be noted to ensure accurate, reliable,
or safe behavior of the system.

Information that enables easier completion of the current task or helps
in completing other tasks.

Link indicating that additional "pop-down" information is available.
Keyboard keys

Names of user interface elements, modules, applications, proper nouns,
etc.
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Introduction

Introduction

Argus Safety assists manufacturers of pharmaceuticals and devices by providing a
simple and efficient way to comply with international and domestic regulatory safety
reporting requirements. It also facilitates internal company safety surveillance by
providing tools for signal detection and for analyzing the overall safety profile of both
investigational compounds and marketed products.

Argus Safety Configuration Process Overview

To configure Argus Safety, the Administrator must follow a particular sequence of
steps. Steps that fall later in the sequence might depend on those that appear earlier. It
is, therefore, important for the Administrator to use the following flowchart as a
guideline for configuring Argus Safety.

; Gl

Ty | i B
h Carfam | Configus i Sl
» " Producs ™ Lesmes | " Geeupsand

il
Configurs Conligues
'-:'.:'v- T Cipbiodss Caees Form

Task Purpose

Configure User Sites, Groups Enter user sites, create user groups and user accounts,
and Accounts configure group and individual user access rights
Configure Products Configure Manufacturers, Ingredients, Formulations,

Dosage Units, Product Families, and Data Sheets

Configure Licenses Enter license information, countries and products associated
with the license

Configure Code List Items Configure list maintenance items that are not covered in
other topics, like Action Taken, Clinical Studies, Study
Centers, etc.
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Task Purpose

Configure Workflow Configure case workflow states and rules that determine the
transition of cases between states

Configure Regulatory Configure Regulatory Agency information and expedited

Reporting reporting rules

Configure System Options Configure miscellaneous system items like Auto-numbering,

Configure Case Form

Configure Letters

Configure Database
Common Profiles

Field Labels, etc.
Configure Case Form dictionaries, duration calculations, etc.
Create letter templates by using template placeholders

Configure the Common Profiles Table to customize the
Argus Safety application

Usage Conventions

The following conventions are used throughout this document to help you identify
specific kinds of information.

Usage Convention

Bold

"between quotation
marks"

Note: Text

Important! Text

Description

User interface elements such as Buttons, Dialog boxes, Check boxes,
Combo boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs,
Text boxes, etc.

Information that may appear as-is on screen, or information provided
by the user.

Information that should be noted before proceeding with the
instructions.

Important information that must be noted to ensure accurate,
reliable, or safe behavior of the system.

Tip: Text Information that enables easier completion of the current task or
helps in completing other tasks.
ALL CAPITALS Keyboard keys
Initial Capitals Names of user interface elements, modules, applications, proper
nouns, etc.
Getting Started

This section introduces the basic tasks for configuring Argus Safety. To get started with
the configuration process, the person responsible for configuring Argus Safety must
log on as Administrator to configure the Argus Console.

Refer to the following sections for information pertaining to:

Section

Administrator Login

Understanding
Argus Console user
interface

Topics Covered

= Logging in and out of the Argus Console

= Changing the Administrator password

= Accessing the Home Page and Online Help

Read this section for an overview of the Argus Console user interface
components.
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Argus Console Architecture

The Argus Web Administration Console has been designed to enhance ease of
navigation for the Argus end-users.

The following illustration shows the design and location of the individual components
under the main Argus Console Menu.

Note: The menu items that you can access depend on the security
permissions that are defined for your account by the administrator

ORACLE’ Argus Safaty Vieb
| ActiveCases | Worklist | CaseActions | Reports |  Local Affiliate Wilities | Dashboards || Argus Console |

System
. V . Tools
Configuration
Case Priority e
E2B gth
Ched
Field Validation

Field Labels

. Business Access
Code Lists _ oy
Configuration Management
Argus Products and
Licenses

. Sites
Studies

LAM System
Numbering

Expedited Report

Rules

System Ma
{Comm
Switc!

Users

=
3
a

Workflow
System Numbering

SMTP Configuration

Required Fields

Fields that are marked with a red flag image and associated with an orange boundary
are required fields. These fields must be filled in, to proceed with the configuration
requirements.

Standard Buttons
The standard buttons used in this console are described in the following table:

Button Description

Save Use this button to save changes associated with a section

Cancel Use this button to cancel changes associated with a section

Print Use this button to print information associated with a sub-section in a
PDE.

Delete Use this button to delete an item associated with a section

Copy Use this button to create a new editable copy of an item within a section

OK Use this button to confirm an action associated with a section
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Button Description

Yes Use this button to confirm an action associated with a section

No Use this button to cancel an action associated with a section

Help Use this button to launch the online manual for the Argus Console
Add New Use this button to add a new item associated with a section

Standard Icons

The standard icons used in this console are described in the following table:

Icon

Identifies

-

W

A required field

An item placed inside a folder in the tree-view

A closed folder containing sub-folders or nodes

An open folder displaying sub-folders or nodes

An open folder that does not contain sub-folders or nodes

A closed folder that does not contain sub-folders or nodes

An expandable or collapsible browser tree view

An option to sort columns alphabetically (when placed next to a
column header)

An item appearing under multiple categories (e.g. a user name
appearing under multiple groups)

A withdrawn license in the tree-view of licenses.
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Administrator Login

When Argus Safety is installed, an account for the Administrator is automatically
created. The installation program assigns "admin" as both the User Name and
Password for this account.

Before logging in to the Argus Console, be aware of the following;:

s If you enter an incorrect username or password three (3) consecutive times, the
system disables the Login button and displays the following message:

The login button has been disabled due to 3 consecutive incorrect entries of Username or
Password. Please refresh the page to enable the Login button.

»  The Date/Time format 24-hour used by the Web server: DD-MMM-YYYY
HH:MM:SS.

Logging In as an Administrator:

1. Enter the Argus URL in your web browser, to launch Argus Safety. The login
screen appears as shown:

oracLe  Argus Safety

HEALTH SCIENCES

Username

Password

Database
| aRoUS04 |

EErH

20-DEC-2012 13:34:30

s The modules displayed in bold text identify the modules you
have permission to access.

= Your login user ID and password are valid for all accessible Argus
modules.

2. Enter the User Name and Password to login to Argus Safety.

Note: The password is case-sensitive.

3. Select the database name from the Database list.

4. Press Enter or click Login.
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5. When the window opens, click Yes to proceed with the login.

Note: If the window does not appear, verify that your brower’s
Pop-Up blocker is disabled.

6. Click Argus Console to launch the Argus Console Administrator screen.

Note: If the window does not appear, verify that your brower’s
Pop-Up blocker is disabled.

Changing the Administrator’s Password
1. Select Utilities -> Change Password in Argus Safety.

2. The Change Password dialog opens.

A Change Password -- Webpage Dialog fz|

Change Pazzword

Password Information for admin
Old Password || |

Date Time [15-0CT-2011 18:17 |

Hew Password | |

Confirm Password | |

| Ol |- cancel |

3. Enter the current password and the new password.

Note: In case of a Single Sign-On user, the Change Password option
is not supported in Argus Safety.

4. Confirm the new password and click OK.

Logging out
1. Click Close to leave the Argus Console application.
2. Tolog out at any time from Argus Safety, click Logout.

Accessing the Home Page
To go back to the Home page, click Home. The default Home page appears.

Launching Online Help
To launch online help click Help.

Understanding Argus Console GUI

This section broadly categorizes the sections of the Argus Console GUI with their
associated descriptions.
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Section

Sub-Section

Description

Getting Started

Access Management

Business
Configuration

System
Configuration

Code Lists

Sites
Groups
Users

Product and License

Studies
Configuration

Expedited Reporting
Rules

Case Priority

Field Labels

Field Validation

LAM System
Numbering

System Management

Common Profile
Switches

Workflow

System Numbering
SMTP Configuration

Code Lists
Argus

This section provides information about new
keyboard navigation features for the Argus
Console.

This section enables the administrator to enter
and configure new user sites.

This section enables the administrator to enter
and configure new user groups.

This section enables the administrator to
configure user accounts.

This section helps in capturing Product Details
(product specifics, product licenses, products
involved in the studies.

These can be the products marketed, or under
investigation, by the company.

This section helps in capturing Study
information (study specifics, products involved
in the study licensed countries associated with
the study and the clinical references used in the
expedited reports.

This section helps in capturing Expedited
Reporting Rule configuration.

The Reporting Rules configuration feature
enables the administrator to define the reporting
rules or criteria for the cases to be qualified for
expedited reporting.

This section enables the administrator to
configure rules to determine the priority of new
cases that are entered into the system.

This section enables the administrator to change
field labels, hide and unhide fields in Case form.

This section enables the administrator to
configure field level validations for the case
form fields.

This dialog enables the administrator to specify
the case numbering preferences for LAM cases.

This section enables the configuration of
Common Profile Switches that affect the
behavior of the Argus application.

The section enables the configuration of
workflow states and rules, within the safety
department starting from initial case receipt to
case closure.

The system enables tracking of the progress of
cases between users and states of activity.

This section enables the administrator to specify
the case numbering preferences.

This screen enables the user to configure SMTP
settings.

This section helps in capturing Code List
information. Code lists appear as drop-downs in
the Argus application.
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Section Sub-Section Description

Tools E2B Length Check This screen enables the user to view the E2B
Length Check report in PDF format.
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Access Management

Access Management

Site, group, and user configuration takes place in the Access Management section of
Argus Console. Here you can add, copy or delete users, groups or sites.

Each user must be assigned to at least one group in order to determine their security
level. Each group is assigned a specific security level. This security level enables
members of the group to view, modify, or restrict access rights to various sections of
the Case Form, and so on.

The first set of steps in configuring Argus safety is to create the following exactly in
the listed order:

s Sites
s Groups
s Users

Note: The configuration must occur in the exact order specified
above.

Configuring User Sites

Addition of Sites is necessary in order to create Users because every user must be
assigned to exactly one Site. Site information can also be used in automatic numbering
of case IDs.

To configure Sites, use the Access Management --> Argus --> Sites section. The
following is an illustration of that section.

Field Descriptions
The following table lists and describes the fields on the screen.
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ORACLE’

Home Help Close

Welcome vanessa, Thursday, March 3, 2011 (AS70-DEFAULT)

Code Lists | BusinessC

A M + | y Configurati |

Tools

CODE LIST MAINTENANCE

Organized by | Code List

----- [ Lab Test Group

----- 3 Lab Test Type

----- [ Letter Configuration

----- [ Literary Citation

----- [[J Local Evaluator Comment Type
----- [ Manufacturers

----- [ Medical Status

..... [ Message Type

----- [ Nature of Event

..... [ Occupations

----- [ Package Units

..... [ Product Group

----- 3 Project ID

----- [ Reference Type

----- [ Report Media

..... [ Report Type

----- [ Reporter Information

----- [ Reporter Type

----- [ Reporting Destination

..... [ Reporting Destination Type
----- [ Routes of Administration
----- [ Study Center

----- [ Study Development Phase
{5 User Sites

B3

User Sites Filter

M Description vl Contains vl |

Field Value

| Criter ]

Total Number of Rows (2)
Description .

Common Site

Abbreviation
Cs
us

Site Type
Argus

United States Argus

[ Addmew |[ copy |[. Deete |[  Frint |

Modify User Site

¥ Description

|United States

¥ Abbreviation

us |
¥ Site Type

| Argus M
| |

Intake File Path

Protect Patient Confidentiality - Default
Protect Reporter Con ality -
Default

Bulk Report By Form (Approved
Reports) - Default

LAM Sites

Add All ==

=< Remaove All

# Printer Hame Printer Path

Defines a list of user sites (e.g. United States, s

United Kingdnm}. ?hat are a.s.'signed to Argus user |=

:incrc‘ﬂ:gz;rli‘.:‘iﬂlr:grluf user sites iz required prior — —
Field/Control Name Description
Description Enter a description of the site.
Abbreviation Enter an abbreviation of the site name. A one to four character

abbreviation is required for each site.

Site Type Select the Site Type Argus or LAM (Local Affiliate Module).
Protect Patient Protects or reveals Patient Confidentiality for the specific site.
Confidentiality -
Default
Protect Reporter Protects or reveals Reporter Confidentiality for the specific site.
Confidentiality -
Default
Bulk report By form  Allows or protects availability of the Bulk Reports by Form for the
(Approved reports) -  specific site.
Default
LAM Sites Select and add previously created LAM sites.
Site Printers The Site Printers section is used to configure site printers.
Adding User Sites

This screen helps in capturing Site information (such as user site description,
abbreviated term, site type and LAM site configuration).

Use the following procedure to add a user site.

Access Management
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1. Click Access Management->Argus->Sites.
2. In the left panel, select User Sites. The User Sites are listed in the right panel.
Tip: You can alternatively click Modify to modify an existing site.

Use Copy to make an editable copy of an existing user site.

Use Delete to delete a user site.

3. Select a User Site and click Add New.

Add New User Site
¥ Description ~ LAM sites

_ Add >>
¥ Abbreviation %< Remove |

¥ site Type hsaaiz |

<< Remove All

Intake File Path

Z  Hame Path
Protect Patient Confidentiality - Default ‘ : 1

Protect Reporter Confidentialty - Default
Bulk Report By Form (Approved Reports) - Default 2

4. Enter the user site Description.

5. Enter the user site Abbreviation.

Note: A maximum four-character abbreviation is required for each
user site.

6. Select a Site Type.

Note: Each Argus Safety user must be assigned to exactly one user
site.

You cannot change the site type from LAM to Central if the current
central site has an association with a LAM site, the current site is

associated with any user, or the current LAM site has any events
assigned to it.

7. Select the following options as required:

= Select the Protect Patient Confidentiality - Default to protect or reveal Patient
Confidentiality for this specific user site.

s Select the Protect Reporter Confidentiality - Default to protect or reveal
Reporter Confidentiality for this specific user site.

n  Select the Bulk Report by Form (Approved Reports) - Default to enable
availability of the Bulk Reports By Form for this specific site.

8. Add or remove any LAM Sites information.
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Tip: To add more LAM Sites to the Lam Sites list, use the Add>>/
Add All .options.

To delete the LAM Sites from the Lam Sites list, use the
Remove>>/Remove All options..
9. In the Site Printers section, click Add to add a site printer.

10. Enter the Name of the printer that will be displayed in the application when
referring to the printer. The name can have up to 20 characters.

11. To delete a site printer, select the printer and click Delete.

12. Click Print to print the site information, as shown below:

Site Information

Description LAM Site 1
Abbreviation LAM1 Site Type LAM

Intake File Path

O Protect Patient Confidentiality- = Protect Reporter Confidentiality- 0 Bulk Report Report By Form (Approved
Default Default Reports)-Default
Site Printers
# Name Path
1 Printer 1 Printer 1 Path
Printer 2 Printer 2 Path

2

13. In the Path textbox, enter the full path of the printer on the network. This path
name can have upto 256 characters. The specified path should be accessible from
the machine where Argus Safety Service is installed.

14. Click Save to save the information and return to the Code List Maintenance
dialog.

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Access Management
section. The filtering browser is displayed as the Code Filter List

Argus Console helps you to filter information further for the Access Management
section. Using the Code Filter List you can specify whether your search should
contain or start with specific alphabets.

For Example: The following filtering criteria enables the system to search for all User
Sites that contain A in the abbreviated term.

Field Value
Deacsigtion w || Stars win w| &
CI—
Stn Type - S
intake File Path 3 LX-1 ]

The right panel now displays the list of User Sites based on the filtering criterion.
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Configuring Groups

Each user of Argus Safety can be a member of one or more user groups. The access
rights of each user group to the menus in the user interface and specific sections of the
Case Form can be configured when the group is created.

Configuration of the user site is done using the Access Management-->Argus -->
Groups section.

Field Descriptions

The following table lists and describes the fields in the Modify Group Information
section.
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ORACLE’ Weloome vanessa, Tuesday, March 8, 2011 (As70.0erAuLT) T

GROUPS AND USERS

B Modify Group Information

Groups ~ || Group Name Email Supervisor Email
[
Contains || e ||| | Group i [ ]
E-[55 User Groups
E-ES ARGUS File @ Enabled O Disabled [2]
[ Administrator Group(21) New Case @ Enabled O Disabled

3 Investigator Group(19) New Case From Image (® Enabled O Disabled

[ RG Administrator Group(22) Open Case @ Enabled O Disabled
E-ES LOCAL AFFILIATE Save @ Enabled O Disabled

3 LAM Group(1)

General Information @ wodify O view O No Access [ Mo Access to Create Advanced Conditions
Study Information @ Wodity O view O No Access [ Mo Access to Share Advanced Conditions
Reporter Information @ wodify O view O No Access [ o Access to View and Edit SQL
Patient Information @ Wodity O view O No Access
Other Relevant History @ modify O view O No Access
Countries Selected Countries

AFGHANISTAN L Asd> |

s

ALGERIA

AMERICAN SANOA [ AddAl|

ANDORAA

ANGOLA B << Remave All

[ ———
O roducts O stucies [2seect]

SN T O -
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Field/Control Name

Description

Group Name

Email

Supervisor Email

Menus

Case Form

Advanced Condition

Listedness
Determination -
Countries

Restrictions -
Products

Restrictions - Studies

Enter a unique name for the group.

Add the group email, used for case priority notification and workflow
routing notification.

Add the Group's Supervisor Email as applicable. This e-mail address is
used to send notifications when the maximum time of a case for a
particular workflow state is exceeded.

Lists the menus and sub menus within a Case Form and allows you to
enable or disable each of them.

Lists the sections and sub sections within a Case Form and enables you
to assign the group Modify; View (Read Only); or No Access (not
visible) to each area.

Allows you to configure advanced condition settings, as applicable. The
options are: No Access to Create Advanced Conditions, No Access to
Share Advanced Conditions, No Access to View and Edit SQL.

Assigns Argus users to the group that has rights to change the
listedness determination for licenses originating in the selected
countries.

Limits the number of products that can be viewed in the trade name
lookup and non-study cases.

Limits the number of studies available for selection and the study cases
that can be viewed.

1. Click the Studies checkbox to enable the Select button

2. Click this button to view a security configuration containing a tree
view list of available items

3. Select a study family to select all its constituents

Default report (LAM Lists the expedited report forms in the drop-down list.
only)
Adding User Groups

This section enables the Administrator to configure the security levels for each work

group.

Radio buttons enable you to view the group and assign access rights for several
specific sections of the case form, menu, case workflow, and report workflow.

If a user belongs to multiple groups, the access rights for the user will be the sum-total
of the individual group access rights. Consider the following example:

John Smith is an Argus User and his profile has been added to 2 user groups with
different access level permissions for each group.

= John has access rights to the Patient Tab in one group and access rights to the
General Tab in another group.

s In this case, John will be able to access both the Patient and the General tabs of

Argus

Use the following procedure to create a user group

1. Click Access Management->Argus->Groups.

2. Select the filtering criterion to display the list of Groups or Users in the left panel.

3. Select a Group and click to view the group details in the right panel.
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ORACLE" Welcome vanessa, Tuesday, March 8, 2011 (AS70-DEFAULT) s il il o
Code Lists | Business Configuration I Access Management | System Configuration I Tools _
Argus W
GROUPS AND USERS
Bro Modify Group Information
Organized by | Groups ~ || | % Group Hame Email Supervisor Email
‘ Contains M ‘ ‘ m‘ "Qdm\mstratnr Group | | ‘ ‘ |
EHES User Groups Menus
=5 ARGUS File (@ Enabled O Disabled |
| [-C3 Administrator Group(21) New Case (%) Enabled ) Disabled
[ Investigator Group(18) New Case From Image @ Enabled O Disabled
.31 RG Administrator Group(22) Open Case () Enabled ) Disabled
Eﬁ LOCAL AFFILIATE Save (& Enabled ) Disabled M
-5 LAM Group(1) Case Form Advanced Condition
General Information & Modify O View ) No Access ‘%’ [ o Access to Create Advanced Conditions
Study Information @ modify O view O No Access [ o Access to Share Advanced Conditions
Reporter Information & Modify O View ) No Access [ o Access to View and Edit SQL
Patient Information @ modify O view O No Access
Other Relevant History =) Medify O Wiew O No Access |V
Listedness Determination
Countries Selected Countries
AFGHAMISTAN A Add =
e
ALGERIA
AMERICAN SAMOA
ANDORRA
s0ee =
Restrictions
[ products |,J Select | [ studies |,_J Select.
Adid User Save [ Add Group || Gopy. || Delete ]| Print

Tip:
= You can alternatively click Add Group to create a new group.

= Use Copy to make an editable copy of an existing group.
= Use Delete to delete a group.

Enter the Group Name. This should be a unique name associated with this Group.
Enter the Email address, if applicable.

Enter the Supervisor Email address, if applicable.

N o a &

In the Case Form section, select the desired access right option ("Modify", "View",
or "No Access") for the group's access to each of the listed items of Case Form.

Note: The following fields are required in order to save a case: Initial

Receipt Date, Country of Incidence, Report Type, Suspect Product,
and Event Description as Reported. Therefore, the group responsible

for initial case entry must have access to these fields in order to save
new cases.

8. In the Menus section, enable or disable access of the group, to particular items in

the Argus Safety menu.
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Tip: Refer to the Argus Safety User Guide for information about the
functions of the Case Form sections and the menu items in the Argus
Safety user interface.

9. In the Listedness Determination section, select a list of countries. This enables the
end user to override the listedness determination in the Event Assessment section
of the Case Form for product licenses that match the countries selected in this step.

10. In the Advanced Conditions section, select No Access to Create Advanced
Condition, No Access to Share Advanced Conditions, and/or No Access to View
and Edit SQL.

Note:

Only trusted users should be given access to Advanced

Conditions. This is because users who have this access will have
complete access to the information in the Argus Schema.

Tip:

11. In the Restrictions section, select Products.

If you select No Access to Create Advanced Condition,
Advanced Conditions does not appear as an option for that user

group.

If you select No Access to Share Advanced Conditions, the user
group does not have access to share Advanced Conditions.

If you select No Access to View and Edit SQL, the SQL... button

will not appear as an option for that user group.

12. Click Add Product, to open the Available Products dialog box.

13. Select each product you want to add and click OK.

=3 Products

[ Ca A vaccine

[ (A Activase

[ (3 Ampicilin

[] 3 Carbamazepine
[ Ca comparator

[J 3 Doxonubicin HCL
[[] 3 Doxorubicin HCL
[ Ca Glaxocover

[ (3 Ghucometer
[] LA Heart Valve

[ CaHypermeter

[] LA BUPROFEN FAMLY
[J] L3 BUPROFEN ONE
[ Cansuiin

[] Cd Naburmetone
[] (S Mudropin

[ i Nuttropin

[] L3 Oxygenator

[ L Pacemaker

[] a Piacebo

/. e

I oK ] Cancel
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14. In the Restrictions section, select Study.
15. Click Add Study, to open the Available Studies dialog box.
16. Click the appropriate checkboxes to select the required studies and click OK.

=~ Studies

1 [ Capox
-] CaraBva
-] CARET
-] CARIT

- [ L3 s0m
-] CATEG

4

| Ok ” Cancel

17. Click OK to save the group.

Groups Included with the Factory Data The following table lists and describes the groups
included with the factory data.

Group Description

Administrator This group has access rights to all areas and all the functionality of
Argus Safety.

Investigator Receives an e-mail alert that can be set up during Clinical Study
Configuration.

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Access Management
section.

Using Organized by
The system displays the filtering browser in the top-left corner of the left panel. You
can filter based on either of the two combination shown in the following illustration.

Browser

Organized by | Uzerz lv'

]

Consider the following.
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If you enable Organized by Groups, the generated output displays in a
tree-format in the left panel. The structure is based on the entire categorization of
Groups and Users

If you enable the Organized by Users, only the User list is available in the tree
view in the left panel.

Using contains or starts with enables you to specify whether your search should
contain or start with specific alphabetic characters. For example, filtering criterion
shown in the following illustration enables the system to for all Groups that contain
the word "administrator."

Browser

Organized by |Users v |4

Containg  |w

|+|||administrator |[_Fitter_|

Containz

SR B BN

Printing a User Group
Use the following procedure to print a user group.

1.
2.

Select Access Management->Argus->Groups.

Select the filtering criterion to display the list of Groups or Users (based on the
filtering criterion) in the left panel.

Select a Group and click to view the group details in the right panel.

Click Print to display a Print dialog that enables the user to choose to print the
entire window or to print only the text covered by the current selection.

AEX]

,) Frint Group

5

P\ ;
2 % Current Selection

A

[ Ok ][Cancel ]

Select the appropriate options and click OK.

The system opens the Print Groups to enable the user select the sections to be
printed in the Group Configuration printout.

By default, the Group Information checkbox is selected and disabled so that it
always gets printed.

Select the appropriate checkboxes, and click OK
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Print Groups

[] Group Information

f:| Caze Form

tenus

Listedness Determination
Advanced Condition Permissions
Restrictions - Products
Restrictions - Studies

O0O00000

Uzers

I Ok Il Cangel

Group Configuration Print Out The following is an illustration of the Group
Configuration printout.

» It lists the users which are configured to the groups.

= User are sorted alphabetically by User Full Name in the report section

Full Name User ID Site

John Smith johnz United States

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Access Management
section.

Using Organized by
The system displays the filtering browser in the top-left corner of the left panel. You
can filter based on either of the two combinations.

Consider the following.

= If you enable Organized by Groups, the generated output displays in a
tree-format in the left panel. The structure is based on the entire categorization of
Groups and Users

= If you enable the Organized by Users, only the User list is available in the tree
view in the left panel.

Using contains or starts with enables you to specify whether your search should
contain or start with specific alphabetic characters. For example, filtering criterion
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shown in the following illustration enables the system to for all Groups that contain
the word "administrator."

Configuring Users
User Maintenance enables you to add, copy, or delete users for the system.

= Each user must be assigned to at least one group in order to determine security
level.

=  Each group is assigned a specific security level that defines whether group
members can view, modify, or have no access rights to various sections of the case
form, etc.

Configuration of the users is done using the Access Management->Argus->Users
section. If the Enable LDAP Login checkbox is not checked, you can specify a

password when creating or modifying an individual user account. When updating
user records, be aware of the following;:

= Ifyou enter a value in the Password field, the system uses this password to
authenticate at login.

»  The Reset Password field is available only when you select Reset Password. The
new password can be up to 30 characters.

s Ifyouleave the value blank, the system uses the default password as defined in
the Common Profile for the system.

= When you save the user configuration, the system saves the default password you
enter.

= During entry, the system displays the password you type.

The following illustration shows the fields associated with this section.

¥ User Hame _?UserlD Email Address
Beena Wood | [bwood i |
Service User
¥ Application Access Default Application
[l argus (V] nsignt. [¥] Console Argus 5
Access |
7] Account Disabled VIForce password change at login i
- | Reset Password|
] securty Disabled Account ] Force password o expire every| |1
¥ site ¥ UserType Worklist to display at login
United States » | | ARGUS USER v =HNong- -
¥ User Group Select I};er Roles ‘ Case h,m

US Bookin | [ Alow unblinding of cases.

"] protect from unbinded information

rl Protect from printing unblinded information
[T Alow locking of cases

[ Mlow Local Locking

[ Alow Forced unlock (Global and Local

[ 7] Alow Global Unlock an Pending Local Lock
UAHuw closing of cases.

[ 7] Route on close case

V] Enable Checkist on Route

Field Descriptions

The following table lists and describes the fields in the Administrator section
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Field/Control Name

Description

User Name
User ID

Reset Password

Email Address
Site

User Group - Select
User Type
User Roles - Select

Application Access

Worklist to display at
login

Enable site security

Enable LDAP Login

Account Disabled

Security Disabled
Account

Enter the full name.
Enter a unique user identification (ID).

Reset the password of a user to a default value specified in the common
profile section.

Enter the user's e-mail address.

Assigns the user to a site.

The values in this field are populated from the codelist item User Sites.
Attaches the user to pre-configured user groups.
Select the type of user, such as an Argus J user from the drop-down list.

Attaches the user to pre-configured user roles such as Global Admin.
By default, a Global Admin role is granted to only an Administrator,
who can grant/revoke this role to other Argus users. Such a user role
should be assigned to users who need access to the Argus Global
application. Similarly, you can also select from other roles present
within User Roles.

Configure user access settings for Argus Console and Argus Safety.

The default application access for the user can be selected from the list.

Configure users to see their worklists immediately upon login. The
options are:

= None (default) - Does not open any worklist when the user logs
into Argus. Displays personal Argus status on login.

= Action Items - Opens Worklist - Action Items screen for the user on
login into Argus

= New - Opens Worklist - New screen for the user on login into
Argus

= Open - Opens Worklist - Open screen for the user on login to
Argus.

= Reports - Opens Worklist - Reports screen for the user on login into
Argus

If Enable Security is checked, the site-based data security will be enabled
for the user.

If the box is not checked, the user will have full access to data from all
sites.

Authenticates users against the active directory server.

When Enable LDAP Login is selected, all fields inside the Access
section are disabled, excluding the Account Disabled option.

When this option is selected, the user account is temporarily disabled to
prevent users from logging in. This option is different from deleting a
user as it enables the Administrator to re-activate the account at a later
date.

= When unchecked, the login procedure keeps track of the number
of consecutive unsuccessful attempts at logging into the system. If
the count reaches three, the login procedure will always fail the
password validation to lock the user out. Administrators with
rights to user maintenance can reset the login attempts for the user
to unlock the account.

= When checked, the login procedure that tracks the consecutive
unsuccessful attempts at logging into the system do not apply.
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Field/Control Name

Description

Force password
change at login

Force password to
expire every

Days
__Days remaining

Allow unblinding of
cases

Protect from
unblinded
information

Protect from printing
unblinded

information

Allow locking of
cases

Allow local locking

Allow Forced unlock
(Global and Local)

Allow Global Unlock
on Pending Local
Lock

Allow closing of
cases

Route on close case

If this check box is selected, the users must change the password the
first time user logs on to the system after the checkbox is checked.

Enables the Administrator to force the user's password to expire in the
specified number of days.

Enables the Administrator to enter the number of days after which the
password should expire.

The field displays the number of days remaining for the password
change.

Enables the user to unblind a study case.

For example, a user without unblinding rights will not see the Study
Drug field. A user with unblinding rights sees a yellow Unblind tag next
to concentration of product field and the Broken by Sponsor option in
Blinding Status drop-down list is enabled. User will have to enter
password when user selects Broken by Sponsor' option.

When checked, the user cannot view any unblinded information.

When checked, the user cannot print any unblinded information.

Enables the user, to lock/unlock the cases.

Enables the user, to locally lock/unlock a case for which local Japan
data entry/assessment is complete, triggering the scheduling and/or
generation of the applicable local reports.

Allows the user to forcibly unlock a case that been globally and/or
locally locked but pending report generation.

This option is enabled only if the Allow locking of cases checkbox
(above) is checked and only if DLP is not enabled for Expedited
Reporting.

If the Argus Console > Access Management > Users > "Allow locking of
cases" is unchecked by user or if the profile switch "DLP_EXPEDITED_

E2B_REPORTS" is set to 1 (i.e., enabled), then this option is also
unchecked and disabled.

If the profile switch "DLP_EXPEDITED_E2B_REPORTS" is set to 1 (i.e.,
DLP is enabled for Expedited Reporting), this option is not applicable.
So Case unlock occurs irrespective of this switch when DLP_
EXPEDITED_E2B_REPORTS" is set to 1.

Note that it is not expected that the system automatically updates the
new switch to unchecked and disabled for all users if the customer
updates the profile switch "DLP_EXPEDITED_E2B_REPORTS" to 1 via
backend update.

Allows users to be set up with the privilege to forcibly unlock a case
that is still pending a local lock.

This option is enabled only if the Allow locking of cases checkbox
(above) is checked.
Allows the user to close the cases.

Opens a routing dialog when the user closes the case.

Access Management 2-15



Access Management

Field/Control Name Description

Enable Checkliston By default, this checkbox is selected.

Route If this checkbox is not selected, the checklist for the Workflow is not
displayed to the user while routing the cases, even if the rule that is
being used has a checklist.

Printing Users
Use the following procedure to print users.

1. Select Access Management > Argus > Users.
2. Select a User and click to view the user details in the right panel.

3. (Click Print to display the Print User dialog.

€ | Argus Console -- Webpage Dialog m

O Print Al

Cane

4. Click OK to display list of Print User options.

€ | Argus Console - Print -- Webpage Dialog m

Access

User Group
User Roles
Case Form

Site Security

[ OK | [ cancel

5. Select the appropriate option(s) and click OK.

Access Management
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Business Configuration

About Business Configuration

This section explains the Business Configuration of the Argus Console, categorized
into the following modules:

Section Sub-Section Description

Business Products and This section helps in capturing Product

Configuration Licenses: Details such as product specifics, product
licenses and products involved in the
studies.

These can be the products marketed, or
under investigation, by the company.

Refer to the following sections for further
information on:

= Configuring Product Families
= Configuring Products

= Configuring Licenses

Studies This section helps in capturing Study
information such as study specifics, products
involved in the study licensed countries
associated with the study and the clinical
references used in the expedited reports.

Expedited Report This section helps in capturing Expedited
Rules Reporting Rule configuration.

The Reporting Rules configuration feature
enables the administrator to define the
reporting rules or criteria for the cases to be
qualified for expedited reporting.

Editable and Non-editable Business Configuration Sections

Each of the three Business Configuration sub-sections supports various views for
efficient access to data. Each view consists of a hierarchical tree-structure comprising
various nodes such as Family, Product, Licenses, and Countries.

The following table list which nodes can be edited and which cannot.
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Business
Configuration
Sub-Section Organized By Node Editable
Products and Licenses Family / Product / Licenses Family Yes
Product Yes
Licenses Yes
Product / Licenses Product Yes
Licenses Yes
License / Products License Yes
Products Yes
Countries / Licenses Countries No
Licenses No
Countries / License Type / Countries No
Licenses License Type No
Licenses No
Studies Projects / Studies / Products Projects No
Studies Yes
Products No
Studies / Products Studies No
Products No
Products / Studies Products No
Studies No
Countries / Projects / Studies Countries No
Projects No
Studies No
Expedited Report Country / License Type / Country No
Rules Reporting Rule License Type No
Reporting Rule Yes
License Type / Reporting License Type No
Destination / Reporting Rule Reporting No
Destination
Reporting Rule Yes
Responsible Group / Reporting Responsible Group ~ No
Rule Reporting Rule Yes
Inactive Rules Country No
License Type No
Reporting Rule Yes
Active Rules Country No
License Type No
Reporting Rule Yes
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Type Ahead Fields

Some fields in the Business Configuration section of Argus Console are enabled with
Type Ahead-input. This means that these fields are equipped with the ability to guess
what the user is typing.

Based on the text being entered, this feature provides suggestions for the user to
choose from.

]

¥ Ingredient Name
[S-FLUOROURACIL

EDoxycI
[ DOXYCYCLIN HYDROCHLORDE
DOXYCYCLINE
— DOXYCYCLINE CALCIUM
I DOXYCYCLINE CARRAGENATE
| DOXYCYCLINE GUAIACOLSULFONATE
{ DOXYCYCLINE HYCLATE
DOXYCYCLINE HYDROCHLORIDE
{ DOXYCYCLINE MONOHYDRATE
| DOXYCYCLINE PHOSPHATE

The following fields have the type-ahead feature:

s Clinical Reference Type (Under ClinicalStudies Configuration)
» Ingredients (Under Product Family Configuration)

= Manufacturers (Under Product and License Configuration)

= Project ID (Under Clinical Studies Configuration)

= Reporting Destination (Under Expedited Reporting Rules)

Additional Comments Fields
Be aware of the following;:

s The system has a Comments field that accommodates a maximum of 1000
characters on the Product Family, Product, and License and Study configurations.

s The Product Configuration permits a maximum of 50 characters in the PSUR
Group Name field. Multiple blank spaces between words will cause the generation
of unusable report templates.

s The License Configuration permits a maximum of 50 characters in the CTPR
Group Name. Multiple blank spaces between words will cause the generation of
unusable report templates.

s The Business Configuration report prints the Comments field, and the system
tracks any changes made to these fields in the audit log.

Configuring Product Family

Each company has a set of products to sell and a set of processes unique to its
business. The Administrator should be aware of the company business processes
and/or workflow rules. The manner of product configuration in Argus Safety will
depend on how the company handles its internal workflow related to the release of a
product.
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Details of the company's products can be added in Argus Safety using the Business
Configuration section. This feature helps end-users to retrieve details of company
products, without entering significant product information for each case.

Every company product should belong to a product family. Each product within a
product family shares the same key ingredient and data sheets but can have a different
concentration for the key ingredient.

Configuration of the product is done in the Business Configuration->Products and
Licenses section.

The following illustration shows the fields associated with this section.

Field Descriptions
The following table lists and describes the fields in this section.

Field Description

Product Family Name Enables the user to enter a new product family name.

Product Group Enables the user to select a product group name.
Ingredient Name Enables the user to select the multiple key ingredients for the product
family

= The user can sort the field alphanumerically.

= Sorting on the ingredient name in the Product Family
Configuration updates the sort order in all the products which
are part of the same family

= A maximum of 25 items are displayed as the search results in the
drop-down list.

»  The Key Ingrediens drop-down list enables the user to enter up
to 20 active ingredients for a product family.

Adding Product Families
The screen helps in capturing the Product Family information. As per the Argus data
model, the Product Family adds the Ingredients, Data Sheets, and the Product group.

Products are associated with Product families and are created using the Data Sheets,
Dosage form, Strength and unit of the corresponding Product Family. The Product
Group field in the Product Family configuration screen enables the Argus
administrator to group the product families into various Product Groups.

Use the following procedure to add a product family.
1. In the Business Configuration section, select Product and Licenses.

2. In the left panel, select a filtering criterion. The left panel now displays the tree
view of the Family based on the filtering criterion.

3. Select a Product Family and click to view the product family details in the right
panel.

Note: Ensure that you select the top-level folder to view the details
of the product family.

Product family details appear in the right panel.
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Tip:

= You can alternatively click Add Family to create a new family of
products.

s Use Copy to make an editable copy of an existing product family.
s Use Copy with Datasheets to make an editable copy of an
existing product family, along with all associated datasheets.
4. Enter the Product Family Name as applicable.

5. Select the Product Group from the drop-down list. This helps you to group the
product families into various product groups.

6. Select the required Ingredient Name(s) displayed under the Key Ingredients
section

7. Select the required Datasheet configuration.

8. Click Save to save the changes made to the Product Family.

Tip: If you have added a new Product Family, click Add Family to
save the new Product Family.

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Business Configuration
section.

Using Organized by

The filtering browser is displayed in the top-left corner of the left panel. The Products
and Licenses section can be filtered based on any of the three combinations shown in
the following illustration. Consider the following;:

= If you enable Organized by Family/Product/License, then the generated output
will be visible in a tree-format in the left panel.

= If you enable the Organized by Product/License, only the Product and License
views are available in the tree view in the left panel.

Browser
Organized by

Containes L

Family f Product f License

Family / Product / License
Froduct JLicense
License f Product

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to
search for all Family/Product/License data that contains the term Cure.
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Organized by | Family / Product / License
Cortsing % [Cure Filter

Starts with

Tip: The number displayed next to the folder indicates the number
of Products in the product family.

Creating Data Sheets

Packaged medications (like prescriptions) are marketed with an insert sheet that lists
the known contraindications (side-effects) that may occur as a consequence of taking
the product. These inserts are also referred to as data sheets. It is important to list these
effects in order to ensure accuracy in reporting. An inaccurate report could result in
the wrong action taken or bring harm to a patient.

The Listed Events & Indications from the data sheet determine the listedness of the
adverse event(s) for the case. Depending on the configured regulatory report rules, the
listedness determination will automatically schedule the expedited reports .

The data sheet in the Product Family is configured using the Business Configuration
-> Products Family section.

Field Descriptions
The following table lists the Field Descriptions for this section.

Field/Control Name Description
Rename Enables the user to rename the datasheet.
Activate Data Sheet Enables the user to activate the current data sheet. Be

aware of the following:

= When you click the checkbox, the system enables
the radio buttons next to Activate Data Sheet.

= You can either select the option to activate the data
sheet with Terms added on the current dates or on
another date entered in the Other Date field.

= Once the datasheet is activated, the system disables
the Activate Datasheet text box.

= If you enter a date greater than the current system
date, the system permits you to enable the
activation date.

Core Sheet The Core Sheet checkbox enables the user to indicate
that this data sheet is the central data sheet. This
checkbox is disabled if another data sheet is marked as
the core data sheet.
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Include

Other Date

Global /No local labeling assessment
required

Notes

Listed Term

View Revisions

The Include checkbox enables the user to indicate that
this data sheet includes the particular datasheet selected
in the drop-down list. Be aware of the following:

s The system populates the drop-down list with the
list of datasheets that do not include other data
sheets.

s The system enables the drop-down list only when
the include checkbox is checked.

If a product family has a single datasheet that is
marked 'Core’, the system disables the Include
checkbox.

This radio button is enabled if the current date is not to
be selected. Select this checkbox and enter any other
date, as required.

Checking this option automatically marks any license
using this data sheet, as assessed, and the license does
not require any local labeling assessment.

On clicking the notes icon, a pop-up appears to enable
users to enter notes while entering the details of the
Datasheet.

This field displays the listed terms (Preferred Term) for
the datasheet.

Enables users to view a list of term that were added or
removed with the added date.

The View Revisions dialog displays the datasheet revisions, as shown below:

Datasheet lame CORE

There are more than 1000 terms. Only the first 1000 are displayed, Use "Print" to view all the terms

Rev. .

Terms |added On Active On
1 Pyrexia 22-Jan-2012 22-Jan-2012
1 Nasopharyngtis | 22-Jan-2012 22-Jan-2012
1 Rash 22-Jan-2012 22-Jan-2012
2 Heaiatie | 25-an-2012 25-Jan-2012
2 * Rash | 25.Jan-2012 25-Jan-20M2
Event Group - Intestingl Disorders )
1 I Hgeusa | 22-Jan-2012 | 2242012
1 | oysgeusia | 22-danz2012 | 22012
1 | Dyspepsia ] 22-Jan-2012 | 22-Jan-2012
2 * Dysgeusia | 22-Jan-2012 | 22-san-2m12
:Lz | Loss of Taste . | 25-Jan-2012 | 25.Jan-2012
2 | Epigastiic discomfor | 25-Jan-2012 | 25-an-2012
Event Group: Skin Disorders i -
1 Yhia 22-Jan-2012 | 222012
1 Leukoderma 22-Jan-2012 | 22-tan2012

Frint_| oK
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Note: In order to facilitate optimum system performance, you can
configure a limit on the number of revised terms that get displayed. If,
for example, this value is set to 1000, the datasheet will display only
1000 revised terms in the list. This value is configurable in web.config
by using the keyname DataSheetRevisionTermCount. The default
value is 1000.

Click Print to view all other revised terms.

Use the following procedure to create a datasheet.

1. In the Datasheet section of the Product Family section, click Activate Datasheet to
activate the data sheet associated with the Product Family.

Y <o [ ovsone [ cons T ouens ]
Activate Datasheet (5 Current Date Core Sheet Include |l
) Other Date | ] Global ' Ho local labeling assessment reouined

Note: If you want to make a copy of the datasheet, click Copy.
Ensure that you enter a new name for the datasheet, if you are making
a copy of another datasheet.

2. Select the Core Sheet check box, if this data sheet is required to be the core data
sheet. Only one core data sheet is allowed per product.

3. Select the Include check box and select the value from a drop-down list. This helps
you to indicate that this data sheet includes the particular datasheet selected in the
drop-down list.

4. Select Global/No local labeling assessment required to automatically mark any
license using this data sheet as assessed.

5. Click Add Term to select the listed terms (Preferred Term) for the datasheet. The
MedDRA browser appears.

Special Category: wl
Terminology: UesDRA - Brews VED (W Search Al Levels I Full Search Limar
S0C WLGT HLY L (1R Symoryms
Gen
Metabobsm and nutiibon  Appetite snd genersl Gersder daarers | Abdomansl obesity A ancominel chesty
aorders PRATIONE] SIS P —— Cachenie
Genersl nutrisonal Defucsency ansemes
dnarders HEC Fallure to Whrive
Gereral sgny ang Feeng diaoraer
w"" ‘m"‘: feedng disorder of
wrakned tong-ciona ——
M Ehilahaod

Feedng problerm n
abnormaites ML C il

Gertal 48 weary act Feedung probler in
Eo—— 1 aowbom
Gerbourrary nespasms Geners! mutrition
=nigRancy sed gendes s orcer
unapecihes
Ganteurrary ract
Idacions aad w| Nwasheorior "
soC 10027433 Metaboimm and rutrben duorders
HLGT 10003018 Agpette #nd Qeneral rulonal JecTieny.
LT 1018087 Genersl nuirtonsl Sncroers NEC

PT 10045178 Abdomans phesly
LT

Frnt || Selea | Canaml
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The MedDRA Browser available for Datasheets enables the administrator to select
either multiple or all Preferred Terms (PTs) in the following way:

s Click the required High Level Term (HLT) and select multiple PTs by clicking
on each required PT.

OR
= Right-click the HLT to select all entities available under PT.
Select the Preferred term from the MedDRA browser and click Select.

Tip: You can alternatively click Select and Close, in the MedDRA
browser to save and exit the Product Family screen.

You can use Delete Term to delete the selected listed term(s) from the
datasheet.

Click Select from the Event Groups tab of Datasheet to select an event group. The
Event Group Selection window appears.

Press Save to save the data sheet. The Data Sheet name displays in the Data
Sheets list.

Tip: To view the revision history associated with a Datasheet, click
Revisions. A pop-up appears containing the following information:

= Rew. No: Displays the revision number of the datasheet. This
number is updated each time the data sheet is activated

s Terms: Displays all the terms that were added / removed. In case
a term has been deleted, it is marked with * against the term
name.

= Added On: Displays the date when the terms were added in the
datasheet

= Active On: Displays the date when the datasheet was made active
for that revision

Configuring Products

Each company has a set of products to sell and a set of processes that are unique to its
business.

The manner of product configuration in Argus Safety depends on how the company
handles its internal workflow, related to the release of a product. Therefore the
Administrator should be familiar with the business processes or workflow rules of the
company.

Configuration of the product is done in Business Configuration -> Products and
Licenses.

When configuring a product, be aware of the following;:

When the user clicks the Notes link on a data sheet, he/she can enter a maximum
of 2000 characters in the Preferred Terms section of a data sheet as shown in the
following illustration.

When the user clicks the Notes link, he/she can enter one note for each term.

The user can use the standard spell check function.
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If notes have been entered for the term, the system displays the Notes icon to
indicate that notes are present.

The system also prints the notes on the Product Family details.

A comments field that can contain up to 1000 characters has been added to the
Product Family/Product/License and Study configuration elements.

The Product configuration also has a 50 character PSUR Name.

The Business Configuration reports print the contents of the Comments fields.

The system tracks any updates made to the datasheets in the audit log.

The following illustration shows the fields associated with this section.

OoORACLE Velcome veena, Wednescay, January 18, 2012 (ASTON-ENTP)
B codeviss | Configuration | Access | system Configuration | Toois [N
PRODUCTS AND LICENSES
X ——
Organized By | Famiy / Product/ Licenses ¥ ||| ¥ Product Family Name k Product Group
| contains [} | [rinac ] | [testt ; [ -
T mmem r———
conbrimb s S = 7l !
B[ Famiy - Functional testing (1) CAFACETANOL
-3 Famiy 1(1) =
B[ Famdy 2(1)
-5 Famity GC (0)
ol ey e e |
#1-[23 GB Test 1NV Famiy (1) 3
1 [ Glicerieter (1) Activate Datasheet Current Date [ core sheet Include i
d). (3 Headache (1) Other Date 12-141-2012 | [] Global / No local labeling assessment required
- LSFamiyt (2) Prei | Event Groups |
- Nectropen (3 # Listed Term {Preferred Term) J T‘m—"_T—
53-8 Oxygenator (1 1 Pyrexia () lictes IJ
- Puacabo (1) 2 Hasopharyngtis (FGEERSE ) ligteg i
-2 Rabifur (1) 3| Rasn 3 lgtes l\/
B[ Rabiour (1) l 4. | Headache (i) lites v
B[ Test Product Family (1}
@13 Test Product Famiy for test (1)
B1-[33 Test Product Famiy Issue #34565 (0) " (New)
- testl i2) | [COREJ] | |
- Vitrasert (1)
- VKPR (1) ~
¢ B
_ Acd New Product | [ | sae || AcaFamity || Copr || Copywith Gatesnews || Detee || Frim

Field Descriptions
The following table lists and describes the fields in this section.

Field Name Description

Product Family Name Enables the user to enter the unique family name for the
product. The Product Family Name must be of at least five
(5) characters.

Product Group Select the product group for the product.

Ingredient Name

Datasheet

Displays the Ingredients of the Product Family to which the
Product belongs.

The user can alphanumerically sort the field.

Sorting on the ingredient name in the Product Configuration
updates the sort order in the corresponding Product Family
and all the other products which are part of the same family.

To view the description of the fields of this section, see
Creating Data Sheets.
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Field Name

Description

Preferred Terms

Event Groups

Displays the Listed Term (Preferred Term) for the product,
as described in the field description table under Creating
Data Sheets.

The Event Group, selected from the Select button >
Available Event Groups dialog, is displayed as follows:

Event Group Name in English

The event group name is displayed in the following format
for Japanese users:

Event Group Name in English (Event Group Name in
Japanese)

The count of the total number of Event Group Names
present for the case is displayed on the header of the Event
Groups tab.

For more details about Event Groups, see the section Event
Groups tab under Configuring Event Groups.

Adding Products

This screen helps in capturing Product Details (product specifics, product licenses,
products involved in the studies. These can be the products marketed, or under
investigation, by the company. Every company product should belong to a product
family. Each product within a product family shares the same key ingredient and data
sheets but can have a different concentration for the key ingredient. This data is
reflected in multiple expedited and periodic reports and case form-general
information section.

Use the following procedure to add a product.

1.
2
3.

In the Business Configuration section, select Product and Licenses.

In the left panel, select a filtering criterion.

Select a Product and click to view the product details in the right panel.

Note: Ensure that you select the second-level folder to view the

details of the product.

The details of the product appear in the right panel.

Tip:

= You can alternatively click Add Product to create a new product.

= Use Copy to make an editable copy of an existing product.

= Use Copy with Licenses to make an editable copy of an existing
product, along with all associated licenses.

Enter the Product Name and Product Abbreviation.

Enter the Dose information associated with the Ingredient Names in the Key

Ingredients section.

Select the Unit information from the drop-down list, associated with the
Ingredient Names in the Key Ingredients section.

Enter the Generic Name.
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Tip: To copy all the Key Ingredients entered in the previous section,
click Copy From Ingredients. This helps you to modify the list as
required, instead of entering all the names manually

9. Enter the Dosage Formulation.
10. Enter the Strength of the dosage and select the Units from a drop-down list.

11. Click Encode to enter the Primary Indication. This enables you to display a
primary indication for the product using either the MedDRA or the ICD-9
Dictionary.

12. Enter the Model # number associated with the product.
13. Select the Manufacturer from the drop-down list.
14. Click Select icon to select the WHO Drug Code associated with the product.
15. Enter the Company Code allotted for the product.
16. Enter the Lot# and Date associated with the Product.
Tip: You can click Add to add new Lot# numbers. If you wish to add

the current date in the Date field, use the = sign on your keyboard as a
short-cut.

17. Click Save to save the product details.

Tip: If you have added a new Product, click Add Product to save the
new Product.

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Business Configuration
section.

Using Organized by

The filtering browser displays in the top-left corner of the left panel. The Products and
Licenses section can be filtered on the basis of any of the three combinations displayed
below. Consider the following:

= If you enable Organized byFamily/Product/License, the generated output is
visible in a tree-format, in the left panel.

= If you enable Organized byProduct/License, only the Product and License views
are in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets.

For example, the filtering criterion defined in the following illustration searches for all
Family/Product/License data that contains the term Cure.

The left panel now displays the tree view of the Product Family->Product based on
the filtering criterion.

Tip: The number displayed next to the folder signifies the number of
licenses within that product.
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Configuring Licenses

Once product configuration is complete, you must create product licenses. Licenses are
issued for pre-market and post-market release of a drug, device, or vaccine.
Investigational (pre-market) licenses are issued for studies done at study centers and
marketed licenses are issued for release of product. Configuration of licenses related to
a product is a key step in the configuration of Argus Safety.

Configure licenses in the Business Configuration -> Products and Licenses section.

The following illustration shows the fields associated with this section.

Welcome shadsahe, Thuesdsy, areh 26,2010 (isor) BT St

ORACLE
W oo [ ownemnc —— [ & T ——

PRODUCTS AND LICENSES

Domorubicin HCL, 0401 [UMITED STATES) 0401
e Pre———— | | T Aveard Dute Vithdrawn Date

| | Daxerutice wov_ pann 13-FEB- 1984 20-uMU.0000
e B = | ———— [ msctogie | Vacsine. [ ot in Tradename Lookup | ot Aute Scheduled
Ceagiaying Rows 149 (49) || | Foiree [ iabeted For Singie use [ 0TC Product (IS Medasch]
|| | batasheet uRL Countries List oty
usA

¥ Authorization Country ¥ License Type

UNTED STATES ] [Markstea orug -

Datashest Hame N Ukenses Company Bem Number

e ] s

FUAEIORE Nomenclature Code Ledical Device Information

Field Descriptions

Prochuct Name | Dosage Form | Strength
Product Name.
Depruticin HCLnjection) 200

olffz

CTPR Growp lame

Comments

Save || Aooleoarse || Gogy Cuieie Frict

The following table lists the Field Descriptions for the License configuration section.

Field/Control Name

Description

Trade Name

Award Date
Withdrawn Date

Market
Authorization Holder

Biologic / Vaccine

Not in Tradename
lookup / Not
Auto-scheduled

Enables the user to enter the Trade Name under which this product(s) is
(are) authorized by this license.

Enables the user to enter the license award date for this license.

Enables the user to enter the license withdrawal date for this license.
The withdrawn date cannot be less than the award date.

Enables the user to select a manufacturer or co-marketing partner for
this license of the product.

Whether the license is for a Biologic/Vaccine (this can impact reporting
rule).

If this is option is checked MedWatch will print PLA# not NDA# in
section G5. It is included to support the Biologic License Application
(BLA) and the Product License Application (PLA) requirements.

An option to indicate that this license name should not appear in the
filter criteria for Auto Scheduling of Reports or trade name lookup
browser.

When this checkbox is checked, the trade name will not appear for this
license in the Trade Name Lookup dialog and this license will not be
evaluated or allowed for auto scheduling of the reports, but will be
available for manual scheduling of reports.

The license will be displayed in event assessment.
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Field/Control Name

Description

Labeled for Single
Use

OTC Product (US
MedWatch)
Datasheet URL

Authorization
Country

License Type

Datasheet Name

Application Type
License #

Company Item
Number

Countries List

Product Name

Hide

PMA /510(k)#

Nomenclature Code

Whether the drug is for single use (such as disposables)
If this option is selected it will mark YES in section H5 of the MedWatch
device form, otherwise it will mark NO.

This enables the user to specify if the Product has been bought as an
Over-the-Counter Product.

User can enter a hyperlink to a site giving information about the
datasheet of the product.

This enables the user to select the Country for which this license
applies.

The chosen country does not impact the reporting rules algorithm. This
field maps to the Country' field in the Reporting rules configuration.

The user can select one of the possible six types:

Investigational Drug/Device/Vaccine or Marketed
Drug/Device/Vaccine

The chosen license type maps to the License type field under each
country on the Reporting rules configuration.

The datasheet drop-down enables the user to associate a datasheet with
the License.

The field lists the datasheets for all the product families of the added
products.

The Data Sheet drop-down is enabled when one or more products have
been added to the Products list.

Enables the user to license application type such as IND, NDA, STN etc.
Enables the user to enter the License Number of the Trade name.

Enables the user to enter the Company Item number corresponding to
the license.

Enables the user to select all the countries in which the same license
was issued. The system adds the authorization country to the Countries
Lise and updates the list when the user updates the authorization
country.

The Product List box displays the list of products (product name,
dosage form and strength) that this associated license covers for
regulatory reporting purposes.

When a product is marked as non display, it will not appear in the
Trade Name Product lookup dialogue associated with the license
tradename.

This field is associated with medical device information and prints in
expedited reports.

This field is associated with medical device information and prints in
expedited reports.
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Field/Control Name Description

Medical Device This field is associated with medical device information and can contain
Information the following values:

= AIMD Active Implants

« MDD Class III

=« MDD Class IIb

» MDD Class Ila

= MDD Classl

»  IVD AnnexII List A

s IVD AnnexII List B

= IVD Devices for self-testing
= IVD General

= Blank (default)

CTPR Group Name  This value is used in Argus Safety when filter periodic report data.

Comments Enables the user to enter information about the element configuration.

Adding Product Licenses

This screen helps capture License information (License specifics, associated with the
License, Countries where the product is marketed or is under investigation). This data
is reflected in multiple expedited and periodic reports and in case form-product
information section.

Use the following procedure to add a product license.

1.

2
3
4,
5

In the Business Configuration section, select Product and Licenses.

In the left panel, select a filtering criterion.

Expand the folders till you reach the license associated with a product.
Select a license and click to view the license in the right panel.

The system opens the following screen:
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10.
11.
12.

13.

14.

15.

Enter the Trade Name of the license.

In the Manufacturer list, select the manufacturer of the product.
Select the AuthorizationCountry in which the license was issued.
Select the License Type. This is the type of license.

Enter the license number in License#.

If this license is to be reported under the PLA# and not the NDA# select the
Biologic/Vaccine checkbox. If this checkbox is selected, the PLA# (and not the
NDA#) will be printed in section G5 of the MedWatch form.

Specify if the drug is Labeled for Single Use or not.
Specify if the drug has been bought as an Over-the-Counter (OTC) Product.

Under Award Date, enter the date the license was granted to the
manufacturer.

Enter the Withdrawn date, if applicable.
Enter the Company item number in Company item number.

Enter a URL reference for the license under Data Sheet URL (A URL reference
might be a link to product label or product information).

A world wide web address or an appropriate network path (For example:
http:/ /anydomainname/anypath or \\FILESERVER\LOCATION) can be
entered in this field.

Select Not in Tradename lookup/Not Auto-Scheduled if this license is not to
be involved in reporting.

In the Countries List, select the countries that define whether the case will be
classified as domestic or foreign for regulatory report scheduling algorithm.

Tip: To modify this list, use the Modify option (placed next to the
Countries List).
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16. Select the Data Sheet Name associated with the license, from the drop-down
list.

17. Click Add in the Product Name/Dosage Form/Strength to add a product to
the License

Tip: You can alternatively click Add License to create a new license.

Use Copy to make an editable copy of an existing license.

6. The ProductBrowser dialog opens.

7. Enter the name (partial or full) of the product and select FullSearch.

8. Select the appropriate product in the search results and click Select. Enter all the
required products in this manner.

Using the Product Browser
1. Click on Add Products to add products.

2. The Products Browser window opens:.

= Enter the Ingredient key word for the search. The ingredient is displayed in
the first column.

= Select the Ingredient to obtain the Family it is associated with.
= Select the Product Name to view the associated Trade Names.
= Select the Trade Name required.

3. Select is now enabled at the bottom of the window.

4. Click Select to add the product details under the Product Name section. The
Product Name is displayed in under the Product Name section.
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5. The product browser available for datasheets, enables the administrator to select
either multiple or all Product Names as follows:

s Click the Family name and select multiple Product Names by clicking on each
required Product Name.

OR

= Right-click the Family name to select all entities available under Product

Name.

6. Click Save to save the changes.

Tip: If you have added a new License, click Add License to save the

new License.

Configuring Clinical Studies

It is important to configure clinical studies in the Argus Console because it helps the
system categorize the source of information for the cases that have been registered.
This screen helps in capturing Study information (study specifics, products involved
in the study licensed countries associated with the study and the clinical references
used in the expedited reports.

Configuration of the product is done using the Business Configuration->Studies

section.

The following illustration shows the fields associated with this section.
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The following table lists and describes the fields in this section.

Field/Control Name Description
Study ID This is the Study ID.
Project ID This is the project ID for the study.
Other ID Enter any other ID associated with this study.
Observe Study Type This enables the user to select the study type from a drop-down list.
(E2B) »  This element is populate from the Case From Clinical Study section
of the application.
= The value selected in Study Configuration, "Observe Study Type
(E2B)" is populated in the the Case Form Study section when the
user selects the Clinical Study.
»  The system updates the standard E2B profiles (EMA, FDA, and
ICH) to populate the tag.
Template Only Select this checkbox to select only a template for the study.
Study Development  Enables you to choose the study phase.
Phase
Arms
Study Name Enter the name of the study. This is a mandatory field. You can add
upto 99 Arms to a study.
Study Type Enter the type of study.

Primary License

Copy
Delete

Note: The Study Name and the Study Type fields must be unique for a
study.

Select the applicable primary license from the list of licenses available in
this drop-down list. These licenses are displayed as per the products
that have been selected for the Arm.

This drop-down list is displayed as blank for a new Arm.

Click this button to copy a selected Arm.
Click this button to delete a selected Arm.
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Field/Control Name

Description

Products

Product Name
(Dosage Form
/Strength /Units)

Blinded

Product Type

Products -Add WHO
Drug

Products -Add
Product

Products -Delete

Clinical References
Reference Type
Country

Reference Number

Add
Delete
Countries

License

Product Abbreviation

Centers

Study Description

Investigator Alert

Investigator Alert -
select

Provides information about the Product Name along with the (Product
formulation/Product Concentration/Product Units).

Check this checkbox to configure a blinded study. You cannot check this
checkbox if the Study Type for that Arm is not blinded.

Note: A Study is eligible for Unblinding checkbox is enabled when a
study has at least one Arm with Study type as Blinded (Single/Double).

The Study is eligible for Unblinding checkbox should be unchecked in
study configuration. If this checkbox is checked, the user will be able to
see the complete case data even if he has protection enabled.

Allows you to select a Product Type from the drop-down list
comprising options of 'Investigational Product’, "Placebo’, and
‘Comparator’.

Opens Search Screen for selecting a non-company product.
Opens Search Screen for selecting a company product.

Deletes the selected product row.

Shows the various reference types that can be setup for this study.
Enables the user to select a country for the clinical reference type.

Captures the reference number that will be reflected on the regulatory
reports.

Enables the user to add another clinical reference.
Enables the user to delete the selected clinical reference.
Enables the user to select a country for the clinical reference type.

This is the license of the primary (company) product participating in the
study.

This enables the user to enter an up to 5 character abbreviation of the
study name which would be used in Case numbering when Product' is
selected in the system numbering configuration in case of study cases.

The system displays the selected study centers for the study.
Enables the user to enter a brief description of the study.

Opens the study description in zoom mode and provides a spell check
dialog.

Opens the multi lingual dialog allowing the user to choose the language
by clicking on the relevant flag of the country.

Enables the user to select an existing Advanced Condition. Under
Investigator alert, an advanced condition can be created / selected.
When this condition is satisfied, the system automatically sends an
e-mail to the investigator group associated with this study.

Opens up the Advance Condition browser.
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Field/Control Name

Description

Study is eligible for
Unblinding

Enable Study Specific
Encoding

Autoencoding :
Drugs(dict)

Autoencoding :
Events & Indications

Study Reporting

Products -Add
Product

Products -Delete
Inherent Reporting

Rules Form

Always report

Country

License Type

Reporting
Destination

Time Frame

Check this box if the study can be unblinded. If the Study Type selected
is Not Blinded", this field is disabled. This checkbox is enabled when a
study has at least one Arm with Study type as Blinded (Single/Double).

User checks this box if Study specific Auto encoding has to be enabled.

If unchecked (default state) the study will use the dictionaries
configured using the Case form Configuration options.

If checked, the Auto encoding button is activated.

Select this field to enable the system to encode Events & Indications
using the dictionary the user selects from the list.

Opens the Search screen for selecting a company product.

Deletes the selected product row.

This drop-down list is populated from all the Study templates which are
configured for SUSAR Reports. Users can use the pre-defined SUSAR
reports by selecting the applicable template from the drop-down list.

Usually the study-specific reporting is configured to handle reporting
requirements for non-company products, e.g. Placebo or a comparator,
as the company-based reporting is taken care by the license based
reporting logic utilized in Argus.

However, checking this checkbox will force Argus to check for
qualifying expedited reporting rules based on the country, license type
and reporting destination specified even if no non-company products
are identified as study drugs.

If the checkbox is unchecked then expedited reports based on the
study-specific reporting rule will only be scheduled if there is a
non-company product identified as a study drug.

Specifies what country's reporting rules the console should consider.
The list includes countries for which the expedited reporting rules exist.

Specifies what license type to consider for the specified country. Only
applicable license types, i.e. Marketed Drug, Device, Vaccine or
Investigational Drug, Device, Vaccine are displayed in this drop down
list.

For example if a country Germany" only has reporting rules for
investigation drugs, then Investigational Drug" is the valid drop-down
element.

This field is optional and by default will have the value All.

Specifying any value in this list limits the reporting rules to be
evaluated to the selected country, license type and reporting
destination. The drop-down list is filled with valid destinations
(regulatory authorities) for the country and license type selected based
on the expedited reporting rules.

For example, if the user has selected Germany, Investigation Drug and
there are reporting rules for Germany with destinations of BfArM" and
Drugs R us" then only these two destinations (LM: regulatory
authorities) are displayed.

This field cannot be searched or altered, but is included for
informational purposes.

Based on the country, license type and reporting destination selected,
the system determines and displays all possible time frames in
ascending order separated by a comma.
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Field/Control Name Description

Possible Report This field cannot be searched or altered, but is included for
Forms informational purposes.

Based on the country, license type and reporting destination selected,
the system should determine and display all possible report forms in
alphabetical order separated by a comma.

Adding Clinical Study Configurations

This screen helps capture study information (study specifics, products involved in the
study licensed countries associated with the study and the clinical references used in
the expedited reports). Study Information is required if a case has been reported while
conducting a study and the participating product(s) belong to the company. This data
is reflected in multiple expedited and periodic reports and case form-general
information section.

Be aware of the following;:

The IND Reference Number drop down displays only those reference numbers
(license numbers) associated with a product with a License Type of
Investigational.

- Console --> Business Configuration --> Studies --> Clinical Reference section
(in middle of screen).

- The Reference Number drop down field should be limited to IND
(Investigational) US Licenses Number only.

The Study Name on the Study Configuration can be a maximum 70 Characters
(same as the Product name).

Use the following procedure to add a study:

1.
2
3.

In the Business Configuration section, select Studies.
In the left panel, select a filtering criterion.

Select a Study and click to view the study details in the right panel.

Note: Ensure that you select the study-level folder to view the details
of the study.

4. The details of the study appear in the right panel.
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Tip:
= You can alternatively click Add Study to create a new study.

= Click Copy to copy of the Study Name and the Study Type data to
the new Study.

»  Click Copy with Products to copy the Study Name and the Study
Type data, as well as to copy the blinded and open products.

Enter the Study ID and Study Name associated with the Study.
Select the Project ID for the Study, from the drop-down list.

5
6
7. Select the Study Type associated with the Study, from the drop-down list.
8. Enter the Other ID. This will be an alternative id for the Study.

9

Select Template to associate a template with the Study.
10. Select the Observer Study Type(E2B) from the drop-down list.

About Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Business Configuration
section.

Using Organized by

The filtering browser displays in the top-left corner of the left panel. The studies
section can be filtered based on of any of the three combinations shown in the
following illustration. The generated output is visible in a tree-format, in the left panel,
based on the entire categorization of Projects, Studies, Products.

g

Organized By Projects S Studies f Products

Coritaing w 0
Study f Products
Prochuct J Studies
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If you enable the Organized by Study/Products, only the Study and Product views
will be available in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to search
for all Projects/Studies/Products data that contain the term Cure.

Organized By Projects f Studies fProducts A
Corntzins b Il:ure H_l;ilter |
Starts with |

The left panel displays the tree view of the Projects/Studies/Products based on the
filtering criterion.

Tip: The number displayed next to the folder signifies the number of
studies/products within that project/studies family.

Adding WHO Drug Details
Use the following procedure to add WHO Drug detail information.

1. Select Add WHO Drug in the Products section to add the WHO Drug details
associated with the Study.

2. Click on WHO Drug to add WHO drug details (using the WHO Drug browser
window) associated with the Study.

3. The system opens the WHO Drug browser window.
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Select the Trade Name or the Ingredient radio-button, to search for the WHO
Drug term associated with either the Trade Name or the main Ingredient of the
drug.

Click Search to execute the search. The data is displayed as follows.

Select the required component/row (this can be the key Trade Name or
Ingredient).

The row now appears highlighted and the Drug Details section displays the
associated information.

Click Select to add this drug information in the Product Name section of the
Studies Configuration window.

The WHO Drug browser window closes and the drug appears in the Product
Name section.

Adding Product Details

Use the following procedure to add details about the Product in the Product Browser.

Family
Ingredient
Product Name

Trade llame

™ Full Search | Claae Drug Code Country |UNITED STATES Sasren

Ingredient Family Product Name Trade Narme

ALTEPLASE Acthoase Activase (ijection) , 200mg Activase, 1545 (UNITED STATES 1548) -~
Active Moisty Drug 0100 (UKITED STATES 0
Active Moisty Drug 0200 (UNITED STATES 0;

Active Moisty Drug 0300 (UNITED STATES &
Ampiclin (UNTED STATES US Marided 1004
BA+ (UNITED STATES BA+7)

Copy of License for 200 ingredients (UNTED
Doonabicin HCL 0401 (UNITED STATES 040
Doxoubicn HCL, 0401 (UNITED STATES 040
Dosonubicin HCL, 11-4421 (UNITED STATES
Doxonubicin HCL, 232131 (UNTED STATES 2
Doxonubicn HCL, 58-1181 (UNITED STATES
Glucometer, 2001 (UNITED STATES 2001)
Heart Vaive, 4001 (UNITED STATES 4001)
Hypenmater. 5001 (UNMTED STATES 5001)
BUPROFEN (UNITED STATES 1100)

Insulin 2001 (UNITED STATES 2001)

< td

-

ACtvase Model 2

ALTEPLASE Drug Code unkc
Activase (njection) , 200mg Indication

Actiase, 1549 (UNITED STATES 1545)

Seiec || Cancel |

]

N o a &

Select Add Product in the Products section to add the products associated with the
Study.

Click on Add Products to add products. The Product Browser window appears.

Enter the Ingredient key word for the search. The ingredient is displayed in the
first column.

Select the Ingredient to obtain the Family it is associated with.
Select the Product Name to view the associated Trade Names.
Select the Trade Name required.

Select is now enabled at the bottom of the window. Click Select to add the
product details under the Product Name section. The Product Name is displayed
in under the Product Name section.
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1.
2
3.

10.
11.

Tip: To delete a product, select the product and click Delete (placed
next to Add Product). A pop-up appears asking you to confirm the
action.
Select the Reference Type associated with this Study, from the drop-down list.
Select the Country associated with this Study, from the drop-down list.
Enter the Reference Number associated with the Reference Type in this Study.
Tip:

s To add more Reference Types in the Clinical Reference section,
simply click Add . A new row is added to this section.

»  To delete the Reference Type, select the Reference Type and click
Delete (placed next to Add). A pop-up appears asking you to
confirm the action.

The Countries field is a display only field. You can Add or Delete this list based
on your requirements.

Select the Product License from the drop down list. This is the license of the
primary (company) product participating in the study.

Enter the Product Abbreviation.

The Centers are displayed as per the centers you choose to associate with the
Study. To modify this list, click on Modify (placed next to Centers). Using this
option you can add and delete Centers associated with the Study.

Tip:

= Toadd more Centers to the Study Center list, use the Add>>/ Add
All .options.

»  To delete the Centers from the Study Center list, use the
Delete>>/Delete All options.
Enter the Study Description associated with the Study.

Click Select placed next to Investigator Alert to select or create an Advanced
Condition for this Study.

Select Study is eligible for Unblinding to enable the study to be unblinded.

Select Enable Study Specific Encoding to enable the study specific Auto
Encoding.

Configuring Auto Encoding

The Auto Encoding features helps you to configure your own dictionary of encoded
data. Using this enables you to:

Configure studies to use dictionaries different from the dictionaries configured
using the Case Form configuration.

Retrieve coded Events, Drugs and Events & Indications and codes from the lists
associated with this section.

Ensure that the expedited reports display the correct verbatim and coded terms

Use the following procedure to configure Auto Encoding.
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1. Click Auto Encoding to open the Auto Encoding dialog. The Auto Encoding
dialog opens.

Modify Case Form Configuration

Auto Encoding, Dictionary & Central Encoding
[¥ Drugs ]wm DRUGS v[

[V Events & Indications | MedDRA, J Brows V13.0. | ™

Central Coding

[T Prevent manual encoding for event terms
[~ Require event term encoding before case closure

2. Select the encoding options as required for Drugs and Events & Indications. Use
the items in the list to encode. For Study Encoding, go to Console -> Business
Configuration -> Studies -> Study Encoding to support Central Encoding for
Events & Indications for study cases, in a similar way as for non-study cases.
Checking the Central Encoding checkbox (next to the Event & Indications
Checkbox) also ensures that Central Encoding also gets reflected (as configured
here) in the Argus Case Form, for study cases.
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3. Select Prevent manual encoding for Events & Indications , if you want to disable
manual encoding by users.

4. Select the Require event term encoding before case closure, to ensure that the
expedited reports display the correct verbatim and coded terms.

Note: If this feature is not selected, then the study will use the
dictionaries configured using the Case Form Configuration options.

Cases where the report type does not include clinical trial cases, will
always encode with the dictionaries configured through the Case
Form configuration options.
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5. Select Inherit Reporting Rules From using the drop-down list to configure
study-based reporting requirements.

Configuring Study Reporting
Study Reporting is provided in the Study Configuration section to configure
study-based reporting requirements.

The reporting rules are not directly defined in the study, but rather identify which
reporting rules to check from the already configured expedited reporting rules.

The identification is based on specifying what set of reporting rules to evaluate, as per
the criteria of:

= Country

s License Type

= Reporting Destination

Use the following procedure to configure study based reporting.

1. Click Add in the Inherit Reporting Rules From section. The Study Reporting
dialog opens.

2. Select Always Report as required.

Tip: Select this checkbox to force Argus to check for qualifying
expedited reporting rules. These rules are based on the country,
license type and reporting destination specified. Refer to the Field
Descriptions for details.

3. Select the Country from the drop-down list.

Tip: This field specifies which country's reporting rules should be
included. The drop-down list includes countries for which the
expedited reporting rules exist.

4. Select the License Type from the drop-down list.

Tip: This field specifies the license type to be considered for the
specified country. Refer to the Field Descriptions for details.

5. Select the Reporting Destination from the drop-down list.
Tip: This field is optional.

6. The Time Frame and Possible Report Forms cannot be searched or altered, but is
included for informational purposes.

Tip:

» To add information pertaining to inheriting reporting rules in the
Study Reporting section, click Add

s To delete information pertaining to inheriting reporting rules in
the Study Reporting section, select the reporting rule and click
Delete. A pop-up appears asking you to confirm the action.

7. Click Save to save the changes made to the Studies section.
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Tip: If you have added a new Study, click Add Study to save the
new Study.

Configuring Expedited Report Rules

This section describes the configuration of Expedited Reports using pre-defined rules.
These reports are required by Regulatory Authorities. The Administrator is
responsible for entering information about Regulatory Authorities to which regulatory
reports will be submitted.

This information is entered in the Regulatory Agency Information screen. Information
about the local company contact for a regulatory authority can also be entered in this
screen.

Configuration of the expedited report rules is done using the Business Configuration
-> Expedited Report Rules section shown in the following illustration.

ORACLE Welzome shaaund, Wednessay, Sagust 6, 2014 [TFOMSOEFANLT) BB M
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EXPEDITED REPORT RULES

Cawnry { Licerss Type | Aeparts =

v [ mcluse fion-Cinical Tral Cases
As Determined (Event) As Reported (Case) A3 Determned (Case]

When configuring expedited reporting rules, be aware of the following;:

»  If the user does not have permission to access Advanced Conditions on the
Expedited Reporting Rules, the system does the following;:

- Displays the advanced condition name instead of displaying a blank.
— Does not permit the user to modify or view advanced condition details.
— Disables the Advance Condition button.

s The system enables the user configure the Blinding Study Products option for
those included in the case (default unchecked).

— The system track updates to this field in the audit log.
— The Reporting Rules reports print the new options

= For cases where expedited reports are due, the user can force-distribute expedited
reports even if processing is incomplete.

= Due Dates for expedited reports differ from Country to Country regulations. For
Group 1 countries, the Due Date is based on the Aware Date received globally for
the case.
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For Group 2 countries, the Due Date is based on the Aware Date when the affiliate
or a company representative of that country received information about the case.
In that case, the Due date for these reports could be 15 days after the report was
actually generated based on the aware date received globally.

When reports are scheduled and generated, the Due Date for Group 2 countries is
calculated. The Due Date for a Group 2 Country = Report Generation Date +
Additional days for Group 2 countries.

The Due Date for a Group 2 country can be adjusted as per the holidays and
weekends, through the Adjust Due Date for Group 2 countries by XXX days
checkbox.

The reporting rules have a Force Distribute XXX days before due checkbox. The
default is unchecked.

—  If the user checks the Force Distribute option, the # of days before due field is
entered and automatically checks the Auto Distribute checkbox on the
reporting rule (grayed out).

— The user can enter the number of days from 0 - # of days defined within the
time frame.

— If the user enters a value greater than the defined time frame, the system
displays the following message:

Please enter a value less than the Time Frame defined for the Reporting Rule.

- If the user has not checked Force Distribute, the system disables the days
before due.

The system tracks updates made to the new Argus Console fields in the audit log.

The system prints an audit log and print out that shows the expedited report rules
information as shown in the following illustration.

A super rule is a rule that overrides other rules when it finds a match. Be aware of
the following:

— The system executes a super rule before executing any other reporting rules.

- If a super rule matches, it executes all the super rules but does not execute
other rules.

—  If the super rule does not match, the application executes the other rules.
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Expedited Rep&n Rules
As of 05 January 2012
Country UNITED STATES
License Type Marketed Drug
Report Name US1997000003 & 6
Reporting Destination CDER
Origin of Events to Include . Domestic [ Foreign
Timeframe 3days
(ﬁ.ca'ust Due date for Group 2 Courtries by 3 gae )
Advanced Condition Adv Condn for investigator alert
Respensible Group US Distribution
Cover Letter
B Active Rue [ Auto Distribute Reports [0 Protect Reporter & Patient Confidentiality
O Active Moiety [ Blind Study Products Report on Study Drug not Administered
O Force Distribute days before due O HCPCase [0 No Follow-up or Downgrade
Reporting Category
License Category

[0 Super Rule - Cease evaluabion of normal rules upon match

Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Report Name Enables the user to view or enter the name of the Report.

Report Destination ~ Enables the user to select the name of the agency to which the report
will be scheduled.

Active Enables the user to specify whether the configured rule is active or
inactive.

= Only active rules are considered for report scheduling.

= Inactive rules are not checked when the report scheduling
algorithm runs.

Auto Distribute Enables you to distribute reports automatically. Except the E2B Reports,

Reports all the Expedited Reports that are selected for auto-distribution are
tracked under the Worklist--> Bulk Transmit screen. The E2B Reports
which are transmitted automatically, are tracked from Worklist--> Bulk
Transmit E2B.
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Field/Control Name Description

Protect Reporter and  Enables the user to configure Protect Reporter and Patient
Patient Confidentiality

Confidentiality = If this option checked and a report is generated or draft is viewed,

the Patient and Reporter information will be hidden.

= This option will override the check-boxes on the case form (for
Protect Reporter and Protect Patient) if it is checked.

= If this option is unchecked, the Case Form check-boxes will take
effect.

»  The Reports listed below will check for the Reporting Rule
Confidentiality Flag:

s EU Device Initial

s EU Device Final

= French CERFA Report
s CIOMS Report

s MedWatch Report

m  Vaers Report

HCP Case When checked, the system check for any reporter in the case where
HCP=Yes. This enables the report to be scheduled if other parameters
for the reporting rules are satisfied.

The default is unchecked.

Report on Drug Not  If this checkbox is checked, system schedules report for the suspect
Administered products (study or non-study products) that are marked as ‘Drug not
administered” along with the other suspect products in the case.

If this checkbox is unchecked, system ignores suspect products (study
or non-study products) that are marked as ‘Drug not administered” and
Reports are scheduled for other suspect products in the case for which
‘Drug not administered” is not marked.

Active Moiety Enable this check-box to enable rule to act exclusively as an active
moiety rule for that country.

When this option is enabled the system will disable and ignore the
county when evaluating the domestic/foreign causality sections.
Listedness will be evaluated at the case level.

No Follow-up or The system does not schedule a follow up or a downgrade report for
Downgrade the case when the the initial report was scheduled based on the current
rule.

Origin of Events to Enables the user to select the inclusion of domestic or foreign cases
Include - Domestic ~ based on their country of incidence.

= Domestic: The event is marked as Domestic, if the country of
incidence appears in the list of selected countries.

= Thislist is displayed in the Countries tab, in the List Maintenance
Licenses (section) for the license(s) of the suspect product(s) under
examination.
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Field/Control Name

Description

Origin of Events to
Include - Foreign

Timeframe

Adjust due date for
Group 2 countries by
xxx days

Form

Local Comment Type

Clinical Reference
Type
Language

Message Type

Listedness

Seriousness -
Fatal/Life
Threatening

Seriousness - Serious

(Case)

Enables the user to select the inclusion of domestic or foreign cases
based on their country of incidence.

= Foreign: The event is marked as Foreign, if the country of incidence
does not appear in the list of selected countries.

»  Thislist is displayed in the Countries Tab on List Maintenance
License (section) for the license(s) of the suspect product(s) under
examination.

This field specifies the report's scheduled due-date based on the
number of days, after the initial receipt or significant follow-up date.

This field allows the user to specify the number of days by which the
due date for a report may need to be adjusted for a Group 2 country.

This is the drop-down list of expedited report forms.

This field is used to extract the local evaluator comment from case data
(French CERFA 65-0044, CIOMS-I (Local)). This field is only enabled for
CIOMS-I (Local) form.

This field is used to get information from the study configured for a
case. This field is enabled for CIOMS-I and other forms.

Enables the user to select language type.
= English is the default language of choice.
= The system does not support other languages at this time.

= Reports such as the German BfArM, German PEI, and French
CERFA can utilize some field values in their corresponding
language (For example: narrative).

Enables the user to select the message type.

Note: This field is displayed when an E2B or eVAERS report is selected
as the Report Form. If the Report Form is selected as eVAERS, then the
Message type is set to ICHICSR and is disabled.

Enables the user to check if the license being evaluated for reporting is
listed. The possible values are:

= Listed
= Unlisted
= Ignore (default)

Enables the user to check if the case contains a Death' or Life
Threatening' seriousness criteria for the current event being evaluated.
The possible values are:

= Yes
| No
= Ignore (default)

Enables the user to check if case level seriousness assessment is
Serious'. The possible values are:

= Yes
| No
= Ignore (default)
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Field/Control Name

Description

Seriousness - Serious
(Event)

Seriousness - Severity

Product Specific -
Family Name

Product Specific -
Product Group

Causality - Most
Conservative

Causality - Include
Non-Clinical Trial
Cases

Causality - Causality
as Reported (Event)

Causality - Causality
as Determined
(Event)

Enables the user to check if the event level seriousness assessment (for
any event) is Serious. The possible values are"

= Yes
L] No
= Ignore (default)

Enables the user to select a term descriptive of the severity of the event.
E.g. Mild, Moderate, severe, unknown.

Enables the user to configure product specific reporting rules.

Enables the user to configure product specific reporting rules.

Product Group drop-down always lists the configured Product
Groups".

If this checkbox is marked, the system will look at the event level
reported causalities, event level determined causalities and case level
causalities, and if any of these three causalities is Yes then the case will
be considered Reportable.

If checked, the following options are hidden and set to Ignore":
= Causality as Reported (Event)

= Causality as Determined (Event)

= Causality as Reported (Case)

= Causality as Determined (Case)

= Causality is ignored when scheduling reports for non - study cases.
This only Study cases.

Enables you to include the Spontaneous Cases (Non Clinical Trial
Cases) for causality assessments.

Assesses As Reported causality in conjunction with the Listed value (if
any) specified in the rule for the license/event combination being
assessed. Ignored for non-study cases. Only applies to Study cases. The
possible values are

= Reportable
= Non-reportable

= Ignore (default)

Assesses As Determined causality in conjunction with the Listed value
(if any) specified in the rule for the license/event combination being
assessed. Ignored for spontaneous, literature and requlatory authority cases.

Ignored for non - study cases. Only applies to Study cases.
The possible values are:

= Reportable

= Non-reportable

= Ignore (default)
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Field/Control Name

Description

Causality - Causality
as Reported (Case)

Causality - Causality
as Determined (Case)

Advanced
Conditions

Advanced
Conditions - Select

Responsible Group

Super Rule - Cease
evaluation of normal
rules upon match

Reporting Category

Device Reporting
Category

License Category

Cover Letter

Comments

Most conservative of the As Reported causalities in event assessment
for ANY event.

Ignored for non - study cases. Only applies to Study cases.
The possible values are:

= Reportable

= Non-reportable

= Ignore (default)

Case Level Causality, as observed on the Analysis tab for the Case Level
Causality.

Ignored for non - study cases. Only applies to Study cases.
The possible values are:

= Reportable

= Non-reportable

= Ignore (default)

This field enables the selection of an advanced condition to further
restrict cases that meet the criteria for the rule.

Enables the user to open the Advanced Condition Browser.

You can click this button to open the Advanced Conditions browser to
select / create an Advanced Condition.

Enables the user to select a group to whom reports scheduled by this
rule will be assigned.

Enables the user to provide a super rule.

Enables the user to configure the relevant reporting category.

Enables the user to configure the relevant device reporting category.

Enables the user to configure the relevant license category.

Enables the user to use letters that have been configured for reporting
template use.

Enables the user to enter reporting rule comments, up to 2000
characters.

Adding Expedited Report Rules

The Reporting Rules configuration feature enables you to define the reporting rules or
criteria for the cases to be qualified for expedited reporting.

Use the following procedure to add expedited report rules.

1. In the Business Configuration section, select Expedited Report Rules.

2. In the left panel, select a filtering criterion. The left panel now displays the tree
view of the Country/License Type/Reporting Rule based on the filtering criterion.

3. Select a Reporting Rule and click to view the reporting details in the right panel.

Note: Ensure that you select the reporting rule-level icon/folder to
view the details of the reporting rule.
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10.
11.
12.

13.

14.
15.

16.

17.

18.

19.

20.

21.

Tip: wYou can alternatively click Add Rule to create a new reporting
rule.

= Use Copy Rule to make an editable copy of an existing reporting
rule, along with all associated expedited reporting rule
information.

Enter the Report Name.

Select the Report Destination from the drop-down list. This is the name of the
agency to which the report will be scheduled.

Select Auto Distribute Reports to distribute reports automatically.

Select Active to specify if the configured rule is active or inactive.

Note: Only active rules are considered for report scheduling

Select Origin of events to include-Domestic to include domestic cases based on the
country of incidence OR Select Origin of events to include-Foreign to include
foreign cases based on the country of incidence

Select Report on Drug not Administered. This option ensures that all drugs that
are not administered are reported.

Select Active Moiety if you want to enable this option.
Select the required Form from the drop-down list of expedited report forms.

Select the Local Comment Type from the drop-down list. This field is used to
extract local evaluator comments from case data.

Select the Clinical Reference Type from the drop-down list. This field is used to
obtain information from study configured for a case.

Tip: This field is enabled only for CIOMS-I and other forms.

Select the Language and Message Type from the drop-down list.

Select the Listedness from the drop-down list. This ensures that the license being
evaluated for reporting is listed.

Select the Seriousness- Fatal/Life Threatening option from the drop-down list.
This field ensures that cases that contain Death or Life Threatening seriousness
criteria for an event are evaluated.

Select the Seriousness- Serious (Event) option from the drop-down list. Enable
this field to check if the event level seriousness assessment is Serious

Select the Seriousness- Serious (Case) option from the drop-down list. Enable this
field to check if the case level seriousness assessment is Serious

Select the Seriousness- Serious (Severity) option from the drop-down list.
This enables you to define the Severity as Mild, Moderate, Severe and Unknown.

Select the Product Specific - Group Name from the drop-down list. This field
enables you to configure product specific reporting rules.

Select the Product Specific - Family Name from the drop-down list. This field
enables you to configure product specific reporting rules.
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22,

23.

24.

25.

26.

27.

28.

29.

30.

31.
32.

Select Causality-Most Conservative. This ensures that the system looks at event
level reported causality, event level determined causality and case level causality.

Select Causality-Include Non-Clinical Trial Cases. This enables you to include the
Spontaneous Cases (Non Clinical Trial Cases) for causality assessments.

Select Causality - Causality as Reported (Event) as required, from the drop-down
list.

Select Causality - Causality as Determined (Event) as required, from the
drop-down list.

Select Causality - Causality as Reported (Case) as required, from the drop-down
list.

Select Causality - Causality as Reported (Case) as required, from the drop-down
list.

Select or create the Advanced Condition to restrict cases to the advanced
conditions defined here.

If any of these three causalities are confirmed, then the case will be considered as
reportable.

Note: Use the Advanced Conditions browser to select or create an
Advanced Condition by clicking Select .

Select the Responsible Group from the drop-down list. This is the group to which
the reports scheduled by this reporting rule will be assigned.

Select the Cover Letter from the drop-down list. Use this field to select cover
letters that have been configured for reporting template use.

Enter any regulatory report comments under the Comments text box.

Click Save to save the changes made to this section.

Tip: If you have added a new Reporting Rule, click Add Rule to save
the new Expedited Reporting Rule.

About the Filtering Criterion The filtering criterion is essential as it helps you to search for
specific items. The Argus Console provides this option for the Business Configuration
section.

Using Organized by

The filtering browser is displayed in the top-left corner of the left panel. The Expedited
Report Rules section can be filtered on the basis of any of the five combinations shown
in the following illustration.

Organized By
Contains A

Courtry / License Type f Reporing | v
Country f License Type f Reporti
License Type | Reporting Destination §
Responzible Group f Reporting Rule

4 Active Rules

Inactive Rules

- CANAD
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Consider the following examples:

= If you enable Organized by Country/License Type/Reporting Rule, then the
output generated will be visible in a tree-format, in the left panel, based on the
entire categorization of Country, License Type and Reporting Rule.

= If you enable the Organized by Responsible Group/Reporting Rule, then only
the Responsible Group and Reporting Rule views will be available in the tree view
in the left panel.

Tip:

= Enable the Organized By filter for Active Rules, to obtain the list
of active reporting rules.

= Enable the Organized By filter for Inactive Rules, to obtain the
list of inactive reporting rules

The Argus Console helps you to filter information further for the Business
Configuration section. Once you have selected the Organized by, you can specify
whether your search should contain or start with specific alphabets or words.

For example, the filtering criterion defined in the following illustration for all
Country/License Type/Reporting Rule data that contain the term Canada.

Browser
Organized By Country fLicense Type / Reporting | »

Contains “ |Canada F[Jte:

Starts with

Sorting of Expedited Report Rules
The Reporting Rules are sorted in an alphanumeric order. The logic of ordering of
Reporting rules based on 'Organized by is as follows:

1. Country/License Type/Reporting Rule

For each country, there will be a folder for license type. Within each folder, the
active and inactive reporting rules will be presented together in alphanumeric
order.

2. License Type/Reporting Rule

For each license type, there will be a folder for each reporting destination. For each
destination, the active and inactive reporting rules will be presented together in
alphanumeric order.

3. Responsible Group / Reporting Rule

There will be a folder for each reporting group. Within each folder, the active and
inactive reporting rules will be presented together in alphanumeric order.

4. Active Rules

Only active rules will be presented. For each country, there will be a folder for
license type. Within each folder, active rules will be presented in alphanumeric
order.

5. Inactive Rules
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Only inactive rules will be presented.

For each country, there will be a folder for license type. Within each folder,
inactive rules will be presented in alphanumeric order.
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System Configuration

This chapter provides information about configuring the system. It includes
information about how to configure the following:

s Case Priority
s Field Validations

= LAM System Numbering

s Common Profile Switches

= Reporting Configuration

= Workflow

= System Numbering
= Field Labels

s User-Defined Fields

System Configuration Overview

The following table describes how the system options are configured:

Section
Case Priority
Field Validation

Field Labels
LAM System Numbering

System Management
(Common Profile Switches)
Workflow

System Numbering

SMTP

Description

This screen enables the administrator to configure rules to
determine the priority of new cases that are entered into the
system.

This screen enables the administrator to configure field level
validations for the Case Form fields.

This screen enables the administrator to configure field labels.

This section enables the administrator to specify the case
numbering preferences for LAM cases.

This screen enables the administrator to configure common
profile switches.

This screen enables the administrator to configure Workflow
states and rules.

This screen enables the administrator to specify the case
numbering preferences.

This screen enables the administrator to configure SMTP for
e-mails

System Configuration 4-1



System Configuration Overview

Configuring Case Priority

Configure rules to determine the priority of new cases that are entered into the system.
Based on these rules, the system assigns each case a priority that is displayed in the
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Each row in the Case Priority Configuration screen represents the priority level
assigned to a case that meets the specific criteria selected for that level. This data is
reflected in multiple expedited and periodic reports and case form-product

information section.

»  The user can select the priority level for which the criterion is to be configured.

»  Select System Configuration --> Case Priority to view the Case Priority page.
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Field Descriptions
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The following table lists and describes the fields in this section.

Field/Control Name

Description

Priority

Case Assessment - Serious

Case Assessment -
Unlisted

Enables the user to select the priority level whose criterion is to be
configured.

The user can disable only the last enabled priority. Example: If a
user has priority 1-4 checked, the priority can be disabled only in
the order of 4-1.

Enables the user to configure the seriousness for case assessment.

Select Yes from the drop-down list to give priority to cases
that are serious.

Select No for non-serious cases to be considered for this
priority level. Seriousness is considered at the case level.

Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.

Enables the user to configure the priority level for unlisted case
assessment.

Select Yes from the drop-down list for unlisted cases to be
considered for this priority level.

Select No for listed cases to be considered for this priority
level. Listedness criteria is considered at the case level.

Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.
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Field/Control Name

Description

Case Assessment - Causal

Report Due Date-Due Soon

First Report Due Date -
Ignore

No. of Warning Days
Before Due

Advance Condition Drop
Down List Box

AC Button

Run All Case Priority
Determination on Middle
Tier

Enables the user to configure the priority level for causal case
assessment.

= Select Yes from the drop-down list for causal cases to be
considered for this priority level.

= Select No for non-causal cases to be considered for this
priority level. Causality criteria is considered at the case level.

= Select Ignore from the drop-down list to ignore this condition
when assessing the priority of this case.

Enables the user to configure the report date due soon.

If this option is selected, the case is given the specified priority if
at least one expedited report is due after the number of warning
days specified from the current system date.

Enables the user to configure the first report due date to ignore
status.

This option is used to ignore this parameter when assessing the
priority.

Enables the user to enter the number of days before a case's report
due date when the priority is raised to Due Soon.

Enables the user to select an existing advance condition from the
drop-down list.

Enables the user to create a new advanced condition set or modify
an existing one.

Enables the user to run all case priority determination on Middle
Tier.

= If unchecked, the application assesses priority during every
case save operation in Web .

= If checked, the application does NOT assess priority during
every case save operation in Web and Client/Server. The
initial priority is calculated by the report scheduling and after
that, all the priority updates are done by the AG Service
Priority process.

Use the following procedure to configure Case Priority

1. Select the priority level whose criterion is to be configured.

2. Select the Case Assessment - Serious. The options in the drop-down list are Yes,

No, Ignore.

3. Select the Case Assessment - Listed. The options in the drop-down list are Yes, No,

Ignore.

4. Select the Case Assessment - Casual. The options in the drop-down list are Yes,

No, Ignore.

5. Select First Report Due Date as Due Soon or Ignore. Enter the #Warning days for

Due Soon.

6. Select the Advanced Conditions from the drop-down list.

7. Use the AC button to create a new Advanced Condition.

8. Select Run All Case Priority Determination on Middle Tier to ensure that the
application does not assess priority when a case is saved in Web and Client/Server.

9. Click Save to save the changes made.
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Configuring Field Validations

This screen enables you to configure field level validations for the Case Form fields. Be
aware of the following:

These validation rules are expressed as an advanced condition, with their criteria
marked as required or warning.

The field level validations feature helps in automatic checking of data as it is
entered on the Case Form, to ensure consistency of data as per company
requirements. Consider the following example:

Suppose that the year in the patient's date of birth is entered as 1860. The patient's
date of birth probably could not have been prior to 1880; hence, a warning is
issued to ensure the accuracy of the entered data.

A field level validation message such as this one is a "warning violation" and the
user can therefore enter a justification and continue working on the case.

An example of a mandatory violation would be a dosage regimen stop date that
occurs before the dosage regimen start date. Cases cannot be saved without
correcting mandatory violations.

For dependent fields, Argus Safety is pre-loaded with several field level
validations. Some of these validations are protected and cannot be disabled.
Others can be disabled, if required by company policy.

The system displays the Advance Condition Description for field validations on
the case form after the Advanced Condition name in the following format: Field:
XXXX:YYYYReason: ZZ7Z7

where:

XXXX Is the Field Label Tree view followed by the field label as configured in
the field label configuration.

YYYY Is the Advance Condition name configured for the field validation.

7777 Is the advance conditions descriptions as configured for the Advance
conditions.
This text prints only if there is a description available for the Advanced
Condition. Otherwise, the system disables the field label.

"2 Case Form Validations - Webpage Dislog %)

D Phone Num 4HD ema

Fileld: GENERAL Reporter - Reporier Last Name; Masng Reporter Name AN

,r Reason: The Reporter Mams OF Frons Mum OF Erad sddress i missing

Select System Configuration->Field Validation to view the Case Form Field Level
Validation screen. The following is an illustration of the screen.
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Tip: The Case Form tabs appear on the left panel and are categorized
as folders. Each folder contains all the field labels associated with that
section.

Consider the following example:

The General Tab in the Case Form contains sections such as Study, Follow-up, Case
Literature, etc. To view the list of field names associated with the Study section, click
Study in the left panel. The field names associated with Study appear in the right
panel.

Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Field Displays the name of the field.

Condition for Warning Displays the advanced condition for warning.

Table Displays the name of the selected sub-folder as displayed in the
browser tree view. This field cannot be edited.

Field Displays the name of the selected field label in the browser
tree-view. This field cannot be edited.

Condition for Warning Displays the advanced condition for warning.

Condition for Mandatory Displays the advanced condition for mandatory exception.

Exception

Print All Displays a list of validations on all tables, fields and advanced

conditions of each Group in the Case Form as a PDF.

Modifying Field Validations

This section enables the user to edit the information already entered in fields.

Use the following procedure to modify a field validation.
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1. Select the Case Form folder and field for which, the validation rule is to be
modified.

Tip: The information of the selected field is displayed in the Modify
section.

2. Click Select icon to create/select advanced conditions for Condition forWarning
and Condition forMandatory Exception.

Tip: Click here for details on Advanced Conditions.

Note:
» If all validation rules are met, a green icon is displayed.

= Ifa condition for warning is met during field validation, an
orange icon is displayed.

= Ifa condition for mandatory exception is met during field
validation, a red icon is displayed.

3. Click Save to save the changes made.

Note: Label Changes will not be reflected in Argus Case Form unless
IIS is reset.

Configuring LAM System Numbering

This section enables you to specify the case numbering preferences for LAM cases. The
system provides the ability to use multiple case numbering schemes for global use. For
example, if site is used in the numbering, the system provides the option to keep
separate sequences for each site.

Select System Configuration->LAM System Numbering to view the LAM System
Numbering screen shown in the following illustration.
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Field Descriptions
The following table lists and describes the fields in this section.
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Field/Control Name

Description

Manually Number Cases

Automatically Number
Cases

Start at

Separate sequence for each
site

Separate sequence for each
report type

Separate sequence for each
year

Separate sequence for each
month

Separate sequence for each
product abbreviation

Numbering Format

The option is used to enable the user to manually number the
cases on booking or while copying the case, using the save as'
option on the case form.

On selection, the system automatically numbers the cases as
defined by the user in the numbering format.

Enables the user to initialize the counter of the sequence number.

Enables the user to separate the sequence numbering for cases
on site by site basis. If there are cases being entered from two
different sites then each site will have different sequencing of
case numbers.

Enables the user to separate the sequence numbering for cases by
the report type of the case.

Enables the user to reset the sequence numbering for cases after
each year, based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases after
each month, based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases for
each different product abbreviation.

Enables the user to select the numbering format by selecting the
different placeholders.

= Define the numbering format by typing in custom keywords
to print on every case number and selecting different
placeholders.

»  [YY][MM]-[###] is the default format.
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Field/Control Name Description

Placeholder Enables the user to enter a placeholder.

= Placeholders are used to pickup values from the database to
be used in the Case numbering format.

»  The possible values populated in this list are:

# - Number: defines the digits to
be used as the sequence number
in the format. The field is used
to display the sequence number
on the case numbers.

CC- Country code: When
selected, this uses the A2 code
for the country of incidence for
the case number.

DD - Day: When selected, this
uses the date of the Initial
receipt date’ field of the case.

MM - month: When selected,
this uses the month of the Initial
receipt date’ field of the case.

P -When selected , this uses
either of the two values:

If report type is Spontaneous or
other during booking: the
system uses the value of the
Product Abbreviation' field
specified in the Product
configuration for the selected
Primary suspect product.

SSS — User Site: When selected
this uses the Site abbreviation of
the site belonging to the user
who booked in the case.

TIT — Report Type: When
selected this uses the report type
abbreviation of the report type
selected during bookin of the
case.:

YY- Year: When selected, this
uses the year of the Initial
receipt date’ field of the case.

Use the following procedure to configure LAM Numbering.

1. Select the Numbering feature as required. This can be manual numbering or

automatic numbering of cases.

2, Select the Sequencing Options as required.
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Tip: For the complete explanation of the sequencing option refer to
the Field Descriptions.

3. Select the Numbering Format. Use Placeholders to enter the required format.

Tip: To customize the Numbering Format, use the placeholder
values. Consider the following example:

To select Country Code, Month and Year (as values to be incorporated
from the database ) as the Case numbering format, execute the
following steps.

1. Click on Country Code. This appears in the Numbering Format field.

2. Click on Month. This appears in the Numbering Format field next to the
Country Code.

3. Click on Year. This appears in the Numbering Format field next to the
Country Code and Month.

4. The final data listed in the Numbering Format field is the Case
Numbering Format.

4. Click Save to save the changes made.

Configuring System Management - Common Profile Switches

This section lists the configurable sections for Common Profile Switches.

Select System Configurationand thenSystem Management to view the Common
Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

Note: If any change is made in the System Management (Common
Profile Switches) screen, the Argusvr2.exe and Argusvr2a.exe should
be killed from each Web Server and the IIS on Argus Web / Report
Servers must be reset, in order to reflect the changes made in the
Argus application..

The following table provides the list of configurable sections associated with Common
Profile Switches.

Section

Sub Section Description

Advanced Conditions ~ The Advanced Conditions

configuration screen enables you to
specify the number of rows to be
displayed on the Advanced
Condition search screen.

Argus Dossier Report Configuration =~ The Argus Dossier screen enables you

to modify the customizable fields of
Argus Dossier.
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Section Sub Section Description
Argus] E2B The Argus ] Configuration screen
Reportin enables you to modify the
P & customizable fields on the Argus J
~Device Report form.
Responsible Officer
Case Form Configuration ~ This screen enables you to configure
Common Profile Switches that affect
the behavior of the Argus application
Case Processing Assessments This section enables you to configure
Auto Archiving the case processing fields and items.

Document Management

E2B

Local Labeling

Network Settings

MedWatch Configuration

Reporting

Security

Case Numbering
Dictionary Browser

Enable Local
Unlocking

Lot Number
Processing

Performance

LAM

BIP Aggregate
Reporting

eVAERS

Expedited
Expedited - BfArM
Expedited - Canada
Expedited - CIOMS

Expedited - MedWatch

Periodic
Scheduling

Cryptography
LDAP

This screen enables you to configure
the Documentum fields and items for
Documentum.

This screen enables you to configure
the E2B fields and items for E2B.

The Local Labeling Configuration
screen enables you to modify the
options available through local
labeling.

The Network Settings screen enables
you to modify the settings on the
Argus Safety Load Balancer Server.

The MedWatch Configuration screen
enables you to modify the
customizable fields on the MedWatch
form.

The Reporting Configuration screen
enables you to modify the options
available for reporting.

The Security Configuration screen
enables you to modify the options
available for security.
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Section Sub Section Description

Single Sign-On ~ The Single Sign-On screen enables
you to modify the options available
for Single Sign-On such as enabling
or disabling it, its HTTP Header,
Logout URL, and using Oracle Access
Server SDK for LDAP Validation.

User Interface ~ The User Interface screen enables you
to modify the options available for
User Interface.

Workflow ~ The Workflow Items screen enables
you to modify the options available
for Workflow Items.

Configuring Advanced Conditions

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the rows to display on each page of an advanced condition screen, click
the Advanced Conditions folder in the left panel.
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Field Descriptions The following table lists and describes the fields in Advanced
Conditions Configuration.

Field/Control Name Description

Number of rows to display per page on the Enables the user to specify the number of rows to

Advanced Condition Search screen be displayed on the Advanced Condition search
screen.

Use the following procedure to configure Advanced Conditions.
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1. Enter the Number of rows to display per page on the Advanced Conditions Search

screen.

2. C(Click Save

to save the changes made.

Configuring Case Form (System Management)

This screen enables you to configure Common Profile Switches that affect the behavior
of the Argus application.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the Case Form Configuration section,
click the Case Form Configuration folder in the left panel. The field names associated
with Case Form Configuration appears in the right panel.

The Case Form Configuration dialog helps you customize the case processing
activities in order to meet the company's requirements. The Administrator can
configure the following items by using the Case Form Configuration dialog shown in
the following illustration.
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--{£% Ccase Form Configuration
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[#-[_J Local Labeling

-1 MedWatch Configuration

[ Network Settings

-3 Reporting

Modify Case Form Configuration

Auto Encoding, Dictionary & Central Encoding

oruss whoomies (]
vents & Indications
E| Prevent manual encoding for event terms

[[] Require event term encoding before case closure

Automation
Auto Regulatory Scheduling

Case Locking For Reports
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Reports
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Custom Routine
[] Custom routine before save
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Help Text

[] Attachment File Size Limit (in Megabytes)

Auto Encoding / Central Encoding To enable the use of standardized medical terminology
throughout the adverse event reporting process, dictionaries can be used to encode
certain terms in the Case Form.

The dictionaries that will be used to encode drugs, Events & Indications, and events
can be specified in the Autoencoding section of the Case Form Configuration dialog.

Field Descriptions
The following table lists and describes the fields in this section.
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Field/Control Name

Description

Drugs

Events & Indications

Prevent manual
encoding for Events
& Indications

Require event term
encoding before case
closure

The Drugs dictionary list enables the selection of the WHO-DRUG
dictionary. Select the Drugs check box and tab out of the product name
field in the Case Form to search the company product followed by the
license trade names.

= If no matches are found, the WHO drug dictionary (drug names) is
searched.

= Tab out of the generic name field in the Case Form to search the
product /product family ingredients (it displays the select dialog if
more than one product is found with the ingredient).

= If no match is found, the WHO drug dictionary (ingredients) is
searched.

Select Events & Indications to be prompted for the term as you enter it
to be encoded on the Events & Indications tab. If an exact match is
found in the dictionary, the term populates automatically. If an exact
match is not found, the Event Coding dialog is displayed to select the
desired event.

Auto encodes primary indication for the drug encoding, Patient
Condition description in Other Relevant History section and Death
Details dialog.

Prevents users from encoding the Events & Indications manually.

Ensures that users encode the events prior to formally closing a case.

Automation The Automation section enables the user to generate an Auto narrative
based on one of the templates configured by the method described in this topic.

Field Descriptions

The following table lists and describes the fields in the Automation dialog box.

Field/Control Name

Description

Auto Regulatory
Scheduling

This enables the user to configure the manner in which Argus Safety
handles the Auto-scheduling of Regulatory Reports.

The available options are:
= None

= Always

= Significant

=  Manual

Selecting Always will run the auto-scheduling algorithm when any
field from a specific list of fields is modified on the Case Form and the
case is saved.
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Field/Control Name

Description

Report Generation

Case Locking for
Report

The Report Generation option helps you to configure how the system
responds to new data when generating auto-scheduled regulatory
reports.

= When new data is entered, the system re-runs the regulatory
report-scheduling algorithm to determine which reporting rules
apply to the case.

= If Overwrite Existing Reports is selected, the system updates the
existing scheduled reports with the new data entered. This setting
ensures that follow-up numbering is specific to each health
authority.

= If a MedWatch report for the FDA has already been scheduled for
this case, that report would then be updated with the new
information entered.

= If Create as Follow-up is selected, the system uses the new data to
create new reports marked as follow-up reports. This setting
ensures that the same number would identify a follow-up report
worldwide. Users will be unable to submit follow-up reports
before one of the following events occur on the initial or previous
follow-up report.

Aware date and Due date of a scheduled report can be overwritten or
retained with original dates based on the internal common profile
swtich "Scheduled Report Update".

If "Scheduled Report Update" is set to "Update to current aware date
and new due date", the current Aware date is used and due dat is
updated based on the current aware date while overwriting a
scheduled report.

If "Scheduled Report Update" is set to "Keep original aware date and
due date" the aware date/due date are not updated based on current
aware date while overwriting a scheduled report.

If the common profile switch Report Generation is set to Create as
Follow-up then, system allows generation of follow-up reports
irrespective of submission status of previously scheduled reports based
on the settings made to the internal common profile switch Allow
Report Generation.

If the ‘Allow generation of report’ is set to Only when previously
scheduled reports are submitted or marked for “submission not
required” (default), then follow-up reports are not generated if the
previously scheduled report are not yet submitted or not marked as
‘Submission not required’.

If the “Allow generation of report’ is set to Even when previously
scheduled reports are neither submitted nor marked for “submission
not required", then follow-up reports are generated even if the
previously scheduled report are not yet submitted or not marked as
‘Submission not required’.

The Administrator has the option of indicating whether cases that are
not locked can appear in periodic reports.

s If Allow Unlocked cases to be included is selected, then a check
box on the periodic report configuration dialogs will allow
unlocked cases to appear in periodic reports.

= To prevent unlocked cases from appearing in periodic reports,
select Prevent unlocked cases from appearing,.
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Field/Control Name Description

Report On

Diagnosis Default on
Event

Event Assessment On

Prevent Modification
of Autonarrative

Case Autonarrative

Selecting Diagnoses will only list the events marked as diagnoses plus
events unassociated with a diagnosis in Regulatory Reports.

= The Event Assessment section of the case form will only list
diagnosis and unrelated events. If there are no diagnoses, all events
are listed. You can configure a default setting for selecting the
Diagnoses state at a system level.

= Selecting All Events will always list all events, regardless of their
relationship in the Event Assessment section of the case form. The
system will take into consideration both events marked as
diagnoses and events marked as symptoms when running the
regulatory report algorithm.

The options are Yes or No

= Selecting Yes will set the default Events Diagnosis to Yes whenever
a new event is entered.

= Selecting No will set the default Events Diagnosis to No whenever
anew event is entered.

The Event Assessment section of the case form will only list diagnosis
and unrelated events. If there are no diagnoses, all events are listed. You
can configure a default setting for selecting the Diagnoses state at a
system level.

= Selecting Diagnoses will include in Event Assessment only those
events that are associated with a diagnosis or symptoms that are
not associated with any of the diagnoses.

= Selecting All Events will include all events when the Event
Assessment is performed.

Selecting the Preventing Modification of Autonarrative check box will
prevent users from modifying autonarratives.

Selecting the Case Autonarrative check box enables the user to generate
an Autonarrative based on one of the templates configured by the
method described in this topic.

Templates Clicking the Templates button enables the Administrator to create a new
Autonarrative template, modify/copy an existing template, or delete an existing
template.

Use the following procedure to create a new Autonarrative template.

1.

Click the Templates button in the Case Form Configuration dialog to open the
Autonarrative Configuration dialog.

Click New to open the Narrative Configuration dialog.
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Under Template Name, enter a name for this new template.

Click the Add button at the bottom of the dialog. A new row for entering a phrase
and its associated logic will appear.

Enter a text phrase in the Phrase field. The text can include placeholders that will
be substituted by the appropriate case data when the Autonarrative is generated.

For example:A phrase might be entered as: "The patient was [age] at the onset of this
event”. When the Autonarrative is being generated, the "[age]” placeholder will be
substituted for the actual age of the particular patient in the case.

Click the ellipsis button to the right of the Logic column. Select or enter an
Advanced Condition for the logic section.

This search will be used to determine whether or not the corresponding phrase will appear
in a narrative for a particular case.For example:An advanced condition can be specified
such that only cases involving children younger than five years old will have the phrase ”

The patient was [age] at the onset of this event" in the Autonarrative.

Repeat steps 4 through 6 to add other text phrases to the template. Click OK to
save the template or Cancel to exit the dialog without saving the changes.

Note: Selecting the Preventing Modification of Autonarrative
checkbox in the Case Form Configuration dialog will prevent users
from modifying autonarratives..

Creating a Template in Another Language Use the following procedure to create a template
in another language.

1.

Once a template is created, double-click the "Narrative Templates" folder to
expand the template tree in the Autonarrative Configuration dialog.

Tip: To open the Autonarrrative Configuration dialog, click the
Autonarrative button in the Case Form Configuration dialog.

Expand the selected template folder to display the languages for this template. To
configure this template in a language other than English, double-click the
appropriate language icon.

Configure the foreign language template as described in steps 4 through 7 of the
procedure for creating the Autonarrative template above.

Click Close to exit the Autonarrative Configuration dialog.

Note: Autonarrative placeholders in a language other than English
will get substituted by text from that particular language. If no text is
available in that language, English language text will be used to
substitute the placeholders.

Copying a Template to Another Language Use the following procedure to copy a template
to another language.

1.

Select the original language from which the target language copy is to be created.
The original language can be selected in the tree-view of the Autonarrative
Configuration dialog.
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Tip: To open the Autonarrrative Configuration dialog, click the
Autonarrative button in the Case Form Configuration dialog.

2. Click Copy. The Autonarrative Copy dialog will appear.

Note: In the Autonarrative Configuration dialog, the Copy button
for a selected language template will only be available if a template
has already been created in that language.

3. Select the language to which the narrative template is to be copied and click Copy.

4. The contents of the original language template will now be copied into the
selected language template.

Deleting Templates Use the following procedure to delete templates.

1. To delete a language template, select the appropriate language icon for the
template in the Autonarrative Configuration dialog and click Delete.

2. To delete the entire Autonarrative template, select the template folder icon in the

Autonarrative Configuration dialog and click Delete.

Duration Calculations The following table lists and describes the fields associated with
this section.

Field/Control Name Description

Event The Duration Calculations section is used to indicate whether the
system should calculate event duration (the time from Event Onset
Date to Event Stop Date) in an inclusive or an exclusive manner.

For instance, select Inclusive to calculate a range from 01 January to 10
January as ten days. Select Exclusive to calculate a range from 01
January to 10 January as nine days.

If the user has entered both the date and time, the exclusive/inclusive
designation is ignored.

Drug The Drug Duration Calculations section is used to indicate whether the
system should calculate drug duration in an inclusive manner or an
exclusive manner, as described under Event Duration Calculations.

Documentum Common Login The Documentum Common Login information is used to
connect to the Documentum server to perform Documentum related activities to the
case form. The system uses this information only if the common profile switch to use
the common login is set. This option is only available if the system is configured to use
Documentum.

The following table lists and describes the fields associated with this section.

Field/Control Name Description

Username This is the username associated with the Documentum Common Login.
Password This is the password associated with the Documentum Common Login
username.

Custom Routines The following table lists the Field Descriptions associated with this
section.
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Field/Control Name

Description

Custom Routine
Before Save

Custom Routine
Before Commit

Custom Routine
After Commit

Custom Routine
Before Lock

Attachment File Size
Limit (in Megabytes)

The function behaves the same way as the Custom Routine Before
Commit. The case ID is passed as a parameter to the function. The
return value is a string format. If a null string is returned, the system
assumes the procedure executed without any error, and continues with
the case save operation. If any numeric/string value is returned, the
case save routine is aborted and the system displays the returned string
as an error message to the user.

This is the Custom routine to be called before case save. Ensure that the
custom routine is present in the database, and the application has access
to it.

This is the after-save Custom routine to be called after case save. Ensure
that the custom routine is present in the database, and the application
has access to it.

Select the Table Config button to select the tables that are being
modified in the post-save script.

This is the Custom routine to be called before case lock Ensure that the
custom routine is present in the database, and the application has access
to it.

The file size entered in this field enables you to specify the maximum
size limit for attaching a file. The upload limit defined here can be seen
in the Attachments and References section of the Bookin screen.

The default size for uploading an attachment is 30 MB. You can also
configure the file size as per your requirement, up to 300 MB.

Table Config Button The Table Config button enables you to fetch only the delta table
data after post-save, so that the entire case is not reloaded. This button is enabled only
when the Custom Routine After Commit checkbox is selected.

Use the following procedure to remove case tables.

1. Select the Custom Routine After Commit checkbox and click the TableConfig
button. The following screen appears.

Initially, all case tables open under the Available Tables list box.
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2, Select the required table(s) and click Add>> to include them to the Selected Tables

list.

Alternatively, you can select the required table(s) and click <<Remove to exclude
them from the Selected Tables list.

3. Click Cancel to close the screen without making any changes or click Save to save
this configuration.

s The Case Save routine gets modified to retrieve only the table data from the
Selected Tables in the configuration.

s Ifno Post Save is configured, the Case Save does not execute the Case Load

routine.

Modify Data Lock Point This section is displayed only if the DLP_SETUP switch is set to
ON in the database schema in the CMN_Profile_Global table.

Modify Data Lock Point

[] enable Data Lock Point

Data Lock Point Revision

QO use Last Completed Version

® use Next Completed version (Includes Data Cleaning)

The following table lists and describes the fields in this section.

Field/Control Name Description

Enable Data Lock

Use Last Completed Version

Use Next Completed Version

Point Enables you to activate a data lock point by selecting this
checkbox. If this checkbox is not selected, the Modify Data
Lock Point section displays only this field as editable.

(Includes Data Cleaning) includes data cleaning.

Enables you to use the last completed version.

Enables you to use the next completed version that

SMTP Configuration
The system enables you to attach a Custom SMTP Header along with the

preconfigured text as the Header for every e-mail it sends.
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s The Custom SMTP Header text is enabled only when the Custom SMTP Header
check box is checked.

— The user can define the Header and the Header text in the Custom SMTP
Header configuration by separating them with a colon (:).

—  The system does not validate the value for the Custom SMTP Header text.
= You can enter a maximum of 255 characters.
= All e-mail messages sent using the following processes are sent as Confidential:
- AG Service : Bulk Transmit Email
- AG Service : General Email
— ESM Service : Business / User / IT Email
s The Audit Log tracks updates to this field.

Configuring Case Processing

This section enables you to configure the case processing fields and items. Select
System Configuration --> System Management to view the Common Profile
Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left panel. The
components are categorized as folders.

Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing section, click the
Case Processing folder in the left panel.

The field names associated with Case Processing Configuration appear in the right
panel.
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The Case Processing folder has been further categorized into the following sub-folders:

s Configuring Assessments

s Configuring Auto Archiving
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= Configuring Case Numbering

s Configuring Dictionary Browser

= Configuring Lot Number Processing

s Configuring Performance

Field Descriptions The following table lists the fields available under Case Processing

Configuration:

Field/Control Name

Description

Create follow-up on
unblinding

Allow User to
regenerate reports

Manually Schedule
reports

Events to Display on
Assessment Tab

Access on Patient
Information

Enable Local
Unlocking

Search product on
Case Form

Select Type of WHO
drug search for auto
drug encoding

Action Item Code
when QC info is
entered

ActiveX
Compatibility Mode
(This option is
applicable only if
"Auto Upload letter"
is checked)

The available options are Yes and No.
The available options are Yes and No.

The available options are:
= Report scheduling will schedule follow up reports

= Report scheduling will not schedule follow up reports

The available options are:
= Event Assessment will display all Events

= Event Assessment will display Diagnosis Events only

The available options are:
= Initials part of Patient information access group

= Initials part of Personal Patient Information access group

Provides a system level control permitting local users to locally unlock
a case and make any corrections to the previously entered local data.
Enables you to select whether to locally unlock a case or not.

The available options are:
s Yes
] No

The available options are:

= Product Name product lookup. Based on products configured in
the system.

= Trade Name product lookup. Based on the licenses configured in
the system.

The available options are:
s Default WHO schema

s Use alternate who tables

The available action item codes are listed in the drop-down list box.

The available options are:

= Standard (WinHTTP method): This is option is selected by default.
System uses the WinHTTP for uploading files.

= Compeatibility (Older OS and IE Versions which do not use
WiIinHTTP method): System uses Internet Explorer for uploading
files. This option can be used if WinHTTP is not working for older
OS/IE.
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Field/Control Name

Description

Default Network
directory for scanned
images

SQL to prevent case
unlock when reports
are pending
generation

Enter the path of the default network directory of scanned images in
this text box.

When the user selects New Case from Image from the Quick Launch
toolbar, the Windows Open dialog opens, and displays the path
specified in this textbox, by default.

Allows customization to prevent users from unlocking the case from
Case Form, E2B, and LAM if there were reports pending generation.

You can configure this behavior by adding a SQL or database function
in the given text field.

1. If the value returned is greater than 0, then the system shall behave
as described below:

If the Value of Allow forced unlock (Global and Local) is Yes,
Report Status (Global or Local) is Pending (i.e. the value from SQL
check returned > 0), a warning message is displayed. The case is
unlocked using the existing "Locked Case" dialog if user selects
"Yes" on the warning message. This means that the pending global
reports will not be generated on unlock and may be overwritten or
removed depending on case data on the subsequent global lock.

If the Value of Allow forced unlock (Global and Local) is No,
Report Status (Global or Local) is Pending (i.e. the value from SQL
check returned > 0), the case is not unlocked and an error message
is displayed.

If the Value of Allow forced unlock (Global and Local) is N/A,
Report Status (Global or Local) is Generated /Submitted (i.e. the
value from SQL check returned 0 or no SQL has been configured),
the case is not unlocked.

2, If the value returned is 0 or no SQL has been configured, the
system shall allow users to global unlock the case without any of
the other checks.

The default for this configuration will stop the users from unlocking the
case if there are scheduled reports pending generation.

The checks for reports pending generation is applicable only when
DLP_EXPEDITED_E2B_REPORTS is set to 0 (i.e., DLP is not enabled for
Expedited Reporting).

Make sure that the name that is being used for the bind parameter is P_
CASE_ID.
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Field/Control Name

Description

Generate
auto-narrative for the
other language
without user
confirmation

Truly Local Case
(Note: Bind variable
:P_CASE_ID must be
used in SQL)

This common profile switch helps to suppress user confirmation during
generation of auto-narrative for the other language while the user
performs the operation in the English side or Japanese side.

Click Yes to generate or No (default) to not generate the auto-narrative.
If auto-narrative is being performed prior to global lock:

If a user is performing the auto-narrative from the Japanese side of the
case form and if the auto-narrative template has any other language
other than Japanese configured, and if the new common profile switch
"Generate auto-narrative for the other language without user
confirmation" is set to "No", the system shall first prompt the user if
they wanted to generate the English and other language narratives as
well. The system shall proceed with all the non-Japanese language
narrative generation steps only if the user chose Yes to this dialog (note
that existing generation steps and prompts still hold good) or if the new
common profile switch "Generate auto-narrative for the other language
without user confirmation" is set to "Yes. If they chose No to the user
prompt, the system shall proceed with only Japanese narrative
generation (note that existing generation steps and prompts still holds
true). If they chose Cancel, the system shall not proceed with
auto-narrative generation for any language.

If a user is performing the auto-narrative from the English side of the
case form and if the chosen Narrative template has Japanese language
configured, and if the new common profile switch "Generate
auto-narrative for the other language without user confirmation" is set
to "No", the system shall first prompt the user if they wanted to
generate the Japanese narrative as well. The system shall proceed with
the Japanese language narrative generation steps only if the user chose
Yes to this dialog (note that existing generation steps and prompts still
hold good) ) or if the new common profile switch "Generate
auto-narrative for the other language without user confirmation" is set
to "Yes". If they chose No to the user prompt, the system shall proceed
with only the non-Japanese (English and all other languages except
Japanese) narrative generation (note that existing generation steps and
prompts still holds true). Note that the prompt shall not display if
Japanese language was not configured in the template. If they chose
Cancel, the system shall not proceed with auto-narrative generation for
any language.

Provides a system level control allowing customers to define SQL or
PL/SQL block or specify database function to test if a case with suspect
Local (Japanese) License product is a Local PRPT case. This field is a
multi-line text fields with a limit of up to 1000 characters. It is
partitioned by enterprises for multi-tenant customers.

The SQL or PL/SQL block or the database function shall accept a bind
variable :P_CASE_ID representing the case from which this switch is
being invoked. If the value returned from the configured SQL or
PL/SQL block or the database function is > 0, the system shall consider
the case with suspect products having local (Japanese) license as a Local
PRPT case.

If the value returned is 0, the system shall not consider the case a Local
PRPT case (unless there is already a local report pending generation i.e.,
Scheduled or New data available report states).

If there is no SQL or PL/SQL block or database function configured in
this switch, the system shall consider that the switch returns a default
value of 1.

The system does not allow illegal data manipulations (e.g.,
UPDATE/INSERT/DELETE statements) to the underlying Argus
schema via this switch.

This switch is also used to determine if a report is a Local report.
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Field/Control Name Description

Uploading Letter Select Auto Upload Letter (enabling Active X) to upload letters

after generation automatically through the Active X control. The Active X control
supports the following versions of MS Office - Office XP, Office 2003
and Office 2007.

Select Manually upload letter to manually upload a letter saved on the
local machine.

Use the following procedure to configure the case processing options.
1. Select the required option in Create follow-up on unblinding.
Select the required option in Allow User to regenerate reports.
Select the required option in Manually Schedule reports.

Select the required option in Events to Display on Assessment Tab.
Select the required option in Access on Patient Information.

Select the required option in Search product on Case Form.

N o a » o Db

Select the required option in Select Type of WHO drug search for auto drug
encoding.

8. Select the required action item code from the drop-down list box in Action Item
Code when QC info is entered.

9. Enter the path of the default network directory of scanned images in the Default
Network directory for scanned images text box.

10. Select whether to upload letters automatically or manually by making the required
selection under Uploading Letter after generation.

11. Click Save to save the changes made to this section.

Configuring Assessments

This screen enables you to configure the case processing fields and items for
assessments. Select System Configuration --> System Management to view the
Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing --> Assessments
section, click the Assessments folder in the left panel.

The field names associated with Assessments Configuration appear in the right panel.

System Configuration 4-24



System Configuration Overview

ORACLE
B coseum | |

COMMON PROFILE - Cane Processingidisessments

TN oo s ot beeel coustinny suseeam e

SSTAR Criteria

Dingiay warming with Foari L

Field Descriptions The following table lists the fields available under Assessments

Configuration:

Field/Control Name

Description

Display warning
when Case Level
Assessment does not
match with Event
Level Assessment

Criteria for case level
causality assessment

Criteria for case level
Seriousness
determination

SUSAR Ceriteria

The available options are Yes and No.

The available options are:

»  Derive the case level causality based on the As Determined event
level causality.

= Manually select case level causality.

The available options are:

m  Derive the case level seriousness based on the events. If any event
is serious, case level will be serious.

= Manually select case level seriousness.

Enables you to enter an SUSAR criteria as an SQL query.

An SUSAR is identified as a Serious, Unexpected, Related Case.
Note: The SQL should not exceed 2000 characters.

Use the following procedure to Configure the Case Processing Options

1. Select the required option for Display warning when Case Level Assessment does
not match with Event Level Assessment.

2. Select the required option for Criteria for case level causality assessment.

3. Select the required option for Criteria for case level Seriousness determination.
4. Enter the SUSAR Criteria.

5. Click Save to save the changes made.

Configuring Auto Archiving

This screen enables you to configure the auto-archiving. Select System Configuration
--> System Management to view the Common Profile Configuration screen.
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Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

The default rule requires that the following options must be completed before a case is
auto-archived:

All Action Items Closed
All Reports Submitted or Marked required for Non-Submission
All Events are encoded

All Letters are sent

All Cases are locked

Apart from this default rule, you can also configure additional rules/criteria for
auto-archiving cases from this screen.

Workflow State (Configurable by the user) - This option enables you to select
Workflow States. Cases that fall in the specified workflow states can be
auto-archived.

Advanced Conditions selection (Configurable by the user) - This option enables
you to specify advanced conditions. Cases that meet the specified advanced
conditions, can be auto-archived.

This feature enables you to define rules for automatically archiving those cases that
meet the defined rules.

To view the list of field names associated with the Case Processing --> Auto Archiving
section, click the Auto Archiving folder in the left panel.

The field names associated with Auto Archiving Configuration appear in the right
panel.
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Field Descriptions The following table lists the fields available under Auto Archiving

Configuration:

Field/Control Name

Description

Workflow States

Advanced Condition

Case Archiving
Comment

Execution Period (in
Days)

The Select button enables you to select workflow states from a list of
workflow states. The selected workflow states are displayed in the text
box.

Cases that belong to these workflow states are marked to be
auto-archived.

Enables you to specify advanced conditions for auto-archiving cases.
Cases that meet the advanced conditions are marked to be auto-archived.

Refer to Advanced Conditions for details on creating advanced
conditions.

Enables you to enter a pre-defined case close comment, of up to 200
characters. The information entered in this field is displayed in the Case
Routing and Case Archive notes.

Enables you to define how often the cases will be archived.
Note: You can enter up to 99 days only.

If no value is entered, the cases will not be auto-archived.

Use the following procedure to configure the auto archiving options

1. Select the workflow states for auto-archiving cases from Workflow States.

Create the advanced conditions for archiving cases in Advanced Condition.

2
3. Enter the Case Archiving Comment as a pre-defined case close comment.
4

Enter how often the cases will be archived, as per number of days, under
Execution Period.

5. Click Save to save the changes made.

Configuring Case Numbering

This screen enables you to configure the case processing fields and items for case
numbering. Select System Configuration --> System Management to view the
Common Profile Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing --> Case

Numbering section, click the Case Numbering folder in the left panel. The field
names associated with Case Numbering appear in the right panel.
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Field Descriptions The following table lists the fields available under Case Numbering
Configuration:

Field/Control Name Description

Date to use for
numbering year
placeholder

The available options are:

Use initial receipt date of the case entered for the automatic system
numbering.

= Use date on the local machine for the automatic system numbering.

Use the following procedure to configure the case numbering options.

1. Select the required option for Date to use for numbering year placeholder.

2. Click Save to save the changes made.

Configuring Lot Number

A common profile switch determines whether a user can override an un-validated lot
number and enter them in the case form.
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The following table lists and describes the fields available under Lot Number

Processing;:

Field/Control Name

Description

Allow Users to enter
non-configured Lot
Numbers

Use Centralized Lot
Number Validation

Lot Number Web
Service
Configuration XML
File

Lot Number Web
Service XSLT

Enables you to select whether or not to allow users to enter
non-configured lot numbers. Select Yes to allow, and No to diallow.

Enables you to select whether or not to allow centralized lot
number validation. Select Yes to use, and No to not use this option.

Enables you to select and/or edit (if required) the Lot Number
Web Service Configuration XML File. The file path textbox is a
read-only field, which displays the path of the uploaded file. This
field stores the configuration of the Centralized Lot Number Web
Service in XML format. The Edit button is enabled only after the
XML file has been successfully uploaded.

Enables you to select and/or edit (if required) the Lot Number
Web Service XSLT File. This field stores the XSLT associated with
the Centralized Lot Number Web Service. The file path textbox is a
read-only field, which displays the path of the uploaded file. The
Edit button is enabled only after the XSLT file has been
successfully uploaded.

Yes is the default. This enables the user to select the options for the Lot Number

Validation as current functionality This message box displays the following message:

No matching lot number was found.

If centralized lot search is used, the system hides the Lookup button since a list is
automatically returned and displayed.

= No: The system does not permit the user to keep the existing value. The user can

only obtain it from a Look up dialog that lists the available Lot Numbers.
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The system hides the Keep button.

A common profile switch determines whether lot validation uses Argus or a
centralized lot validation.

s No (default): This enables the user to select the options for the Lot Number
Validation as current functionality from within the Argus Product Families Lot
Numbers

= Yes: This enables the system to query outside the Argus Safety system through
a web service return the following parameters for Lot Number Validation

- Argus sends the user-entered lot number to central system for
validation/look-up and retrieves a response to act on.

— The message format for the retrieved lot is as follows:
<Lots>
<Lot>
<Lot Number>: Lot number
<Expiration>: Lot expiration date
<Custom name=name metadata=text>: Custom data to a lot number

If more than one lot number is returned, the system displays a lot selection dialog.

The Custom Node sThe metadata attribute is as labels in the selection dialog that

displays the data. The name attribute is used to identify the case form field to be
populated with the data in the node.

Clients can use an XSLT document to map the custom data to case fields present
on the active case form page.
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If an error occurs during the web service transaction, a message box will appear with
the proper error message.
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Configuring MedDRA Browser
This screen enables you to configure the case processing fields and items for MedDRA
Browser.

Select System Configuration --> System Management to view the Common Profile
Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

The MedDRA browser category has been renamed as Dictionary Browser.

A switch in Argus enables you to use either local MedDRA Coding or Central
System MedDRA Coding (Web Service Method)

Local (Default): Current functionality of MedDRA browser using Local
Dictionary within the Database

Web Services: Returns the MedDRA hierarchy via the configured Web
Services.

This enables the User Local MedDRA if term is not found by Web Service" function.
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To view the list of field names associated with the Case Processing --> MedDRA
Browser section, click the MedDRA Browser folder in the left panel. The field names
associated with MedDRA Browser are in the right panel.

Field Descriptions The following table lists the fields available under MedDRA Browser
Configuration:

Field/Control Name Description
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Term Selection in The available options are:

MedDRA Browser Select any term to code if multiple are returned for the search

= Select the Primary SOC term for encoding if multiple terms are
returned from the search.

Use the following procedure to configure the MedDRA Browser.
1. Select the required option for Date to use for numbering year placeholder.

2. Click Save to save the changes made.

Configuring WHO Drug
Argus supports WHO-Drug encoding using a locally installed version of the
WHO-Drug dictionary through the WHO-Drug browser.

= A switch in Argus enables you to use either local WHO-Drug Coding or Central
System WHO-Drug Coding (Web Service Method) under the Dictionary browser
category

- Local (Default): Uses the current functionality of WHO-Drug browser that
uses the Local Dictionary in the Database

- Web Service: Returns the WHO-Drug fields via the configured Web Services

—  The system enables the User Local MedDRA if term is not found by Web
Service"

Configuring Performance

This screen enables you to configure the case processing fields and items for
performance.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing --> Performance

section, click the Performance folder in the left panel. The field names associated with
Performance appear in the right panel.
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Field Descriptions The following table lists and describes the fields available under
Performance Configuration:

Field/Control Name Description

When to process field Enables you to configure the frequency of field level validation.

level validation Select Only on case save to validate only when a case is saved.
Alternatively, select Every page update to validate fields whenever
a page is updated.

Where to store Enables you to select the location where you can save the

temporary case temporary case information during data entry.

information during You can select the location to be On the database in web case table

data entry

or On the fileserver cache directory.

Use Oracle Text for ~ Enables you to select Oracle Text for duplicate search querying.

duplicate search Click Yes to enable this feature.

querying

Refresh Oracle Text ~ Enables you to configure the interval (in minutes) between each
Index interval (in refresh of an Oracle Text Index.

Minutes)

This feature is useful while searching for duplicate cases. It is
advisable to enter a high interval for low number of cases and vice
versa.

Start Time for Oracle Enables you to specify the time when the Oracle text will be
Text Refresh refreshed.

Use the following procedure to configure performance.

1. Select the required option for When to process field level validation, as
applicable.

2. Select the required option for Where to store temporary case information during
data entry, as applicable.
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Select the required option for Use Oracle Text for duplicate search querying, as
applicable.

Enter the time difference between each refresh (in minutes), under Refresh Oracle
Text Index interval (in Minutes).

Enter the time (in military format) when the Oracle text refresh will begin, under
Start Time for Oracle Text Refresh.

Click Save to save the changes made.

Configuring Documentum

The system enables you to configure to choose Document Management from the
Common Profile Switches: Document Management

ORACLE' ‘Welcome vanessa, Thursday, March 3, 2011 (AST0-DEFAULT)
T e P ——————r

COMMON PROFILE - Document Management

Bro Modify Document Management
Organized by | Common Profie ¥4 | commeon Login
- Common Profile
= E Username |Admin istrator |
--[Jl Advanced Conditions
[#1-[3 Argus Dossier [ |
-3 Argus J
Diarg Docbase |sp3dncum |
[ Case Form Configuration
[#]-[1] Case Processing Domain [10.178.84.187 |
{5 Document Management
[JEzm Enable storage of E2B reports in Document Repository
[ Local Labeling ) Documentum Cabinet Hame | ‘
[ MedWatch Configuration @Argus Document Type | ‘
[ Network Settings
[ Reporting Enable storage of pedited reports in Dy 't Repository
-3 Securi
[+ g curity ® Documentum Cabinet Name |Repurhs ‘
-~ User Interface
Document Type |arqus_document_typel
[ Workflow Oargus | = = ‘
Enable storage of case attach it files in D t Repository and additionally the g and files already
ting in D it Repository to a case
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O argus Document Type |ca.se_ma.ster ‘
Enable storage of submitted periodic reports in Document Repository
(® Documentum Cabinetlame  [Reports |
O Argus Document Type |argus_n ocument_typel ‘
Save

= You may select from the following:

Documentum: Cabinet Name and Document Type textboxes are only enabled
when the "Documentum” radio option is selected. These text boxes allow upto
255 characters.

s Docbase and Domain are textbox fields. These fields can be a maximum of 255
characters.

= Configure the following for Document Management:

E2B Reports

Expedited Paper Reports

Periodic Reports
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— Attachments saved within the cases
- E2B Reports:

= If the E2B switch is enabled and the user transmits an E2B Report (Before
submission to the Gateway), the system stores the E2B XML Message in
Documentum.

s When the Report Submission is successful and the report is marked as submitted
in Argus, the system updates a flag in the Documentum database to designate the
same.

= Expedited Reports

- If the Expedited switch is enabled and the user submits an expedited report,
the Argus Safety Service inserts the report into Documentum as a PDF file.

—  When the Report Submission is successful and the report is marked as
submitted, the system updates a flag in the Documentum database to signify
the same.

= Periodic Reports:

- If the Periodic Switch is enabled and a Periodic Report is approved in Argus,
an Argus Safety Service exports the report as a PDF file and saves it in the
Documentum database.

- When the Report Submission is successful and the report is marked submitted,
the system updates a flag in the Documentum database to indicate the same.

s Attachments:

—  When this switch is enabled, a new button is available on the Argus
Attachments screen, LAM Attachments Section label Attach Documentum
Link.

- The Argus Bookin dialog has an additional drop down option for attaching to
Documentum.

— When the Links Switch is enabled, the system stores all Argus Attachments in
the Documentum database.

—  Clicking the Attach Documentum Link button opens a search dialog to enable
the user to search the Documentum database for a document. This document
is then linked as an attachment within Argus.
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—  When the user clicks the Attach Documentum Link button, the following
occurs:

— The system presents a search dialog to enable the user to search for a
document in the Documentum database.

— The user must select a Table to Search. This list is a distinct Table List from the
Documentum_table_info Table.

—  After the user selects a Table, the system populates the Column drop down
with all the columns available for that table based on configuration from the
same table.

—  When the user selects the Full Search option, the system performs a like search
in Documentum.

If LDAP is enabled, the system automatically send the login information from
Argus to Documentum.

After selecting a document from the Search results, the system saves the URL for
the Argus attachment.

If the user clicks the URL, Argus automatically opens the document from
Documentum.

Argus refers to two (2) that enables you to specify which tables/columns can be
searched in Documentum and which Table Fields to display in the Search Results.

— documentum_table_info - This table holds the table / fields the user will be
able to search.

Type_Name - Table to Search
Attribute_Name - Field in the Table to Search
Attribute_Type - Type of field being searched.
- Documentum_display_info - This table stores the Return Search Parameters.
Type_Name - Table to Search
Attribute_Name - Field in the Table to Search
Sort_Id - The order in which the fields will be displayed

— The Document Management (Central or Documentum) database gets a new
document each time a document attachment is added as a new attachment.
Existing documents are modified for changes.

— The system does not create a new document in the Document Management
(Central or Documentum) database each time a case /event is saved in Argus
or Affiliate

—  When cases are copied, the document copy has the same DOC ID (Object ID)
as the original case. If the Document is modified after the cases are copied, the
system gets a new DOC ID only for the case attachments that were modified.

— Theicon is similar to the Additional Info requirements for attachment types

—  When the user clicks the attachment to open it, the system retrieves the
attachment from Documentum

—  When events from the Affiliate are accepted in Argus as Argus cases, the
system keeps the DOC ID(Object ID) from the Affiliate Event

— Attachments can be entered to the case / affiliate event via
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Affiliate Events
Bookin in Argus or Affiliate
Case Form / Affiliate Event Form

Intake WL

»s  Error Messages

If the system cannot connect to the document system, it displays the following
message:

Argus was unable to connect to the document management system. Please
contact your Administrator for more details.

If the document system does not return any rows, the system returns a dialog
with the following message

No documents returned.

Select System Configuration --> System Management to view the Common
Profile Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing --> Documentum

section,

click the Documentum folder in the left panel. The field names associated

with Documentum appear in the right panel.

Field Descriptions The following table lists the fields available under Documentum

Management:
Section Field Description
Common Login  Use Common Login Users use a common login password to access
Password the system
Docbase The name of the document database.
Domain The name of the domain where the database
resides.
Enable Storage of Documentum Enables the system to store E2B reports in the
E2B Reports in document repository.
Document .
Repository Argus Enables the system to store E2B reports in the
Argus document repository.
This is the default.
Cabinet Name The storage location of the E2B reports.
Document Type The type of document that is being stored.

System Configuration 4-37



System Configuration Overview

Section Field Description
Enable Storage of Documentum Enables the system to store submitted expedited
submitted reports in the Documentum document
expedited repository.
reports in .
Document Argus Enables the system to store submittedd
Repository expedited reports in the Argus document
repository.
This is the default.
Cabinet Name The storage location of the submitted expedited
reports.
Document Type The type of document that is being stored.
Enable storage of Documentum Enables the system to store case attachment files
case attachment in the Documentum document repository.
files in the .
Document Argus Enables the system to store case attachment files
Repository in the Argus document repository.

Enable storage of
submitted
periodic reports
in the Document
Repository

Cabinet Name
Document Type

Documentum

Argus

Cabinet Name

Document Type

This is the default.
The storage location of the case attachment files.
The type of document that is being stored.

Enables the system to store submitted periodic
reports in the Documentum document
repository.

Enables the system to store submitted periodic
reports in the Argus document repository.

This is the default.

The storage location of the submitted periodic
reports.

The type of document that is being stored.

Use the following procedure to configure Documentum

1. Select the Common Login to configure the login for the user.

2. Select the option for Enable Storage of E2B Reports in Documentum.

3. Select the option for Enable Storage of submitted expedited reports in
Documentum.

4, Select the option for Enable storage of case attachment files in Documentum and
additionally the searching and attaching files already existing in Documentum to a

case.

5. Select the option for Enable storage of submitted periodic reports in Documentum.

6. Click Save to save the changes made.

Configuring E2B

This screen enables you to configure the E2B fields and items for E2B. Select System
Configuration --> System Management to view the Common Profile Configuration

screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.
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To view the list of field names associated with the E2B section, click the E2B folder in
the left panel. The field names associated with E2B appear in the right panel.

Field Descriptions The following table lists the fields available under E2B:

Field/Control Name

Description

Send E2B
nullification report

Onset Date
Calculation

Drug assessment
method (used by
E2B/Interchange
module)

Blind status during
E2B report
generation

Perform E2B Check
on Save

Default viewing
format of the E2B
report (used with
Electronic
Submission Module
(ESM))

Default DTD

Auto Accept Notes

This field enables the user to send an E2B nullification report. You can
select whether to automatically schedule it or to not send the report.

This field enables the user to configure if the onset date is to be
calculated based on any suspect drug or on the primary suspect drug
only.

This field enables the user to incorporate the drug assessment method
used by E2B/Interchange module.

The available options are:
s Blinded
s Unblinded

Performs data check on Argus fields against E2B standard while saving
the case.

The available options are:

= Yes

= No

The available options are:

= SGML

= CIOMS
MEDWATCH

= DECODED VIEW

This field enables the user to select the Default DTD from the
drop-down list box.

Enables the user to enter notes (up to 190 characters). It is required for
these notes to be entered for the acceptance of the E2B. The notes
entered here, are automatically provided during E2B acceptance.

Use the following procedure to configure E2B

1. Enable the check-box option for Drug assessment method (used by E2B/ESM
module), if required.

2. Select the option for Blind status during E2B report generation.

3. Select the option for Perform length check of Argus fields against E2B standard.

4. Select the option for Default viewing format of the E2B report (used with
Electronic Submission Module (ESM)).

5. Select the option for Default DTD.

6. Select the required radio button under Onset Date Calculation, as applicable.

7. Enter the comments for the automatically generated notes, when an E2B is
accepted, under Auto Accept Notes.

8. Click Save to save the changes made to this screen.
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Local Labeling

This section enables you to configure the common profile switches for Local Labeling
and includes discussions of the following;:

= Configuring Local Labeling
s Configuring Local Labeling LAM

Configuring Local Labeling The Local Labeling Configuration screen enables you to
modify the options available through local labeling. Select System Configuration -->
System Management to view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Local Labeling section, click the Local
Labeling folder in the left panel. The configurable fields associated with Local
Labeling appear in the right panel.
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Field Descriptions The following table lists and describes the fields available under
Local Labeling:

Field/Control Name Description

Number of Cases This field enables the user to configure the number of cases that are
returned in local returned in the local labeling dialog.
labeling dialog: Example: If the value is entered as 20 then 20 cases are returned in the local
default X . .

labeling dialog.
Action to be taken The available options are :

after timeout . Discard

s Submit
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Field/Control Name Description

Timeout for This field enables the user to enter the minutes after which the time-out for
assessment data lock assessment data lock is applicable.
(in minutes)

Use the following procedure to configure local labeling

1. Enter the number in Number of Cases returned in local labeling dialog: default.
2. Select the option for Action to be taken after timeout.

3. Enter the value in minutes for Timeout for assessment data lock (in minutes).

4. Click Save to save the changes made.

Configuring LAM The Local Labeling LAM Configuration screen enables you to modify
the options available through local labeling for LAM.

Field Label Updates The Argus Console Field Labels option enables the user to modify
the field labels for the Argus Affiliate Event Information form.
s The existing Argus fields are under the Argus Safety folder structure.

m Please refer to the tables in the LAM Information section for the details about the
Help Text for the fields.

s The system enables the user to hide the field on the LAM form.

s The system prints the Affiliate field labels.

s The system tracks all field label updates in the audit log.

Field Validation Updates Argus Affiliate enables the user to configure Field Validations
for Mandatory and Warning for the LAM Event fields.

s The existing Argus fields are under the Argus Safety folder structure.

= Please refer to the table for LAM Event Info for the fields in the Field Validations.

s The Affiliate fields for advanced conditions are only visible for field validations.
They are not visible to the rest of the application.

s The system prints the information for the configured field validations.
s The system tracks all updates to field validations in the audit log.

s The system displays the standard Justifications dialog to enable the user to enter
the justifications for overriding the warnings, but does not permit the user to save
the case for a mandatory error.

Select System Configuration --> System Management to view the Common Profile
Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Local Labeling LAM section, click the Local
Labeling folder in the left panel.
s The LAM sub-folder is displayed in the left panel.

s Click on LAM sub-folder to configure the LAM options.
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s The configurable fields associated with Local Labeling Lam appear in the right

panel.
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Field Descriptions

The following table lists and describes the fields available under Local Labeling LAM:

Field /Control Name

Report Scheduling when
Labeling Changes from the Local
Labeling Screen

Re-evaluate all scheduled and
generated reports related to a
case when the labeling is
changed from the Local Labeling
dialog

Report Scheduling for LAM

Description

The available options are:

Report Scheduling will not be executed when the
Local Labeling is changed

= Report Scheduling will occur for those Licenses
where the Labeling has changed

The available options are:
The system will not re-evaluate generated reports

= Re-evaluate general reports.

The available options are:
= Perform live scheduling on screen

= Perform scheduling using AG service

Use the following procedure to configure local labeling for LAM.

1. Select the option for Allow hiding of the Local Labeling dialog from Users.

2. Select the option for Report Scheduling when Labeling Changes from the Local

Labeling Screen.

3. Select the option for Re-evaluate all scheduled and generated reports related to a
case when the labeling is changed from the Local Labeling dialog.

4. Click Save to save the changes made.
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Configuring MedWatch The MedWatch Configuration screen enables you to modify the
customizable fields on the MedWatch form. Select System Configuration --> System
Management to view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To view the list of field names associated with the MedWatch Configuration section,
click the MedWatch Configuration folder in the left panel.

Firm Name as it Should Appear at the Top of Each Page
Great Drug & Devices, inc.aa

Use Manufacturer of the License used for Report scheduling

Date of FDA Approval to Appear on the First Page
01JAN-2009

Disclaimer to Appear at the Bottom of the First Page
Submission of a report does not constitute an admission that the product, medical personnel, user facity, distributor, importer, packer or manufacturer caused or contributed to the eventaa

Default Text to Appear on Block H10
0

Addressig be printed at the battom of Second page of MedWatch Device Form

Default Text to Appear on Block H10

Reset MedWatch Numbering |

[ Meawatch Numbering Reset

The field names associated with MedWatch Configuration appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under MedWatch
Configuration:

Field/Control Name Description

Firm Name as it Should Appear Enables the user to enter the name of the reporting firm on
at the Top of Each Page the MedWatch form.

Use Manufacturer of the License Enables the user to use the manufacturer of the license that
Used for Report scheduling was used for report scheduling, by checking this checkbox.
Date of FDA Approval to Enables the user to enter the FDA approval date of the
Appear on the First Page manufacturer.

Disclaimer to appear at the Enables the user to enter a brief disclaimer.

Bottom of the First Page

Default text to appear on Block  Enables the user to enter default text.

H10

Address to be printed at the Enables the user to enter the address to be printed at the
bottom of Second page of bottom of Second page of MedWatch Device Form.
MedWatch Device Form

The default address is as follows:
Department of Health and Human Services
Food and Drug Administration

Office of Chief Information Officer
Paperwork Reduction Act (PRA) Staff
PRAStaff@fda.hhs.gov
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Field/Control Name Description

Reset MedWatch Numbering Enables the user to reset the sequence number that appears
on the MedWatch form for the manufacturer.

Mfr. Site FDA Number Displays the FDA number for the Manufacturer Site which
submitted the MedWatch 3500 Device report in the year.

Year Displays the year of report submission.

# of Reports Displays the number of submitted reports for products

associated with a Manufacturing Site in that year

Reset Number Enables the user to reset the Sequence Number.

Use the following procedure to configure the MedWatch form options.
1. Enter the Firm Name as it Should Appear at the Top of Each Page.
2. Enter the Date of FDA Approval to appear on the first page.

3. Enter the Disclaimer to appear at the bottom of the first page.

4. Enter the Default text to appear on Block H10.
5

ClickReset MedWatch Numbering to reset the sequence number that appears on
the MedWatch form, for the manufacturer as required.

User Interface
This section enables you to configure the common profile switches for User Interface.

Configuring User Interface

The User Interface Configuration screen enables you to configure the user interface, as
per the options available. Select System Configuration --> System Management to
view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the User Interface section, click the User

Interface folder in the left panel. The configurable fields associated with User
Interface appear in the right panel.
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COMMON PROFILE - User Interface

Modify User interface

[[] pisplay Enterprice Short Name in the header

Organized by | Comman Profie ~ 4
EHES Common Profie
(L3 Advanced Conditions
& (4 Argus Dossier
[ Argus Insight
(_J Argus J
(i Case Form Configuration
-3 Case Processing
(23 Document Management
AE28
- Local Labeing
[ MedWatch Configuration
(i Network Settings
E-[ ) Reporting
&~ Security
{&F User Interface
.l Workflow

Save

Field Descriptions
The following table lists and describes the fields available under User Interface:

Field/Control Name Description

Display Enterprise This field enables the user to select whether to display the
Short Name in the enterprise short name in the header. Check this checkbox
header to display the enterprise short name.

Reporting Configuration

This section enables you to configure the common profile switches for Reporting. This
topic has been divided into the following sub-topics:
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Section Sub-Section Description
Reporting Expedited Reports  The Expedited Reporting Configuration screen
Configuration enables you to modify the options available for

expedited reporting.

Expedited BEArM  The Expedited BfArM Reporting Configuration
screen enables you to modify the options
available for expedited BfArM reporting.

Expedited Canada  The Expedited Canada Reporting Configuration
screen enables you to modify the options
available for expedited Canada reporting.

Expedited CIOMS  The Expedited CIOMS Reporting Configuration
screen enables you to print fields such as Patient
ID, Medically Confirmed and Worldwide
Number in the "26. REMARKS" section of the

CIOMS form.

Expedited The Expedited MedWatch Reporting

MedWatch Configuration screen enables you to modify the
options available for expedited MedWatch
reporting.

Periodic The Periodic Reporting Configuration screen

enables you to modify the options available for
periodic reporting.

Scheduling The Scheduling Reports Configuration screen
enables you to modify the options available for
scheduling reporting.

Configuring Reporting

The Reporting Configuration screen enables you to modify the options available for
reporting. Select System Configuration --> System Management to view the Common
Profile Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting

folder in the left panel. The configurable fields associated with Reporting appear in
the right panel.
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Field Descriptions The following table lists the fields available under Reporting:

Field/Control Name Description

Determine the minimum length of ~ The available options are:
the routing comment text length on No routing comment will be required
report routing dialog

= Minimum length of text required

Use the following procedure to configure reporting.

1. Select the option for Determine the minimum length of the routing comment text
length on report routing dialog.

2. Enter the numeric value in the Minimum length of text required text-box, if
applicable.

3. Click Save to save the changes made to this screen.
Expedited Reports Configuration The Expedited Reporting Configuration screen enables

you to modify the options available for expedited reporting. When configuring
expedited reporting rules, be aware of the following:

»  If the user does not have permission to access Advanced Conditions on the
Expedited Reporting Rules, the system does the following:

- Displays the advanced condition name instead of displaying a blank.
- Does not permit the user to modify or view advanced condition details.
- Disables the Adv Condition button.

s The system enables the user configure the Blinding Study Products option for
those included in the case (default unchecked).

— The system track updates to this field in the audit log.

— The Reporting Rules reports print the new options
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For cases where expedited reports are due, the user can force-distribute expedited
reports even if processing is incomplete.

The reporting rules have a Forced Distribute XXX days before due check box. The
default is unchecked.

If the user checks the Force Distribute option, the # of days before due field is
entered and automatically checks the Auto Distribute check box on the
reporting rule (grayed out).

The user can enter the number of days from 0 - # of days defined within the
time frame.

If the user enters a value greater than the defined time frame, the system
displays the following message:

Please enter a value less than the Time Frame defined for the Reporting Rule.

If the user has not checked Force Distribute, the system disables the days
before due.

The system tracks updates made to the new Argus Console fields in the audit log.

The system prints the new fields on the Reporting Rules report.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

The Common Profile folder appears in a tree-view on the left

panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited sub-folder opens in the left panel.

Click on Expedited sub-folder to configure the expedited reporting options. The
configurable fields associated with ExpeditedReporting open in the right panel.
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Field Descriptions

The following table lists and describes the fields available under Expedited Reporting:

Field/Control Name

Description

Active moiety report scheduling
evaluation (a report scheduled against a
product/license that shares ingredients
with a product in a case)

Allows Bulk Reporting screen to show
Unlocked Cases for Final Report

License number on MedWatch Drug
Report

Allows Bulk Reporting screen to show
Generated Reports Only

Nomenclature System on EU Device
Vigilance Form

Default name of Regulatory Agency for
Draft Expedited English Reports

Text to display as comment when a
downgrade report is scheduled

CIOMS report format to use

CIOMS Form Selection

The available options are:
s Enable
= Disable (default)

The available options are:

= Report by Form and Bulk Report By Case will
filter final reports by Locked Cases only

= Bulk Report By Form and Bulk Report By
Case will allow selection of unlocked cases to
be submitted as Final

The available options are:

= Print License # only for the scheduled license
on MedWatch Drug Report

= Print all available license numbers for Drug
as determined by the scheduled license

Enables the administrator to allow the Bulk
Reporting screen to display only the generated
reports.

Nomenclature system (Preferable GMDN)" box of
EU Device Vigilance Form. By default, this
common profile switch is set to ‘'GMDN’.

This enables the user to select the Default Name of
the Regulatory agency from the drop-down list.

This enables the user to enter the text to display
when a downgrade report is scheduled.

The available options are:
s Standard
s Custom

When Custom is selected, a second version of the
CIOMS form is used. This form is almost identical
to the Standard form.

The only difference is that the Custom form
includes superscripts in the label text for boxes 15,
16, 18 and 19. The superscript is simply an asterisk
(*) to draw the user’s attention to the following
footnote also included in the Custom form:

*Boxes 15, 16, 18, and 19 on page 1 contain first
dose regimen information for suspected product
#1 and #2. Suspected Drug(s) information is
continued on Additional Information page, if
applicable.

Thus, the Custom form simply provides the user
the option to clearly identify fields that have
overflow information on the Additional
Information page.

This enables the user to select the CIOMS form to
be used across the application for Expedited
Reporting / Periodic Reporting.
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Field/Control Name Description

Auto Distribution Transmission Comments Enables the user to enter transmission comments
of up to 2000 characters, for Expedited Reports
Transmission.

These comments are auto-distributed, based on
Expedited Reporting Rules or Reporting
Destinations.

Auto Distribution Submission Comments  Enables the user to enter submission comments of
up to 2000 characters, for Expedited Reports
Transmission.

These comments are auto-distributed, based on
Expedited Reporting Rules or Reporting
Destinations.

Print Case Version of Expedited Reports This switch enables the user to enable or disable
(x.y.2) the printing of the case version of expedited
reports.

Use the following procedure to configure expedited reports.

1. Select the option for Active moiety report scheduling evaluation (a report
scheduled against a product/license that shares ingredients with a product in a
case).

2. Select the option for enables Bulk by Form to show Unlocked Cases for Final
Report.

3. Select the option for License number on MedWatch Drug Report.

4. Select the option for Default name of Regulatory Agency for New Draft Expedited
Reports from Analysis Tab of the Case Form from the drop-down text-box.

5. Enter the text in the Text to display as comment when a downgrade report is
scheduled text-box, if applicable.

Select the option for CIOMS report format to use.
Select the relevant CIOMS form, from CIOMS Form Selection.

Enter the transmission comments in Auto Distribution Transmission Comments.

© ® N o

Enter the submission comments in Auto Distribution Submission Comments.

10. Select whether to enable or disable printing the case version of expedited reports
in Print Case Version of Expedited Reports (x.y.z).

11. Click Save to save the changes made to this screen.
BIP Aggregate Reporting The BIP Aggregate Reporting Configuration screen enables you
to modify the options available for BIP Aggregate reporting.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting

folder in the left panel. The BIP Aggregate Reporting sub-folder is displayed in the
left panel.
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Click this sub-folder to configure the reporting options. The configurable fields
associated with BIP Aggregate Reporting appear in the right panel.

Field Descriptions

The following table lists and describes the fields available under BIP Aggregate
Reporting:

Field/Control Name Description

BIP Common User Enables you to enter the name of the BIP common user.
BIP Common User Enables you to enter the password of the BIP common user.
Password

Persist data in BIP Enables you to select whether to persist data in BIP Aggregate

Aggregate Temp Temporary Tables.

Tables The available options are:
= Yes
= No

Number of days for ~ Enables you to specify the number of days for which data in BIP
which data of BIP Aggregate Temporary Tables should be persisted.

Aggregate Temp

Tables should be

persisted

eVAERS The eVAERS Reporting Configuration screen enables you to modify the
options available for eVAERS reporting.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The eVAERS sub-folder is displayed in the left panel.
Click this sub-folder to configure the reporting options. The configurable fields
associated with eVAERS appear in the right panel.

Field Descriptions
The following table lists and describes the fields available under eVAERS:

Field/Control Name Description

Default view for Enables you to select either XML View or HL7 view as the default view
eVAERS for eVAERS.
File attachments Enables you to specify the types of files whose attachments are allowed

allowed for eVAERS for eVAERS.

Allowed file size for ~ Enables you to specify the maximum file size (in MB) allowed in
eVAERS (in MB) eVAERS.

Default Reporting Enables you to select the default Reporting Destination for draft
Destination for draft eVAERS generation.
eVAERS generation
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Expedited BfArM Reports Configuration The Expedited BfArM Reporting Configuration
screen enables you to modify the options available for expedited BfArM reporting.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited- BEArM sub-folder is displayed in the left
panel.

Click on the Expedited-BfArM sub-folder to configure the expedited BfArM reporting
options. The configurable fields associated with Expedited - BEArMReporting appear
in the right panel.
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Field Descriptions

The following table lists and describes the fields available under Expedited -
BfArMReporting:

Field/Control Name Description

Causality Valueon  The available options are:

BfArM Report e beh Azt

= Hersteller

= Arznel Komm
Value of field The available options are:
"Grunderkrankung" . T
on the BArM /PEI ] ]f?eo1 (Iilot output suspect and concomitant product indication in this
form

= Output additional suspect and concomitant product Events &

Indications.
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Use the following steps to configure the expedited BfArM reports.

1. Select the option for Causality Value on BfArM Report.

2. Select the option for Value of field "Grunderkrankung" on the BfArM/PEI form.
3. (Click Save to save the changes made to this screen.

Expedited Canada Reports Configuration The Expedited Canada Reporting Configuration
screen enables you to modify the options available for expedited Canada reporting.
Select System Configuration --> System Management to view the Common Profile

Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited- Canada sub-folder is displayed in the left
panel.

Click on the Expedited-Canada sub-folder to configure the reporting options. The
configurable fields associated with Expedited - CanadaReporting appear in the right
panel.
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Field Descriptions

The following table lists and describes the fields available under Expedited- Canada
Reporting:

Field/Control Name Description

This field enables the user to enter the associated SQL
syntax.

SQL used to populate the "Is there an
ongoing clinical trial for this drug in
Canada" field on the Canadian
Expedited ADR report form
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Field/Control Name Description

SQL used to populate the "Is there a This field enables the user to enter the associated SQL
clinical trial application for this drug  syntax.

under review in Canada" field on the

Canadian Expedited ADR report form

SQL used to populate the "Is there a This field enables the user to enter the associated SQL
new drug submission for this drug syntax.

under review in Canada" field on the

Canadian Expedited ADR report form

SQL used to populate the "Report ADR This field enables the user to enter the associated SQL
occurred in Phase I-III Study" field on  syntax.

the Canadian Expedited ADR report

form

SQL used to populate the "Report ADR This field enables the user to enter the associated SQL
occurred in Phase I-IV Study" field on  syntax.

the Canadian Expedited ADR report

form

Use the following procedure to configure expedited Canada reports.

1. Enter the SQL syntax for SQL used to populate the "Is there an ongoing clinical
trial for this drug in Canada" field on the Canadian Expedited ADR report form.

2. Enter the SQL syntax for SQL used to populate the "Is there a clinical trial
application for this drug under review in Canada" field on the Canadian
Expedited ADR report form.

3. Enter the SQL syntax for SQL used to populate the "Is there a new drug
submission for this drug under review in Canada" field on the Canadian
Expedited ADR report form.

4. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in Phase
LI-IIT Study" field on the Canadian Expedited ADR report form.

5. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in Phase
I-IV Study" field on the Canadian Expedited ADR report form.

6. Click Save to save the changes made to this screen.

Expedited CIOMS Reports The Expedited CIOMS Reporting Configuration screen
enables you to modify the options available for expedited CIOMS reporting. Select
System Configuration --> System Management to view the Common Profile
Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel.

The Expedited- CIOMS sub-folder is displayed in the left panel. Click on the
Expedited-CIOMS sub-folder to configure the expedited CIOMS reporting options.

The configurable fields associated with Expedited - CIOMSReporting appear in the
right panel.
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Field Descriptions
The following table lists the fields available under Expedited- CIOMS Reporting;:

Field/Control Name Description

Print Patient ID, Study ID, Center ID in  Enables the user to print the Patient ID, Study ID
26. REMARKS section of the CIOMS and Center ID fields in the "26. REMARKS" section
form of the CIOMS form.

Print Medically Confirmed in the 26. Enables the user to print Medically Confirmed in the
REMARKS section of the CIOMS form  26. REMARKS section of the CIOMS form.

Print World Wide Number in the 26. Enables the user to print World Wide Number in the
REMARKS" section of the CIOMS form  "26. REMARKS" section of the CIOMS form.

Use the following procedure to configure the expedited CIOMS reports.

1. Select the Print Patient ID, Study ID, Center ID in the "26. REMARKS" section of
the CIOMS form checkbox to print these fields in the CIOMS form.

2. Select the Print Medically Confirmed in the "26. REMARKS" section of the CIOMS
form checkbox to print this field in the CIOMS form.

3. Select the Print World Wide Number in the "26. REMARKS" section of the CIOMS
form checkbox to print this field in the CIOMS form.

4. Click Save to save the changes made to this screen.
Expedited MedWatch Reports Configuration The Expedited MedWatch Reporting

Configuration screen enables you to modify the options available for expedited
MedWatch reporting.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.
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Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Expedited- MedWatch sub-folder is displayed in the left
panel.

Click on the Expedited-MedWatch sub-folder to configure the expedited MedWatch
reporting options. The configurable fields associated with Expedited -
MedWatchReporting appear in the right panel.

Valwe for fieid E4 on MedWatch

Wumber from LM_REF_TYPES.REF_TYPE_ID for Reference Type containing Legacy Case Number (to print MedWatch forms)

SlLused to populate BLA B in MedWalch Form

S0Lused to populate Unique Identifie (UD] #) in Medwatch Devices Foen.

Field Descriptions
The following table lists the fields available under Expedited- MedWatch Reporting:

Field/Control Name Description

Value for Field E4 on MedWatch Select the applicable value from the available options.
Value for Field G8 on MedWatch Select the applicable value from the available options.

Data to print on follow up The available options are:

MedWatch Device form = Allinformation (initial + follow-up) is displayed.

(Previous Behaviour).

= Only Display changed information from the initial
report.

Number from LM_REF_ This field enables the user to select the required option
TYPES.REF_TYPE_ID for Reference from the drop-down list.

Type containing Legacy Case

Number (to print MedWatch forms)

SQL used to print the BLA # Enables you to enter the SQL query used to print the
BLA#.

SQL used to print Unique Identifier Enables you to enter the SQL query used to print the
(UDI #) in MedWatch Device Form  UDI# in MedWatch Device Forms.

Use the following procedure to configure expedited MedWatch reports.
1. Select the option for the Value for Field E4 on MedWatch.
2. Select the option for the Data to print on follow up MedWatch Device form.
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3. Select the required option for Number from LM_REF_TYPES.REF_TYPE_ID for
Reference Type containing Legacy Case Number (to print MedWatch forms) from
the drop-down list box.

4. Add an SQL for BLA# and UDH, if there is a need to change the default logic for
these fields in MedWatch report.

5. Click Save to save the changes made to this screen.

Periodic Reports Configuration The Periodic Reporting Configuration screen enables you
to modify the options available for periodic reporting.

Select System Configuration --> System Management to view the Common Profile

Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Periodic sub-folder is displayed in the left panel.

Click on the Periodic sub-folder to configure the periodic reporting options. The
configurable fields associated with Periodic Reporting appear in the right panel.
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Field Descriptions
The following table lists and describes the fields available under Periodic Reporting:
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Field/Control Name

Description

Determine Primary Event for use
in ICH PSUR/CTPR report

Listedness grouping logic for ICH
PSUR/CTPR report output

Seriousness grouping logic for
ICH PSUR/CTPR report output

Inclusion Criteria for cases in the
ICH PSUR/CTPR report

Determine Possible Causality
from the causality score

Determine Probable Causality
from the causality score

On PSUR, NDA, IND, Medical
Review List Reports

Print footnote "Non-Serious
Listed’ for non-serious listed cases
in ICH PSUR report

The available options are:

= Primary Event (Left Most Diagnosis or the left-most
Event if there is no Diagnosis on the Case Form).

= Most severe event for the product (First left most
Diagnosis Related Serious Event with most weight on
Diagnosis then relatedness and then seriousness).

The available options are:

= Primary Event (refer to Inclusion criteria of event for a
product in the PSUR/CTPR switch).

s Case level Listedness

The available options are:

Primary Event (refer to Inclusion criteria of event for a
product in the PSUR/CTPR switch).

s Case level seriousness

The available options are:

»  Evaluate seriousness, listedness, relatedness, fatal
across all diagnoses/events against product

When this option is selected, the case inclusion criteria
logic in ICH PSUR/CTPR scans all the diagnoses in
the case and matches all the Seriousness, Listedness,
Relatedness, Fatal values for the diagnosis in the case
against the product(s) for which the report is being
run, with the corresponding values selected by the
user in the Report configuration.

When there are no diagnosis in the case, the system
scans all the events in the case and matches all the
Seriousness, Listedness, Relatedness, Fatal values for
the events in the case against the product(s) for which
the report is being run, with the corresponding values
selected by the user in the Report configuration.

When multiple products are configured in the report,
a match of all the Seriousness, Listedness, Relatedness
and Fatal values against even one product-diagnosis is
considered as a match for including the case.

= Evaluate case inclusion based on following
seriousness, listedness, causality option groups - Case
Inclusion criteria for the ICH PSUR/CTPR report
based on Seriousness OR Case Inclusion criteria for
the ICH PSUR/CTPR report based on Causality OR
Case Inclusion criteria for the ICH PSUR/CTPR report
based on Listedness.

This field enables the user to enter a numeric value.
This field enables the user to enter a numeric value.

The available options are:
»  Use Initial Receipt Date for date range search
= Use Safety Date for date range search
The available options are:
Yes
= No
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Field/Control Name Description

Assessment of Listedness and The available options are:
Causality when both Licenses and Based on selected liscenses
Studies are selected in CTPR "

s Based on selected studies

Use the following procedure to configure periodic reports.
1. Select the option for Inclusion Criteria for cases in the ICH PSUR report.

2. Select the option for Print footnote "Non Serious Listed" for non-serious listed
cases in ICH PSUR report.

Select the option for Inclusion criteria of event for a product in the PSUR.
Enter the value for Determine Possible Causality from the causality score.
Enter the value for Determine Probable Causality from causality score.

Select the option for On PSUR, NDA, IND, Medical Review List Reports.

N o a 0

Click Save to save the changes made to this screen.

Scheduling Reports Configuration The Scheduling Reports Configuration screen enables
you to modify the options available for scheduling reporting. Select System
Configuration --> System Management to view the Common Profile Configuration
screen.

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting
folder in the left panel. The Scheduling sub-folder is displayed in the left panel.

Click on the Scheduling sub-folder to configure the scheduling report options. The
configurable fields associated with Scheduling Reports appear in the right panel.
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Field Descriptions
The following table lists and describes the fields available under Schedule Reports:

Field/Control Name Description

Report Scheduling The available options are:

= Report Scheduling will be run by the Middle Tier
Service

= Allreport scheduling will be done locally on the
client machine

Enable separate scheduling of device The available options are:

reporting rules from drugs and

. = Yes
vaccines
] No
Report Scheduling Causality Enables the user to select from the causality operands
Operand AND/OR to use for scheduling a report.

Use the following procedure to configure scheduling.

1. Select the option for Report Scheduling.

2. Select the option for Enable separate scheduling of device reporting rules from
drugs and vaccines.

3. Select the operand to use for scheduling a report from Report Scheduling
Causality Operand.

4. Click Save to save the changes made to this screen.

Configuring Security

The Security Configuration screen enables you to modify the options available for
security. Select System Configuration --> System Management to view the Common
Profile Configuration screen.
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Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the Security section, click the Common
Profile--> Security folder in the left panel. The configurable fields associated with

Security appear in the right panel.
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The following table lists the fields available under Security:

Field/Control Name

Description

Number of previous passwords that
cannot be repeated

Number of non-alpha characters in
password

Minimum number of characters in
the password

Use Secure property for cookies

Enables you to configure the number of passwords that
can be allowed.

For example, if you enter 4 in this field, it configures the
system to enable up to 4 previous passwords that
cannot be used as passwords again.

Enables you to configure the number of non-alpha
characters that should exist in a password. Non-alpha
characters include characters such as @, $, etc.

Note: To avoid bad configuration, we recommend that
the value of this switch is kept as 0 or 1 only.

Enables you to configure the minimum number of
characters that a password must have.

For example, if you enter 8 in this field, it configures the
system to ensure that every password contains at least 8
characters.

Enables you to select whether to use secure property for
cookies.
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Field/Control Name Description

Number of consecutive failed login ~ Enables you to configure the number of consecutive
attempts before account is locked out failed login attempts that can be allowed before an
account is locked out.

For example, if you enter 3, it means that up to 3
consecutive failed login attempts are allowed. If the
fourth consecutive login attempt also fails, the account
gets locked out.

Use the following procedure to configure security.

1. Enter the value for the number of unique previous passwords in Number of
previous passwords that cannot be repeated.

2. Enter the value for the number of non-alpha characters in Number of non-alpha
characters in password.

3. Enter the value for the minimum number of characters for a password in
Minimum number of characters in the password.

4. Enter the value for the number of consecutive failed login attempts in Number of
consecutive failed login attempts before account is locked out.

5. Click Save to save the configured values.
6. Click LDAP to configure the LDAP fields.
The configurable fields associated with LDAP appear in the right panel.

Field Descriptions
The following table lists and describes the fields available under LDAP:

Field/Control Name Description

Enable LDAP at system level The available options for this are :
= Yes
= No

Use the following procedure to configure security:
1. Select the option for Enable LDAP at system level.

2. Click Yes to enable the LDAP Search Domain Account. This displays the LDAP
Search Domain Account dialog.
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The following table describes the fields of the LDAP Search Domain Account
dialog:

Field/Control Name Description

Use Secure Socket If your LDAP Server is configured to use SSL for communication,
Layer please check this box. Use of SSL enables for a Secure communication
between the client and the server using secure keys.

Force Anonymous When setting up the LDAP Server, you have the option to force users

Binding for Search to bind (authenticate) to the LDAP Server prior to being able to search
the LDAP Tree. If this option has been setup in your LDAP server,
this option must be checked.

UserDN During the setup of the LDAP server, the distinguished name and
tree structure is created for users to be configured under. Enter in the
defined structure as defined in your LDAP server into this box. This
is required only if the server is setup for Force Anonymous Binding
for Search”.

Password Enter in the password for the User entered in the UserDN box for the
bind to the server.

Server Name Enter in the LDAP Server name or IP Address to which LDAP
Authentication needs to occur on.

Port Number Enter the port on which the LDAP Authentication Services are
enabled on the LDAP Server (Default Value: 389).

BaseDN Enter in the topmost distinguished name of your tree defined on the
LDAP Server for which you would like to search for users under.

Time Out (Sec) Enter a value in seconds, which will tell Argus how long to wait for a
response from the LDAP Server during any authentication before
timing out (Default Value: 10).

LDAP Search Key Enter the key to authenticate the user name against in the LDAP Tree
structure. For Example, when using Microsoft Active Directory, to
authenticate using the Windows Username (Not Full Name), enter in
sAMAccountName.
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5.

s If you select the Use Secure Socket Layer (SSL) checkbox, the Port Number is
auto-populated with the value 636.

»  If this checkbox is not selected, the Port Number is auto-populated with the
value 389.

= A generic LDAP server can accept anonymous as well as non anonymous
binding, based on the configuration.

s If the Force anonymous binding for search? checkbox is not selected, both
UserDN andPassword are enabled.

Enter the LDAP username and password in the UserDN and Password fields,
respectively.

Enter the values for Server Name, Port Number, Base DN, Time Out and LDAP
Search Key, as required.

s The field length for Port Number and Time Out is 5 characters, while the
Server Name, BaseDN, LDAP Search Key, UserDN and Password can be up
to 255 characters.

Click Save to save the changes made to this screen.

Configuring Cryptography within Common Profile > Security

Common Profile > Security > Cryptography contains two key settings:

1.

Configured hashing algorithm to use - This setting determines the Hashtag
algorithm that will be used in encrypting passwords.

*De-optimizer counter for hashtag routine* - This setting determines the strength
of encryption (for example, the higher the value of this setting, the stronger will be
the encryption, and vice-versa). The default/recommended value is 1000.

Configuring Single Sign-on

A common profile switch determines whether the system uses the Single Sign-on
function. The Enable Single Sign-on checkbox, enables you to configure the system to
use the single sign-on feature.

Before enabling the single sign-on feature, be aware of the following:

If the user enables the Single Sign-on feature, the user must enter Single Sign-on
the HTTP Header element Argus application uses for authentication.

— This field can contain a maximum of 40 characters

- If the Single Sign-on feature is enabled and the user does not enter the Single
Sign-on HTTP Header, the system displays the following error message:

Please enter the Single Sign-on HTTP Header or disable the Single Sign-on feature.

The following new entries which are common across all enterprises have been
added in Argus Console -> System Management (Common Profile Switches) ->
Single Sign-On:

A new checkbox called Use Oracle Access Server SDK for LDAP Validation
under Single Sign-On tree will become available for selection only when 'Enable
Single Sign-On' is checked.

This configuration is used to identify use of Oracle ASDK for user action
confirmation , ESM login and EOSU Login functionality.
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m If this checkbox is checked, Oracle ASDK is user for action confirmation , ESM
Login and EOSU Login when Argus Safety is configured for Single Sign-On.

s If this checkbox is not checked, LDAP server information is used from Argus
Safety database for user action confirmation, ESM Login and EOSU Login.

A new textbox called Oracle Access Server Login URL has been added under the
Use Oracle Access Server SDK for LDAP Validation checkbox.

= This is the base URL which is be passed to Oracle ASDK for user validation
against Oracle Access Manager.

A new textbox called Oracle Access Server Login URL has been added under the
Use Oracle Access Server SDK for LDAP Validation checkbox.

s Thisis an HTTP Header variable for retrieving the short org ID which is to be
passed with ASDK Login URL.

If the Use Oracle Access Server SDK for LDAP Validation checkbox is checked,
the application ignores any LDAP configuration present in Argus Safety database

and it is not be possible to select LDAP Server Alias for any user from Argus

configuration.

The following table lists dialog boxes in the Argus Application that must require
passwords. In such cases, the system Single Sign-on feature redirects the password to
Argus for validation. When single sign-on is enabled, the system locks the user
account if the user enters and incorrect password three consecutive time. The
Administrator must unlock the account to enable the user to log in to the application.

Function Section Procedure

Case Locking Activities | Lock Locking a case

Case Unlocking Activities | Lock Unlocking a case

Case Closing Activities | Close Closing a case

Case Unclosing Activities | Close Unclosing a case.

Case Unblinding General | Blinding Status Breaking a blind

E2B Incoming Accept Reports | Incoming E2B Accepting E2B Reports
Reports

E2B Incoming Reject Reports | Incoming E2B Rejecting E2B Reports

E2B Incoming Follow-up
Accept

E2B Incoming Follow-up
Reject

E2B Incoming
Nullification Accept

E2B Incoming
Nullification Reject

LAM Incoming

Workflow Routing

Reports

Reports | Incoming E2B
Reports

Reports | Incoming E2B
Reports

E2B Incoming Nullification
Accept

E2B Incoming Nullification
Reject

Local Affiliate Incoming
Review

Workflow Routing on
Password on Route

Accepting E2B Follow-up Reports
Rejecting E2B Follow-up Reports

Accepting E2B Nullification
Reports

Rejecting E2B Nullification
Reports

Accepting an Affiliate Event

Workflow Routing on Password
on Route

Oracle Access Server SDK Support for LDAP Validation in Single Sign-On

Environment
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Argus Safety has been enhanced to support action confirmation (user id /password)
using Oracle Access Server SDK.

If customers do not want to store the LDAP information in Argus database for single
sign-on environment, this new feature of Argus Safety can be used to validate a user's
actions through ASDK.

This feature is available only while using Oracle Access Manager as the Single Sign-On
tool.

The following is a list of places where the Argus Safety web dialog which requires
action confirmation to perform respective actions, has now been enhanced to validate
a user using Oracle ASDK:

1. Case Lock/Unlock
Case Routing

Case Delete/Undelete
Case Archiving

LAM Routing

Study Unblinding
ESM Login

EOSU Login

® N o g »~ 0 b

There is no change in the user experience while performing actions which requires
password validation for logged-in user.

The following modules launched in the Argus Application, continue to use Single
Sign-on feature:

= Argus Insight

s Argus Affiliate

s Argus]

The following modules do not use the Single Sign-on feature:
= End of Study Unblinding

= Argus Safety Services

= Argus Interchange Services (ESM)

= Argus Interchange Mapping (ESM Mapping Ultility)

Error Messages

Once the user is configured, the system automatically logs the user into the Argus
Application without requiring reauthentication on the Argus Login application. If
there is an authentication error, the system displays the current login page so the user
can log in manually.

Configuring SMTP

This screen enables you to configure SMTP.
Currently there are multiple issues such as, Outlook related problems with AG Service
due to new security features introduced by Microsoft. Due to these security

enhancements, a new method to submit emails from AG Service has been
implemented using the SMTP Protocol.
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Select System Configuration --> SMTP Configuration to view the SMTP
configuration pop-up dialog. The pop-up dialog opens as shown.
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Field Descriptions The following table lists and describes the fields associated with this

section.

Field /Control Name
Server IP or Name
Port

Authentication

SMTP User Name

SMTP Password

Enable SMTP

Description
Enables the user enter the SMTP server name / IP address.
Enables the user to enter the port number to use for SMTP server.

Enables the user to select the Authentication mode for SMTP
configuration

This is the username that the AG Service authenticates with for SMTP
Emailing.

This is the password that the AG Service authenticates with for SMTP
Emailing.

This field is required when Basic Authentication is selected in
Authentication.

When this checkbox is checked, SMTP is used by AG Service to send
emails.

Use the following procedure to modify SMTP.
1. Enter the SMTP Server IP or Name.

2. Enter the Port number to use for SMTP server.

3. Select the Authentication mode for the SMTP configuration, from the drop-down

list.

4. Enter the SMTP User Name.
5. Enter the SMTP Password.
6. Select Enable SMTP? to ensure that the AG Service implements SMTP to send

e-mails.

7. Click OK to save the changes made.

Configuring Workflow Items
The Workflow Items screen enables you to modify the options available for Workflow

Items.

Select System Configuration --> System Management to view the Common Profile
Configuration screen.
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SiRACLE

Tip: The Common Profile folder appears in a tree-view on the left
panel. The components are categorized as folders. Each folder
contains all the field labels associated with that section.

To configure the fields associated with the User Interface section, click the Common

Profile--> Workflow folder in the left panel. The configurable fields associated with
Workflow appear in the right panel.
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This section enables you to configure the total number of hours remaining for the
present workflow state as well as the Total Number of the hours remaining for the case
lock.

s The first element displays the number of hours remaining for the case to be
processed with the current workflow state.

s The second element displays the number of hours remaining for the entire
workflow for the case till Case Approval (Case Lock).

= If the time remaining is less than the specified value in % for Yellow Indicator on
the Case form for Dynamic Workflow, the elements are highlighted in yellow.

= If the time remaining is more than the specified value in % for Yellow Indicator
on the Case form for Dynamic Workflow, the elements are highlighted in green.

»  If the time remaining has exceeded the allocated time for the case process, the
value is displayed in red, with the time displayed in negative.

= The exceptions to this feature are those cases, which are archived and locked.

The Worklist>New and Worklist>Open also display a !" status beside Priority,
denoting that the time remaining has exceeded the allocated time.
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The total number of units is calculated by navigating across the possible routes the
case can traverse. In case a case has to traverse through multiple possible routes, the
preferred route is selected.

Field Descriptions The following table lists the fields available under Workflow:

Field/Control Name

Description

Case Routing

Display Locked /All
cases on the worklist

Minimum length of
the routing comment
text length

Due Soon Duration
(in Days) for Worklist
Calculation

Due Soon Red
Indicator (in Days)
for Worklist Display

% for Yellow
Indicator on the Case
form for Dynamic
Workflow

Enable Dynamic
Workflow Timing

The available options are:

= Case form to close after use performs a manual routing
= Case form to remain open

The available options are:

= Display option on the Worklist screen to view Locked Cases
requiring follow-up only. (Default)

= Display all the cases at the time
The available options are:
= None

s Text field

Enter the number of days in which the worklist calculation is due.

Enter the number of days in which the red indicator is to due to be
displayed for the worklist.

Enter the percentage for the yellow indicator on the case form for
dynamic workflow. This field cannot have a value more than 99.

Select this checkbox to view the dynamic workflow indicators on the
case form.

Use the following procedure to configure workflow items.

1. Select the option for Case Routing.

Select the option for Display Locked/All cases on the worklist.

Enter the Minimum length of the routing comment text length in the text box.

2
3
4. Select the option for Display date for cases in the worklist.
5

Enter the number of days in which the worklist calculation is due in Due Soon
Duration (in Days) for Worklist Calculation.
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6. Enter the number of days in which the red indicator is to due to be displayed for
the worklist in Due Soon Red Indicator (in Days) for Worklist Display.

7. Enter the percentage for the yellow indicator on the case form for dynamic
workflow in % for Yellow Indicator on the Case form for Dynamic Workflow.

8. Select the Enable Dynamic Workflow Timing checkbox to view the dynamic
workflow indicators on the case form.

9. Click Save to save the changes made to this screen.

Configuring Workflow

When a case is received by the company and initial details have been entered and
saved into Argus Safety, its status in the system becomes 'New' or 'Data Entry'. Various
actions may be required before a case makes the transition from one workflow state to
another.

Example: The case may require review, letters may need to be issued, the case may
need to be reported elsewhere in the company, or regulatory reports need to be
submitted to regulatory authorities. The case can be closed after all outstanding
actions have been carried out and it flows through its life cycle.

For each stage in case processing, Argus Safety enables responsibility for cases to be
assigned to specific user or group of users. Click the following link for information
about how worklist permissions have changed.

Worklist Updates

The Worklist is driven by the group permissions defined for each user.

s Granular permissions have replaced the current worklist options for the following
worklist elements in group permissions:

—  Worklist - New

-  Worklist - Open

—  Worklist - Reports

—  Worklist - Action Items

- Worklist - Coding Action Items
—  Worklist - Contacts

—  Worklist - Bulk Transmit

—  Worklist - Bulk Print

—  Worklist - Bulk E2B Transmit

- Worklist - Local Labeling

- Worklist - Coding Status

—  Worklist - Letters

—  Worklist - Intake (default is disabled)

= If the worklist is disabled during the upgrade, then all the sub-elements are
disabled; otherwise, all are enabled.

n  The default for New Group Creation is enabled.

s The User Group Permissions Report has been updated to reflect granular
permissions.
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Configuring Case Workflow
Configuring case workflow involves configuration of:

s Workflow States
s Workflow Rules

Configuring Workflow States This screen enables you to configure the workflow states.
The following illustration shows the fields associated with this section.
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Field Descriptions
The following table lists and describes the fields available under Total Number of

Rows:

Field/Control Name Description

State Name Displays the name of a workflow state.
State Description Displays a brief description about the workflow state.
Site Displays the site associated with a workflow state.

Tip: Click Add New to add a new workflow state to the list of
existing workflow states.

Use the following to modify workflow states

1. Enter the name of the workflow state under State Name.

Tip: This name is displayed as Case Status in the General
Information section of the Case Form.

2. Enter the description of the workflow state under Description.
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3. Select the site to be associated with the workflow state from the Site drop-down
list.

4. The drop-down list is populated with the configured user sites.

5. Click Save to save the changes made.

Configuring Workflow Rules This screen enables you to configure workflow rules. The
following illustration shows the fields associated with this section.
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Field Descriptions
The following table lists the Field Descriptions for this section.
Field/Control Name Description
From Defines the original state for the transition.
To Defines the destination state for the transition.
Group Specifies the group which will own the case once it moves from the

From state to the To state (via this transition).

The drop-down list displays all the configured user groups of Argus.
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Field/Control Name

Description

Normal Time (days)
Max Time (days)

Units

Product Group

Restrict to Workflow
Group

Email

Require Password on
Route

Lock Case on Route

Reason for not being
able to route

Privileges to others

Preferred State

The workflow system monitors the time frames of each case in a state
with respect to the Normal and Maximum parameters through AG
Service.

= The AG Service evaluates the status of each open case.

= Ifacase has existed in its current state longer than the Normal time
specified for the transition, the system raises the priority of the case
by one level.

This escalation occurs only once for a case within a given state.

»  The case priority is not reset to its assigned priority upon
transition.

= If a case has existed in its current state longer than the Maximum
time specified for the transition, the system raises its priority to
level one (the highest priority).

= Inaddition, an email notification is sent to the group's supervisor,
indicating that the case has exceeded its maximum time.

= The email message identifies the Case ID, Current State, Current
Owner, and the time it has spent in its current state.

Enables the user to specify the number of units.

Enables the user to associate a specific Product group as additional
criteria for the workflow transition.

Enables the user belonging to the identified workflow rule group to
have case access rights, based on the definitions of only the identified

group.
When checked, the system sends an email notification to the user group

address specified in group information whenever a case makes this
particular transition.

By default, the checkbox is unchecked.

»  If the switch PASSWORD_ON_ROUTING" is disabled (0), the
password option on the Workflow Dialog is not displayed and the
Routing dialog does not ask the user for a password.

n  If the switch PASSWORD_ON_ROUTING" is enabled (1), the
password option on the Workflow Dialog is displayed to users. If
the Workflow Rule has the password option checked and the case
being routed passes that workflow rule criteria, the password
option is displayed on the routing dialog.

= If the Workflow Rule that the case has passed does not have the
Password option checked, no password option is displayed on the
routing dial.

Enables the user to lock the case on routing. Users might need to enter a
password when routing to the case.

Enables the user to enter the description needed by the system to
display while routing the case, when the case is ineligible to be routed
to any of the configured To State.

Specifies the access rights for groups other than To Group' of the
transition have to the case when it follows that transition. The choices
are:

»  No Access
= Read-Only
=  Read/Write (default)

Enables the user to specify the preferred state for the rule.
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Use the following procedure to modify workflow rules.

1.

17.

18.

Select the appropriate Filter Criteria.

= Execute the following steps to apply a filtering criteria to search for specific
workflow rules.

= Select the check boxes to enable the drop-down lists containing a filtering
criteria.

= Select the appropriate filtering criteria from the drop-down lists.

s Click Search to remove the selected criteria or click Apply Filter to apply the
selected criteria. This displays the search results under Total Number of
Rows.

The entities in Total Number of Rows display the From and To states, the
Advanced Condition, Group, Normal Time/Max Time and Number of User
Defined Attributes in the Workflow.

Select the rule displayed under Total Number of Rows that needs to be modified.

The ModifyWorkflow Rules section is populated with information about the
selected rule.

Select the original state of the workflow rule from the From drop-down list.
Select the destination state of the workflow rule from the To drop-down list.
Select the group from the Groups drop-down list.

Select the product from the Product Group drop-down list.

Select the Email checkbox, if required.

. Select the Lock Case on Route checkbox, if required.

. Select the Require Password on Route checkbox, if required.
. Enter the number of days in the Normal Time (days) field.

. Enter the number of days in the Max. Time (days) field.

. Enter the number of units in the Units field.

. Select the preferred state for the rule from Preferred State.

. Select the relevant Advanced Condition, if any from the button.

Tip: Click here for details on Advanced Conditions
Enter the reason for not being able to route, if applicable, under Reason for not
being able to route.

Specify the access levels available to others from the Privilegesto others
drop-down list. The options available under this list are No Access, Read-Only
and Read/Write.

Tip: Select the No Access option to disallow users outside the
transition's group to open the case when it follows the transition.

Select the Read-Only option to enable users outside the transition's
group to view the case, but not to modify it.

Select the Read /Write option to enable users outside the transition's
group to modify the case when it follows the transition.
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19. Specify the checklist of items to appear under Checklist.

Tip: The Checklist row cannot be left blank. Click Add and Delete to
add and delete checklist items.

20. Define custom attributes for a workflow rule under User Defined Attribute.

21. Click Save to save the changes made.

Worklist Intake
This section provides information about the Worklist Intake feature.

Pending Dialog The system enables the user to view a list of incoming attachments in
Worklist View. In this view, the user can select an attachment for the case creation for

Argus and Affiliate cases in the Pending dialog.
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The following table lists and describes the fields available for the worklist

Field/Control Name Description Bookin Field Property

Priority Enables you to view the N/A Non-scrollable
priority of a case field label

Initial Date Enables you to view the Initial Initial Receipt Non-scrollable
Receipt Date of the case. Date field label

Intake Date Enables the user to view the ~ N/A Non-scrollable
date the system imported the field label
attachment in the Intake
Worklist

Product Name Enables you to view the Product Name Scrollable field
suspect product in questions. label

Generic Name Enables you to view the Generic Name Scrollable field
generic name of the suspect label
product in question.

Event PT Enables you to view the N/A Scrollable field
primary event and verbatim as label

reported

System Configuration 4-75



System Configuration Overview

Field/Control Name

Description

Bookin Field

Property

Event Verbatim

Serious

E LT orH

Case Type

Study ID

Reporter Type

Country

Central / Affiliate Site

Attachment

Classification

The following format will be

used:

Primary Event (Verbatim as

Reported)

Enables you to view the Case

Level Assessments Serious
(Y/N)

Fatal (F) or Life Threatening

(LT) or Hospitalized (H)

If the case is Fatal, print F

If the case is Life
Threatening, print LT

If the case is Hospitalized,

print H

If any of the preceding are

present together, Fatal
takes precedence

followed by LT, followed

by H

If the case is neither,
display No

Enables you to view report
type information.

Enables you to view the Study

ID for the study cases

This field is empty for cases

where the Study ID is not
available.

Enables you to view the

reporter type for the primary

reporter in the case.

This field is empty if the

reporter type is not available.

Enables you to view the
country of incidence

Enables you to view the

current Argus or Affiliate site

of the case.

You can view all the source

documents from the site folder

the user belongs to

Workflow enterprise users can

view all cases across all site

Enables you to view the

attachment associated with the
case. If there are multiple files,

they are separated by a
comma.

Enables you to view the
attachment classifications
associated with the
attachment.

N/A

N/A

Death for F

Hospitalized for H

Life Threatening
for LT

Report Type

Study ID

N/A

Country of
Incidence

N/A

N/A

Classification

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Non-scrollable
field label

Scrollable field
label

Scrollable field
label

Non-scrollable
field label link

Scrollable field
label
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Field/Control Name Description Bookin Field Property
Description Enables you to view the Description Scrollable field
attachment description label

associated with the case.

View All Enables the administrator and N/A Radio button
workflow manager/enterprise
to see all items in the system
across all sites.

View Individual Enables you to view all items  N/A Radio button
assigned to this user site.

s If there are no sites
defined then all users
have access to the case
attachment.

s This button is disabled if
the user is not a workflow
manager or enterprise
user.

Worklist Intake View The following table describes the Worklist Intake View:

Argus Site Folder Worklist Intake View

US C:\USINTAKE All users belonging to the US site can see the
case and workflow enterprise users.

DE C:\EUINTAKE All users belonging to the DE, FR, CH site can
see the case and workflow enterprise users.

CH C:\EUINTAKE All users belonging to the DE, FR, CH site can
see the case and workflow enterprise users.

FR C:\EUINTAKE All users belonging to the DE, FR, CH site can
see the case and workflow enterprise users.

JP C:\JPINTAKE All users belonging to the JP site can see the

case and workflow enterprise users.

Worklist aThe system reads the XML that contains the preceding fields as tags and
creates the Worklist based on the tags.

<Cases>

<Case>

<PRIORITY>: Single number from 1 - 8. All others to be ignored
<INITIAL_DATE>: Format of Date DD-MMM-YYYY
<PRODUCT_NAME>: Text Field up to 70 Characters
<GENERIC_NAME>: Text Field up to 70 Characters
<EVENT_PT>: Text Field up to 250 Characters
<EVENT_VERBATIM>: Text Field up to 250 Characters
<SERIOUS>: Yes / No. All others are ignored

<FLTH>: Format of F. All other after that are ignored
<LT>: Format of LT All other after that are ignored
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<H>: Format of H. All other after that are ignored
<CASE_TYPE>: Text field of report type

<STUDY_ID>: Text field of Study ID

<REPORTER_TYPE>: Text field of Reporter Type
<COUNTRY_OF_INCIDENCE>: Text field of Country
<ASSIGNED_TO>: Text field of User

<GROUP>: Text field of Group

<SITE>: Text field of Site

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name
<DOCID>: Document ID from Document Storage System
<CLASSIFICATION>: Text field of Attachment Classifications
<DESCRIPTION>: Text field of Attachment Classifications Descriptions

The text on the worklist prints as specified in the XML and no lookup is
performed.

If any of the Tag elements are empty they will be empty in the Intake Worklist.
If any fields are not available on the initial case entry, the system ignores them.

If there are multiple tags for the same element, the system retrieves the first tag
element.

If the values do not match any elements in the Initial Case entry, the system
ignores them.

The minimum fields required for the Attachment to be visible in the Intake
Worklist are

— Filename
—  DocID

- DoclD is only required if a central document system is enabled. If DoclD is
blank then the physical file with the same name as specified in the tag
<Filename> is also required in the same folder.

If there is an error occurs while processing the Worklist, AG Service sends an
e-mail to the General E-mail address.

The system enables you to select only one case at a time when creating cases in the
Initial Case entry dialog.

—  When you select an attachment row and click Create case, the system locks the
file to prevent others users from booking in the same case.

— The system displays the following message:
The case attachment is being currently used by XXXX user.
where:

XXXX is the full name of the user who has locked the attachment row
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The system displays the standard Initial Case Entry where the system
populates the fields within the XML Properties to the Initial Case entry dialog
and display the PDF file for 40% of the screen (Similar to the New case from
Image functionality)

If multiple attachments are available, the system opens them. The end user
system must be setup to open multiple documents in the same window in
Internet Explorer.

If the system is setup to use a central document storage system and the user
clicks Create Case, the system retrieves the PDF from the central document
system.

The system adds the attachment to the Initial Case entry dialog and also
includes the Classifications and Descriptions for the attachment.

If the system is setup to use a central document storage system, Argus stores
the document ID from the central document system. The file attachment will
not be stored in Argus.

The system fills all available fields in the Initial Case Entry dialog with data
from the XML Messages.

If you choose to open the cases after book-in, the system keeps the Attachment
open in the split screen to enable the user to complete the case data entry.

If you book in the case from the Worklist Intake and chooses not to open the
case from the Initial Case Entry dialog after book in is complete, the system
returns to the Worklist Intake dialog.

When you perform a Duplicate Search and select a Case from the list, you can
attach an incoming file to an existing case.

The system displays the Accept As Follow-up button and enables it when the
user selects a case from the Duplicate search for the current Attachments to be
added.

When you click Accept as Follow-up, the system opens the selected case and
continues to display the Source attachments.

The system adds the attachments with the Classification and description (if
provided) to the follow up case

The system opens multiple attachments if they are available. The end user
system must be setup to open multiple documents in the same window.

Once you accept the initial or Follow up case and successfully create the case in
Argus / Affiliate, the system generates an Acknowledgement in the OUT folder at
the same level. For example, if the incoming folder for Site US is
C:\USSITE\Incoming, the system generates ACKS in the C:\USSITE\OUT folder.

a. The Message format for the ACK is as follows::
<CASES>

<CASE>

<CASE_NUMBER>: Argus Generated Case Number

<PRODUCT_NAME>: Text Field up to 70 Characters for Primary Suspect
Product of Case
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<DATETIME>: The Date and time in the DD-MMM-YYYY hh:mm:ss format
when the file was accepted / rejected by the system

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name
<DOCID>: Document ID from Document Storage System

= If you click Copy to copy a case in Argus, the system generates an ACKS and puts
it into the out folder for the site the original case belongs to. For example, Case A
belongs to US Site and the user copies the case to Case B. The system creates an
ACK in the US\Out Folder as configured in the US Site.

Rejected Cases In Argus Safety, the Workflow Manager or Enterprise User can click
Reject Case to reject cases from the Intake Worklist.
= Affiliate Users can reject cases in the Intake Worklist.

— When you try to reject a case, the system presents the Standard Justification
dialog.

— The Status row displays the following message:
Case Rejected by XXXX on YYYY at MMM due to: ZZZZ
where:
XXX is the User Full Name,
YYYY is the Date when the case was rejected in GMT
MMM is the time in GMT
7277 is the justification for rejecting the case as entered by the user.

- Rejected Date: Date in GMT when the user rejected the case

- Rejected By: User Full Name who rejected the case.

= The system displays the Total number of Rows in the Worklist header section.

= You can select the number of cases to display on the by selecting a value from page
size drop-down list on the Worklist dialog.

s The page drop-down list contains the following values:
- 50
- 100 (default)
- 250
- 500
- 1000
- 2000

= The system displays the number of cases currently in view and updates the range
automatically. For example. if you select 100 from the page size drop-down list, the
system separates the displaying rows into groups of 100 cases.

= The system enables you to go directly to a range of cases from the Displaying
Rows drop-down list.
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The system enables you to scroll through the Worklist page-by-page increments as
defined by the Page Size drop-down list.

The system enables you to sort on ALL the columns in the Worklist view by
clicking the header column. The system displays a triangle to show which column
is sorted currently.

—  The initial sorted column is Initial Date.
— The default sort order is ascending

- Clicking the column header again, toggles between ascending and descending
order.

The system maintains the worklist view with the sorting and filtering options
defined by the user.

The Intake Worklist enables you to filter on each element.
The system enables you to filter on any element when you click the Filter button.

— The system provides a Type Ahead feature to enables users to filter on any
text/date element.

— The system enables you to Close the filtering options by clicking the X icon on
the filtering options.

- If filtering criteria are specified, the Filter icon has the paper clip icon to
indicate there are filtering elements.

— The system permits a Like search (e.g. if you search for Cure, it returns all
elements starting with Cure).

— The system enables wild card searches . For example, if the user searches for
%Cure, the system returns all elements containing Cure

- Clicking the Search button enables you to filter for the reports in the list of
reports.

— These are filtering options are available from Worklist-specific views and
when you drill down for cases or reports.

The system saves all user preferences for future use.

Clicking the Search button enables you to filter the elements on the dialog.

User Site Updates and Access Management You can configure the Path for the File Intakes
per Site (Argus and LAM) in the Site configuration

When you click the Browse button, the system enables you to browse to the Folder
for the Site where the XMLS and the PDFs are stored

The Path length is up to 255 characters
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ORACLE Welcome vanessa, Thurzday, March 3, 2011 (ASTO-DEFAULT)
Code Lists | Business Configuration | Access Management | System Configuration | Tools .
CODE LIST MAINTENANCE
Browser User Sites Filter
Organized by | Code List v | Field Value
| Description M | Cnntainsm | | [Finer ]
----- [ Lab Test Group m
----- [ Lab Test Type Total Number of Rows (2)
""" [ Letter Configuration Description - Abbreviation site Type
""" [ Literary Ciation Common Site cs Argus
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..... [ Message Type Modify User Site
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s The current Worklist options are replaced with granular permissions for Worklist
elements in the Group Permissions as per the following:

= Worklist Intake (default is disabled)
s The Audit Log tracks the updates made to Site Configuration
s The User Site print out displays the File Intake Path.

Configuring System Numbering

This screen enables you to specify the case numbering preferences. Select System
Configuration --> System Numbering to view the LAM System Numbering screen.

The screen appears as shown.
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Field Descriptions

The following table lists and describes the fields for this section.
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Field/Control Name

Description

Manually Number
Cases

Automatically
Number Cases

Start at

Separate sequence for
each site

Separate sequence for
each report type

Separate sequence for
each year

Separate sequence for
each month

Separate sequence for
each product
abbreviation

Numbering Format

Placeholder

Enables the user to manually number the cases on booking or while
copying the case, using the save as' option on the case form.

On selection, the system automatically numbers the cases as defined by
the user in the numbering format.

Enables the user to initialize the counter of the sequence number.

Enables the user to separate the sequence numbering for cases on site
by site basis. If there are cases being entered from two different sites
then each site will have different sequencing of case numbers.

Enables the user to separate the sequence numbering for cases by the
report type of the case.

Enables the user to reset the sequence numbering for cases after each
year based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases after each
month based on the initial receipt date of the case.

Enables the user to reset the sequence numbering for cases for each
different product abbreviation.

Enables the user to select the numbering format by selecting the
different placeholders.

Define the numbering format by typing in custom keywords to print on
every case number and selecting different placeholders.

[YY][MM]-[###] is the default format.

Placeholders are used to pickup values from the database to be used in
the Case numbering format.

The possible values populated in this list are:

# - Number: defines the digits to be used as the sequence number in the
format. The field is used to display the sequence number on the case
numbers.

CC- Country Code: When selected, this uses the A2 code for the country
of incidence for the case number.

DD - Day: When selected, this uses the date of the Initial receipt date’
field of the case.

MM - month: When selected, this uses the month of the Initial receipt
date' field of the case.

P - When selected , this uses either of the two values:

If report type is Spontaneous' or other' during booking: the system uses
the value of the Product Abbreviation' field specified in the Product
configuration for the selected Primary suspect product.

If report type is of the type report from study' during booking: the
system uses the Product Abbreviation' field specified in the study
configuration.

SSS - User Site: When selected this uses the Site abbreviation of the site
belonging to the user who booked in the case.

TTT - Report Type: When selected this uses the report type abbreviation
of the report type selected during bookin of the case.

YY- Year: When selected, this uses the year of the Initial receipt date'
field of the case.

Use the following procedure to configure LAM system numbering.
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1. Select the Numbering feature as required. This can be manual numbering or
automatic numbering of cases.

2. Select the Sequencing Options as required.

Tip: For the complete explanation of the sequencing options refer to
the Field Descriptions

3. Select the Numbering Format.

Tip: To customize the Numbering Format, use the placeholder
values.

Example: To select Country Code, Month and Year (as values to be
incorporated from the database ) as the Case numbering format,
execute the following steps.

»  Click on Country Code. This appears in the Numbering Format
field.

»  Click on Month. This appears in the Numbering Format field next
to the Country Code.

»  Click on Year. This appears in the Numbering Format field next to
the Country Code and Month.

The final data listed in the Numbering Format field is the Case

Numbering Format.

4. Click Save to save the changes made.

Configuring Field Labels

This section enables you to change field label names and hide or display fields in the
Case Form.

Select System Configuration --> Field Labels to view the Case Form Field
Configuration screen shown in the following illustration.
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Tip:

The Case Form tabs appear in the left panel and are categorized as
folders. Each folder contains all the field labels associated with that
section.

Example : The General Tab in the Case Form contains sections such as
Study, Follow-Up, Case Literature etc.

To view the list of field names associated with the Study section,
click Study in the left panel.

The field names associated with Study appear in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Field Name

Field Form Label

Help Text
Read Only
Drug

Enables the user to view the field name. This is a read only field.

be edited.

Enables the user to enter the field label names for those fields that can

Enables you to enter help text for fields that can be edited.

Enables you to make inrug, device, or vaccine field read- only.

Enables the user to make a field Read only in the Product tab, when the
Argus user chooses Drug" option on the Product screen.
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Field/Control Name Description

Device Enables the user to make a field Read only in the Product tab, when the

Argus user chooses Device" option on Product screen.

Vaccine Enables the user to make a field Read only in the Product tab, when the

Argus user chooses Vaccine" option on Product screen.

Hidden Enables the user to hide or unhide a field by selecting the radio button.

Select Yes to hide the field on case form; select No to unhide the field on
case form.

Note: Some fields cannot be hidden. Hidden fields do not appear in the
case form printout.

E2B Field When checked, hows which fields are required for E2B.

Use the following to modify case form field names.

1. Select the folder (or section) in the left pane, for which the field names are to be
modified.
2. The places the list of field labels associated in the right panel.
3. Click on the Field Name to be modified.
4. The system highlights the selected row is highlighted and puts the details about
this field in the Modify section at the bottom of the screen.
5. Enter the new field name in Field Form Label.
Tip: :This label will appear in the Case Form section.
6. Select the Hidden preference. Select Yes if you want to hide the field on the Case
Form.
7. Click this checkbox to indicate which fields are required for E2B.
8. Select any or all of the following options Drug, Device or Vaccine as Read Only
based on your requirement.
9. Click Save to save the changes made.
Note: Label Changes will not be reflected in Argus Case Form
unless IIS is reset.
Adding User Defined Fields

User defined fields of type Text, Date, and Number may be added to a Case Form.
Follow the steps listed below to add a user defined field to a Case Form and/or
confirm that the Case Form supports user-defined fields:

1.
2.
3.

In Argus Console, navigate to System Configuration > Field Labels.
In the left-hand section, select a Case Form by clicking on its name.

In the right-hand section with a title bar matching the selected Case Form, scroll
down till the words "User Defined.." are visible in the Field Name column.

Click on the desired Field Name.

In the lower, right-hand section, make the appropriate corrections and save any
changes.
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Note: Oracle Argus Safety controls the total number of User Defined
Fields on any given Case Form by only allowing a single occurrence of
each sequence number. Therefore, if "User Defined Number 1" is
used, "User Defined Text 1" and "User Defined Date 1" cannot be
activated. If a Date and/or Text field is desired the user must select
from the fields that have a higher sequence number such as User
Defined Date 2, User Defined Date 3, etc., thus always ensuring that
the sequence number is unique.

Configuring User Defined Fields

The Argus Safety administrator can customize a user-defined field as a drop-down list.
These drop-down lists may contain customized lookup data which can be
independent of Argus data.

Use the following procedure to create a user-defined field.

1. Identify the User Defined field in the CMN_FIELDS table.

Create a custom table containing lookup information.

Create a custom index and specify the required values for the table.
Update the record in the CMIN_FIELDS table for the User Defined Field.
Create a Role and Synonym for the table.

Restart IIS.

o a & 0 N

7. Verify the update made in the application.

Consider the following example that show a sample set of scripts required to configure
User Defined Fields as a drop-down list. Assume the requirement is for a User
Defined Field (UDF) with the following features:

Requirement: A User Defined field "SOURCE_OF_INFORMATION" to be created,
with its drop-down values as Fax, E2B, Letter, Email and Telephone under Case Form
-> General Tab -> General Information.

Attribute Value
Field Name SOURCE_OF_INFORMATION
Field Type Numeric (Text field type would not work)

Drop-down Values Fax, E2B, Letter, Email and Telephone

Field Location Case Form => General tab => General Information

Use the following procedure to create a user-defined field:
1. Login to Argus --> Argus Console --> System Configuration --> Field Labels.
2. Enter the Field Form Label as Source of Information.
3. Select No against Hidden and click Save.
4. Query the following required field for an update, based on the field_label
SELECT
field_ID, field_label, table_name, column_name, tree_view, data_type, data_length

FROM
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cmn_fields
WHERE
field_label LIKE '%SOURCE_OF_INFORMATION%};
5. Create a Custom Table
create table pf SOURCE_OF_INFORMATION(
pf_SOURCE_OF_INFORMATION_code number,
pf_SOURCE_OF_INFORMATION_desc varchar2(100))
/
6. Create a Custom Index
create index idx_pf_SOURCE_OF_INFORMATION
on pf_SOURCE_OF_INFORMATION (pf_SOURCE_OF_INFORMATION_code)
/
7. Insert values
insert into pf_SOURCE_OF_INFORMATION values (1, MI Fax');
insert into pf_SOURCE_OF_INFORMATION values (2, MI E2B');
insert into pf_SOURCE_OF_INFORMATION values (3, MI Letter');
insert into pf_SOURCE_OF_INFORMATION values (4, MI Email’);
insert into pf_SOURCE_OF_INFORMATION values (5, MI Telephone');
8. Update CMIN_FIELDS table
update cmn_fields
setjoin_type=1,
GUI field_type =6,
field_length = 100,
JOIN_FLD_ID = 50001,
select_table = 'pf_ SOURCE_OF_INFORMATION',
join_field = 'PF_SOURCE_OF_INFORMATION_CODE',
select_column = 'PF_SOURCE_OF_INFORMATION_DESC'
where field_id = 2130052;
/
commit;
/
9. Grant select to ARGUS_ROLE
grant select on pf_SOURCE_OF_INFORMATION to argus_role;
10. Create Public Synonym

create public synonym pf_SOURCE_OF_INFORMATION for argus_app.pf_
SOURCE_OF_INFORMATION;

11. Restart the Web Server.
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12. Clear the cache from Utilities > Clear Cache.

13. Go to the command prompt and enter the iisreset command for changes to take
effect.

14. Verify the outcome from the front end.
15. Login to Argus Safety and open a Case Form.

Go to General tab | General Information and check that the configured user-defined
fields display the updated drop-down text.

System Configuration 4-89



O

Code List Configuration

This chapter allows administrators to configure and maintain code lists in Argus
Safety through Argus and the Flexible Data Re-categorization feature.

These are detailed in the following sections:
s Configuring Code Lists > Argus
s Configuring Code Lists > Flexible Data Re-Categorization

Configuring Code Lists > Argus

Code List items appear at several locations in the Case Form. It is essential to configure
relevant Code List items in order to ensure that case entry in Argus Safety is done
according to your company's policies. Before configuring Code List items, the
Administrator should consult the company's policies and the terminology used by the
company.

To ensure that the Administrator does not have to enter excessive amounts of data
during Code List configuration, Argus Safety is shipped with factory data for many of
the Code List items.

Tip: The following Code List Items have been described to
familiarize you with the Code List configuration.

= For the complete set of Code Lists refer to the Argus
Console->Code List section.

»  The default help text associated with each code list item is
displayed at the bottom of the left panel.

Code List Item Description

Autosignals This screen helps in capturing Auto Signal information. Users can
define the criteria that triggers Autosignal within Argus

Batch Reports This screen helps in capturing Batch Reports information.

Letters The screen helps in configuring the system to create and schedule
letters automatically, according to pre-defined business rules.

Justification This screen helps in capturing justification information.

Electronic This screen helps in capturing electronic transmission recipient

Transmission information.

Recipient

Literary Citation This screen helps in capturing information about Literary Citations.
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Reporting This screen helps in capturing Reporting Destination information.
Destination

Routes of This screen helps in capturing Routes of Administration information.
Administration

Study Center This screen helps in capturing Study Center information.

Configuring Autosignals

This screen enables you to capture the Auto Signal information.Using this screen, you
can define the criteria that triggers Autosignal within Argus.

Example: If an event is reported within x number of days, an email is sent to the
defined individual or workgroup. The system checks for patterns each time new data
is entered, and sends e-mails to the appropriate individuals or departments on finding
a matching pattern.

Select Code Lists --> Argus to view the Code List Maintenance screen.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Name Enables the user to enter the name of the Autosignal. This is a
required field.

Number of Enables the user to enter the number of occurrences of the

Occurrences autosignal.

Occurrences of Enables the user to enter the user to select or create an advanced

condition for the autosignal through Select icon.
Number of days Displays the number of days for the autosignal.
As cases are entered  Enables the user to perform autosignal as cases are entered.

Every N Days Enables the user to enter the number of days, when autosignal
should be executed.

Email Enables the user to enter the email address of Argus users to whom
the email about autosignal occurrence should be sent.

Use the following procedure to configure Autosignals.

1. Click on the Autosignals folder in the left panel. The associated autosignal data
appears in the Total Number of Rows section in the right panel.
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2. Click on the Name (or row), to view the details associated with the selected

autosignal. The details appear in the Modify Autosignal section.

You can use the Autosignals Filter to make your search specific to an autosignal.
The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.
4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.
5. Enter the search criteria in Value.
6. Click Filter to apply the selected criteria.
This displays the search results under Total Number of Rows.
Tip: You can alternatively click Add New to create a new auto sig-
nal.: Click Copy to make an editable copy of an existing autosignal.
Click Delete to delete a selected autosignal.
7. Enter the name of the autosignal in the Name field.
8. Enter the number of occurrences of the autosignal in the Number of Occurrences
field.
9. Select or create an Advanced Condition, if any from the button in the Occurrences
of field.
Tip: Click here for details on Advanced Conditions
10. Enter the number of days for the autosignal under the Number of days field.
11. Select the As cases are Entered checkbox to perform autosignal as cases are

entered.
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12. Enter the number of days when the autosignal should perform under the Every N
Days field.

13. Enter the e-mail address that receives email about autosignal occurrence in the
Email field.

14. Click Save to save the changes made to this screen.

Configuring Batch Reports

This screen enables you to configure Batch Reports information.
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»  Scheduled reports can be automatically generated and stored in the database by
Argus Safety Service. This screen displays a list of all the existing Batch Reports.

= By default the Batch reports shown are memorized reports. The Argus user can see
the list of scheduled reports for memorized reports, using the Memorized Reports
option.

= Select Code Lists --> Argus to view the Code List page.
»  Click on the Batch Reports folder in the left panel.
The associated report data appears in the Total Number of Rows section in the right

panel.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Title This is the unique name for the batch report name.
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Field/Control Name Description

Report Enables the user to select a report that has to be scheduled.

Report Regeneration

Memorized report

Product Enables the user to select a product for which the report is generated.

Frequency: Every Enables the user to enter the number of days after which the report is to

Days. be generated. The value has to be --> 0.

Next Run Date Enables the user to enter the next date from which the report has to be
scheduled.

Advanced Condition Enables the user to select the Advance Condition that satisfies the

criteria which will trigger the Signal. You can either select an existing
criteria or create a new one.

Report Type Enables the user to select the type of the report.
Group Enables the user to select the group to which the report must be
assigned.

Use the following procedure to configure Batch Reports

1.

10.
11.

12.

13.

Click on the Report Title (or row), to view the details associated with that report.
The details appear in the Modify Batch Report section.

You can use the Batch Reports Filter to make your search specific to a batch
report. The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value

Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.
Tip:
You can alternatively click Add New to create a new report.
= Use Copy to make an editable copy of an existing report.

= Use Delete to delete an existing report.

Enter the Title Name for the batch report.

Select the Report Type from the drop-down list.

Select the Group to which the report must be assigned.

Select the report to be scheduled as Memorized Reports or Reports Regeneration.

Select the Frequency of generating the report after the specified number of days
have elapsed.

Select the Product for which the report is to generated, from the drop-down list
box.

Select the Report from the drop-down list.
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14.

15.
16.
17.

Enter the Next Run Date. This is the next date from which the report has to be
scheduled.

Select the Advanced Condition associated with the report configuration.
Click Select icon to launch the Advanced Conditions browser.

Click Save to save the changes made to this section.

Configuring Letters

Argus Safety enables the customizing of letter templates in order to correspond with
reporters or health officials and keep them updated with case activity. Access to the
Letter Configuration dialog can be granted to any user or user-group, as found
appropriate by the Administrator.
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To automatically generate a letter, the system reads a template that specifies the
information that must appear in the letter.

The template is a file in Rich Text Format (".rtf" format) that contains the letter text
and some field identifiers (also called placeholders). The system substitutes
information specific to the current case for the placeholders in the template. Thus,
a letter containing case-specific information is automatically generated.

The administrator can set up the system to create and schedule letters
automatically, according to pre-defined business rules. This section discusses the
creation, modification, and deletion of letter templates.

Select Code Lists--> Argus to view the Code List page.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured.

The details of this code list item appear in the right panel.
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Configuring letter (RTF) templates
RTF Document can be created using the required placeholders such as:

[patient_last_name], [product_name]:[n], [rec_vacc_date]:[n]:[m], [event_prior_
hist:primary_event], [reg_report_timeframe]

Most of the placeholders have one parameter or two and these are almost always

linked to sort order.

Here are some examples of how these placeholders extract data:

For single value columns:

[age] [case_id],[comments],[case_status],[country_of_inc]

For multiple value columns:

[event_death:primary_event] picks data from case_primary_event table

[event_death]:[n] picks data from case_event/lam_event table based on Sort order

[case_notes]:[n], [concentration]:[n],[drug_code]:[n]

For multiple parameter columns:

[ingredient]:[n]:[m] - It lists nth case product and lists its mth ingredient

Field Descriptions

The following table describes the fields associated with this section.

Field/Control Name Description

Name
Name (J)
Edit Template

Regulatory Cover
Letter

Schedule - Letter

Schedule - Action

Sites

Action Items

Return Email
Address

Advanced Condition

Enables the user to specify the name of the letter as it will appear in
the Letters menu.

Enables the user to specify the Japanese name of the letter as it will
appear in the Letters menu.

Enables the user to open the letter in MS-Word (template) for
editing.

Enables the user to indicate whether this letter template should
appear in the Regulatory Rules dialog Cover letter drop-down list
box.

Enables the user to enter the number of days (from the receipt date)
when the letter will be due.

The Action field enables the Administrator to specify the number of
days (from the current date) after which the Action Item for
following up on this letter will be due.

Argus Console provides the ability to configure letters to user sites.
Enables users to select single or multiple sites for that letter. The
system will only allow users to see letters that are configured to
their site.

The action items list is a drop-down list of action item codes from
the Action Type List Maintenance.

Enables the user to enter a default email address where the mails
will be sent. This address is displayed by default in the Activities tab
of the Case Form.

Enables the user to configure Advanced Conditions. If the case
matches with the Advanced Condition, the configured letter is
scheduled for the case.
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Use the following procedure to configure letters.

1.

10.

11.
12.

13.
14.

15.

16.

17.
18.

Click on the Letter Configuration folder in the left panel. The associated data
appears in the Total Number of Rows section in the right panel.

Click on the Name (or row), to view the details associated with that letter. The
details appear in the Modify Letter Configuration section.

You may use the Letter Configuration Filter to make your search specific to a
letter. The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.
Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.

Tip: You can alternatively click Add New to create a new letter.
= Use Copy to make an editable copy of an existing letter.

= Use Delete to delete an existing letter.

Click Select to specify the path of the letter template to be used.

Tip: Click Edit Template to save the existent template on to your
local drive of the system.

You can edit this template and repeat the step listed above, to ensure

that the updated template is used for letters.
Enter the name of the letter, as it will appear, in the Letters Menu section in Enter
a new item.
Click Add or Delete to configure letter to the user Sites.

Select the Action Item from the drop-down list box. The action items list is a
drop-down list of action item codes, from the Action Type List Maintenance.

Configure the Advanced Condition for the case.

Enter the Schedule (days)-Letter. This is the number of days from the receipt date
when the letter is due.

Enter the Schedule (days)-Action. This is the number of days from the current
date, after which the Action Item for the follow up on this letter will be due.

Enable the Regulatory Cover Letter option to indicate whether this letter template
should appear in the Regulatory Rules dialog.

Enter the default e-mail address in Return Email Address.

Click Save to save the changes made for this section.

Configuring Justifications

This screen enables you to capture justification information.
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Argus Safety users can enter the reasons for overriding system determinations using
the Justifications dialog. The Justification items appear on the Action Justification
dialog on the screen.

Select Code Lists--> Argus to view the Code List page.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured.

The details of this code list item appear in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Type Enables the user to configure the type.

Justification Enables the user to enter the justification.

Use the following procedure to configure justification.

1. Click on the Justifications folder in the left panel. The associated report data
appears in the Total Number of Rows section in the right panel.

2. Click on the Type (or row), to view the details associated with that justification.
The details appear in the Modify Justification section.

3. You may use the Justifications Filter to make your search specific to a justification.
The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

6. Enter the justification reason in Justification.
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9.

10.

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new
justification.

= Use Copy to make an editable copy of an existing justification.

»  Use Delete to delete an existing justification.

Select the Type from the drop-down list.
Enter the Value for the justification.

Click Save to save the changes made for this section.

Configuring Electronic Transmission

This screen enables you to configure electronic transmission recipient information.

Details of electronic transmission recipient such as name, title, address etc. are
submitted here.

Select Code Lists--> Argus to view the Code List page.
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Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions

The following table lists and describes the fields associated with this section.
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Field/Control Name

Description

Name

Title

Address

City

State /Province

Country
Postal Code

Phone

Fax

Email

Preferred Method

Enables the user to enter the name of Electronic Transmission
Recipient.

Enables the user to enter the title of Electronic Transmission
Recipient.

Enables the user to enter the address of Electronic Transmission
Recipient.

Enables the user to enter the city of Electronic Transmission
Recipient.

Enables the user to enter the state/province of Electronic
Transmission Recipient.

Enables the user to select the country of the user.

Enables the user to enter the postal code of Electronic Transmission
Recipient.

Enables the user to enter the phone number of Electronic
Transmission Recipient.

Enables the user to enter the fax of Electronic Transmission
Recipient.

Enables the user to enter the email of Electronic Transmission
Recipient.

Enables the user to select the preferred method of transmission
from the drop-down list. This can be by fax or by email.

Use the following procedure to configure the electronic transmission recipient.

1. Click on the Electronic Transmission Recipient folder in the left panel. The
associated data appears in the Total Number of Rows section in the right panel.

2. Click on the Name Title (or row), to view the details associated with that
electronic transmission. The details appear in the Modify Electronic Transmission
Recipient section.

3. You may use the Electronic Transmission RecipientFilter to make your search
specific to an electronic transmission recipient. The filtering criterion is essential as
it helps you to search for specific items

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new electronic
transmission recipient.

= Use Copy to make an editable copy of an existing electronic
transmission recipient.

s Use Delete to delete an existing electronic transmission recipient.

8. Enter the Name of the electronic transmission recipient.
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9.

10.
11.
12,
13.

14.
15.
16.
17.
18.

19.

Enter the Title of the electronic transmission recipient.

Enter the Address of the electronic transmission recipient.

Enter the City of the electronic transmission recipient.

Enter the State/Province of the electronic transmission recipient.

Select the Country of the electronic transmission recipient, from the drop-down

list.

Enter the Postal Code of the electronic transmission recipient.

Enter the Phone of the electronic transmission recipient.

Enter the Fax of the electronic transmission recipient.

Enter the Email of the electronic transmission recipient.

Select the Preferred Method of communication (by fax or email) for the electronic
transmission recipient.

Click Save to save the changes made to this section.

Configuring Event Groups

This screen enables you to configure Event Groups information.
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The list of terms which are used across labeledness determines are defined in a
central location for users. These users can update these event groups (list of terms)
when the product configuration updates are required or when MedDRA versions
are upgraded when MSSO releases the new MedDRA updates.

The values entered here and marked as Display appear in the Console > Business
Configuration > Products and Licenses > Product Family > Datasheet > Add
Event Groups section.

Terms tab
The following table describes the fields associated with Event Groups > Terms tab.
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Field Name Description

Event Group Name  Allows the user to enter a new Event Group name.

Event Group Name  Allows the user to enter a new Event Group name in Japanese. This

)

screen and its print form will be visible to only the Japanese users.

Display Allows the user to display the Event Group in Business Configuration >

Products and Licenses > Product Family > Datasheet.

Terms The Terms tab contains terms selected from the MedDRA browser.

These terms are displayed in the following format for English users:
MedDRA Term in English

These terms are displayed in the following format for Japanese users:
MedDRA Term in English (MedDRA Term in Japanese)

The count of the total number of MedDRA terms present for the case is
displayed on the header of the Terms tab.

Term Type Displays the type of the MedDRA term. This field can contain the

MedDRA term type values such as PT, HLT, HLGT or SOC.

Use the following procedure to configure Terms:

1.

10.

Click Event Groups on the left pane of the Code List.

You can use the Event Group Filter on the right pane, to make your search specific
to an event group. The filtering criterion is essential as it helps you to search for
specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.
Tip:
You can alternatively click Add New to create a new event group.
= Use Copy to make an editable copy of an existing event group.

= Use Delete to delete an existing event group.

Enter the name of the event group under Event Group Name.

If it is also required for a Japanese user, enter the Japanese name of the event
group under Event Group Name ().

Check the Display checkbox to display the Event Group in Business
Configuration > Products and Licenses > Product Family > Datasheet.

Click Export (or Import) to export (or import, respectively) a file in a valid file
format from (or into) your local system. Valid file formats require that the file be in
xls, .xIsx, or .csv formats.

Important: The format of the data in the csv, xls or xIsx file must be as follows:

It must have only a single column of data. An import file can have ~ 16 K Terms.
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The first/header row must have text as "PT" or "HLT" or "HLGT" or "SOC" in
upper or lower case.

All the rows below the header row must contain corresponding terms (text) such
as PT text or HLT text or HLGT text or SOC text.

11. Click Save to save the changes made to this tab.

Event Groups tab

Click the Event Groups tab to configure event groups.

The following screen is displayed:
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The following table describes the fields associated with Event Groups > Event Groups

tab.

Field Name

Description

Event Groups

The Event Group, selected from the Select button > Available Event
Groups dialog, is displayed as follows:

Event Group Name in English
The event group name is displayed in the following format for Japanese

users:
Event Group Name in English (Event Group Name in Japanese)

The count of the total number of Event Group Names present for the
case is displayed on the header of the Event Groups tab.

Select button Click this button to select the relevant event groups from the Available
Event Groups dialog.
This dialog displays the event groups in a tree-format, with the child
event groups being paired under the parent event groups.

SMQ tab

Click the SMQ tab to configure SMQ terms.

The following screen is displayed:
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The following table describes the fields associated with Event Groups > SMQ tab.

Field Name Description
SMQ The SMQ term is selected from the Add button > MedDRA Browser
dialog.

On clicking the Add button, the MedDRA Browser is displayed, as shown below:

MedDRA Browser
Current Coding Version MedDRA J Brows V14.0) MedDRA SMQ: | (B) Accidents and injuries (SNQ) b
search All Levels | I T
soc HLGT HLT PT LLT Synonyms
[ i I |l I |
Injury, poisoning and Injuries NEC Hon-site specific injuries Abdomen crushing A | Accident at work
procedural complications HEC Abdominal injury | Industrial accident
Accident Injury at work
Accident at home
Accident at work
E% Accidental death
Acetabulum fracture
Acoustic shock
Acrotrophodynia
Adrenal gland injury
Anal injury
Animal bite
Ankle fracture
Aortic injury
Aortic rupture
Arterial injury
Arterial rupture al
soc 10022117 Injury, poisoning and procedural complications
HLGT 10022114 Injuries NEC
HLT 10028511 Non-site specific injuries NEC
PT 10000372 Accident at work
LLT 10000372 Accident at work
Synonyms
(Export [ import | Fant || seteal] Save | concer |

Export:
The Export button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses > Product Family
> Datasheet

or, from:
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ii) Argus Console > Code Lists > Argus > Event Group
MedDRA terms are selected at any level of the MedDRA hierarchy.

On clicking this button, a dialog is displayed, that allows you to select the file type -
.csv / xls / xlsx file.

On specifying the file type, the selected PT terms are then exported in the Export file.
in the <PT terms> format.

Import:
This button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses > Product Family
> Datasheet

or, from:
ii) Argus Console > Code Lists > Argus > Event Group
MedDRA terms are selected at any level of the MedDRA hierarchy.

On clicking this button, a dialog is displayed, that allows you to browse and upload a
.csv / xls / xlsx file from the desired location on your local machine.

The format of the data in the selected file should be as follows:
It should have only one column of data
The first header /row must display 'PT” or '"HLT’ or '"HLGT” or 'SOC".

All the rows under the header row should contain corresponding terms such as PT
text, or HLT text, or HLGT text, or SOC text.

The MedDRA terms in the file should be matched against the MedDRA terms table at
the level specified in the header row. Duplicate terms within the import file should be
ignored.

If the user enters a search criteria at any levels of the MedDRA hierarchy and
continues to search for terms, the results obtained from the Import will be lost. The
user may need to import terms again, using the Import button.

Save:

The Save button is enabled only on selection of the PT termy(s).

Configuring Literary Citations

This screen enables you to configure information about Literary Citations.

s The information configured in this form is displayed in the Literature Info section
of the Case Form.

= Select Code Lists --> Argus to view the Code List Maintenance screen.
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Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions
The following table lists and describes the fields associated with this section.

Field/Control Name Description

Journal Displays the name of the journal where the citation appears. This is a
required field.

Author Displays the name of the author.

Title Displays the title of the citation.

Volume Displays the volume number of the journal where the citation appears.

Year Displays the publication year of the journal where the citation appears.

Pages Displays the number of pages in the journal where the citation appears.

Use the following procedure to configure literary citations.

1. Click on the Literary Citations folder in the left panel. The associated data appears
in the Total Number of Rows section in the right panel.

2. Click Journal/Author (or row) to view the details associated with the literary
citation. The details appear in the Modify Literature section.

3. You may use the Literary Citation Filter to make your search specific to a citation.
The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.
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6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new citation.
s Click Copy to make an editable copy of an existing citation.
s Click Delete to delete a selected citation.

»  Click Print to print the selected information as a PDF.

8. Enter the name of the journal in the Journal field.

9. Enter the name of the author of the citation in the Author field.
10. Enter the title of the citation in the Title field.

11. Enter the Volume Number in the Volume field.

12. Enter the year in the Year field.

13. Enter the number of pages in the Pages field.

14. Click Save to save the changes made.

Configuring Message Type
This screen enables you to configure information about message type.

s The message type specified in this section enables you to specify auto-submission
of reports.

= Select Code Lists --> Argus to view the Code List Maintenance screen.
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Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.
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Field Descriptions
The following table lists and describes the fields associated with this section.

Field/Control Name Description

Message Type Displays the message type for a report.

English ICSR Displays if the message type belongs to English ICSR.

Expedited /Periodic ~ Displays if the message type is expedited or periodic.

Note: By default, ICHICSR is considered as Expedited, while the other
message types are considered as Periodic.

Description Displays a description about the message type.

Auto Submit Displays if the report has been auto submitted.

Japan ICSR Displays if the report belongs to Japan ICSR.

Display Displays if the report needs to be displayed or hidden.

Use the following procedure to configure message type.

1.

10.
11.
12.
13.
14.

Click on the Message Type folder in the left panel. The associated data appears in
the Total Number of Rows section in the right panel.

Click Message Type (or row) to view the details associated with the message type.
The details appear in the Modify Message Type section.

You may use the Message Type Filter to make your search specific to a message
type. The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new message
type.
s Click Copy to make an editable copy of an existing message type.

s Click Delete to delete a selected message type.

s Click Print to print the selected information as a PDF.

Enter the type of message in the Message Type field.

Enter the description for the message type in the Description field.

Select the English ICSR or Japan ICSR radio button, as applicable.

Click the Expedited checkbox if the message type is for an expedited report.

Click the Mark as Auto Submit checkbox if you wish to mark for auto submission.
Click the Display checkbox if you wish to display the message type.

Click Save to save the changes made.
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Configuring Reporting Destination

Regulatory reports are submitted to the Reporting Destination. Local company contact
information is also provided on this screen.

Use the following procedure to configure reporting destination:
Select Code Lists --> Argus to view the Code List Maintenance screen.

Click Reporting Destination on the left pane of the Code List screen.

Agency Information

The Agency Information tab is displayed by default, on selecting Reporting
Destination.

Field Descriptions
The fields under the Agency Information tab are described in the following table:

Field/Control Name Description

Agency Name Displays the name of the agency. This is a required field.

Agency Type Enables the user to select the agency type.

Department Enables the user to enter the name of the department.

Email Address Enables the user to enter the email address of the agency.

Preferred Method Enables the user to select the preferred method of agency
information.

Registration # Enables the user to enter the registration number.

FAX Enables the user to enter the FAX Number.

FAX Cover Enables the user to enter the FAX Cover.

Contact Type = Manufacturer - Enables the user to select manufacturer as the

type of contact

= Importer - Enables the user to select importer as the type of
contact

= Distributor - Enables the user to select distributor as the type of

contact
Offline Recipient Enables the user to configure the regulatory agency as an offline
agency.
Title Enables the user to enter the title of the regulatory contact.
First Name Enables the user to enter the first name of the regulatory contact.
Middle Enables the user to enter the middle name of the regulatory contact.
Last Enables the user to enter the last name of the regulatory contact.
Address Enables the user to enter the address of the regulatory contact.
Phone Enables the user to enter the phone number of the regulatory contact.
Ext Enables the user to enter the extension number of the regulatory
contact.
Country Code Enables the user to enter the country code of the regulatory contact.
FAX Enables the user to enter the fax number of the regulatory contact.
Ext Enables the user to enter the extension number of the regulatory
contact.
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Field/Control Name

Description

Country Code
City
State/Province
Country

Postal Code

Report per Email

Attachments

Email Text Body

Report for Marketed
Licenses

Allow WHO Drug
reporting

Report for
Investigational
Licenses

Enables the user to enter the country code of the regulatory contact.
Enables the user to enter the city of the regulatory contact.

Enables the user to enter the state/province of the regulatory contact.
Enables the user to enter the country of the regulatory contact.
Enables the user to enter the postal code of the regulatory contact.

Enables the user to enter the number of reports to be received in each
email.

Enables the user to select the format of attachments.

PDF reports generated by Argus Safety Service to be transmitted via
email have a file naming convention as follows:

= If only a single report per attachment option is selected at the
Reporting Destination, the PDF file name is as follows:

<Reg Authority Name>-<Case Number>-<Follow-u
Number>-<Seriousness(Y/N)><Unlisted(Y/N)><Causality(Y/
N)>-<Date in Argus Format>-<Time with
Seconds>.<Milliseconds>.pdf

Example:
FDA-2002USTEG001-1-YYN-03-AUG-2003-100302.750.pdf

= If multiple reports are selected per attachment in the Reporting
Destination, the PDF file name is as follows:

<Reg Authority Name>-<Date in Argus Format>-<Time with
Seconds>.<Milliseconds>.pdf

Example: FDA-03-AUG-2003-100302.750.pdf

= Select - Enables the user to select a .txt or .rtf file to be uploaded.
Note: The file should be in .txt, or .rtf format.

After the uploaded file is saved, the Edit button displays a clip
button, denoting an attachment.

= Edit - Enables the user to open the uploaded file / text in a word
document from the server and edit the text inside it. If no file
was uploaded earlier, a blank document is opened.

Note: You can save the edited document on the local machine
and click Select to save the file.

Enables the user to select whether reports are to be marketed always
or only for the Spontaneous cases or no Investigational.

Enables the user to schedule a report for WHO Drug Reporting.

Enables the user to select if the reports are to be investigational
always or only for clinical case or no marketed license.

Use the following procedure to configure agency information.

1. Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section displays
the information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an
agency. The filtering criterion is essential as it helps you to search for specific

items.
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10.

11.

12.
13.
14.
15.

16.

17.

18.
19.
20.
21.
22,
23.
24.

25.
26.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: Tip: You can alternatively click Add New to create a new
agency information.

»  Click Copy to make an editable copy of an existing agency
information.

s Click Delete to delete the selected agency information.

»  Click Print to print the selected information as a PDF.

Enter the name of the agency in the Agency Name field.
Select the type of agency in the Agency Type field.
Enter the department in the Department field.

Enter the email address in the Email field. Multiple e-mail addresses must be
separated by a comma (,), and not by a semi-colon (;). If you separate the email
addresses by a semi-colon, the transmission service will fail.

Select the preferred method from the Preferred Method drop-down list. The
options available are Fax or Email.

Enter the registration number in the Registration # field.
Enter the Fax Number in the FAX field.
Enter the Fax Cover in the FAX Cover field.

Select the preferred contact type by clicking the checkboxes available under
Contact Type.

The options available are Manufacturer, Importer and Distributor.

Select the Offline Recipient checkbox to configure the regulatory agency as an
offline agency.

Select the Title of the regulatory contact. The options available are Mr., Miss and
Mrs.

Enter the first name of the regulatory contact under the First Name field.

Enter the middle name of the regulatory contact under the Middle field.

Enter the last name of the regulatory contact under the Last field.

Enter the postal contact address of the regulatory contact under the Address field.
Enter the phone number of the regulatory contact under the Phone field.

Enter the extension number of the regulatory contact under the Ext field.

Enter the country code to be dialed in calling up the regulatory contact under the
Country Code field.

Enter the fax number of the regulatory contact under the FAX field.

Enter the fax extension number of the regulatory contact under the Ext field.
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27. Enter the country code required in faxing up the regulatory contact under the
Country Code field.

28. Enter the name of the city where the regulatory contact lives in the City field.

29. Enter the name of the state/province where the regulatory contact lives in the
State/Province field.

30. Enter the name of the country where the regulatory contact lives in the Country
field.

31. Enter the postal code of the place where the regulatory contact lives in the Postal
Code field.

32. Enter the number of reports that need to be sent in every email to the regulatory
contact in the Report per Email field.

33. Select the format of the attachments being sent with the emails through the
Attachments drop-down list.

The formats available to be sent as attachments are PDF or RTF formats.
34. Click Text or RTF to save and view a letter attachment in text or RTF format.
This enables the user to select the email body in Text or RTF format.

35. Select how the report is to be marketed from the Report to be marketed
drop-down list.

36. The options in this list are Always or Spontaneous or No Investigational.

37. Select the Allow WHO Drug Reporting checkbox to schedule the report for WHO
Drug Reporting.

38. Select the type of reports as Investigational always or Only for clinical case or No
marketed license from the Report for Investigational drop-down list.

39. Click Save to save the changes made.

Local Company Contact

This section lists the Field Descriptions and configuration steps for the Local
Company Contact tab.

Field Descriptions

The fields the following table lists and describes the fields on the Local Company
Contact tab.

Field/Control Name Description

Company Name Displays the name of the company. This is a required field
Sender Type Enables the user to select the sender type

Department Enables the user to enter the name of the department

Email Address Enables the user to enter the email address of the agency

Lab Code Enables the user to enter the lab code

Event Term on Enables the user to select the event term on expedited reports.
Expedited Reports

Title Enables the user to enter the title of the local company contact
First Name Enables the user to enter the first name of the contact
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Field/Control Name

Description

Middle

Enables the user to enter the middle name of the contact

Last Enables the user to enter the last name of the contact
Address Enables the user to enter the address of the contact

Phone Enables the user to enter the phone number of the contact
Ext Enables the user to enter the extension number of the contact
Country Code Enables the user to enter the country code of the contact
FAX Enables the user to enter the fax number of the contact

Ext Enables the user to enter the fax extension number of the contact
Country Code Enables the user to enter the fax country code of the contact
City Enables the user to enter the city of the contact
State/Province Enables the user to enter the state/province of the contact
Country Enables the user to enter the country of the contact

Postal Code Enables the user to enter the postal code of the contact

Use the following procedure to configure the local company contact.

1. Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section is
populated with information about the selected code list.

2. You can use the Reporting Destination Filter to make your search specific to a
company. The filtering criterion is essential as it helps you to search for specific
items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new company
contact.

s Click Copy to make an editable copy of an existing company
contact.

»  Click Delete to delete a selected company contact.

»  Click Print to print the selected information as a PDFE.

7. Enter the name of the company in the Company Name field.

8. Select the type of sender in the Sender Type drop-down list.

9. Enter the name of the department under the Department field.

10. Enter the email address of the agency under the Email Address field.
11. Enter the lab code of the agency under the Lab Code field.
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12.

13.

14.
15.
16.
17.
18.
19.
20.

21.
22,
23.

24.
25.

26.

27.

28.

Select the type of event term on preferred reports from the Event Term on
Preferred Reports drop-down list. The options available under this list are
Preferred and Lower Level.

Select the Title of the regulatory contact. The options available are Mr., Miss and
Mrs.

Enter the first name of the regulatory contact under the First Name field.

Enter the middle name of the regulatory contact under the Middle field.

Enter the last name of the regulatory contact under the Last field.

Enter the postal contact address of the regulatory contact under the Address field.
Enter the phone number of the regulatory contact under the Phone field.

Enter the extension number of the regulatory contact under the Ext field.

Enter the country code to be dialed in calling up the regulatory contact under the
Country Code field.

Enter the fax number of the regulatory contact under the FAX field.
Enter the fax extension number of the regulatory contact under the Ext field.

Enter the country code required in faxing up the regulatory contact under the
Country Code field.

Enter the name of the city where the regulatory contact lives in the City field.

Enter the name of the state/province where the regulatory contact lives in the
State/Province field.

Enter the name of the country where the regulatory contact lives in the Country
field.

Enter the postal code of the place where the regulatory contact lives in the Postal
Code field.

Click Save to save the changes made.

Configuring EDI

This section lists the field descriptions and configuration steps for the EDI tab.
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Use the following procedure to configure reporting destination:
1. Select Code Lists --> Argus to view the Code List Maintenance screen.

2. Select Reporting Destination on the left pane of the Code List screen. The screen
appears as shown below.

Field Descriptions
The following table lists and describes the fields on the EDI tab.
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Field/Control Name

Description

SGML/XML
Agency Identifier

Identification Code

Code Qualifier

Message Profile
Mark as Auto Submit
Auto Accept ICSR's

ACK Profile

Primary Receive
Agency

Imported Cases are
assigned to

Initial Workflow
State

XML Source
Classification

Selection Source
Classification

Transmit E2B
Attachments

Attachment
Classification

Identification Code

Company Identifier
Code Qualifier

File Name

SGML Declaration
File

Enables the user to select whether to send the report in SGML or XML
format.

Enables the user to enter the routing ID configured in Cyclone for the
sender community.

Enables the user to enter the agency Duns code, a unique identification
code that identifies the trading partner.

This field is disabled for the E2B (R3) profile.

Enables the user to enter the code qualifier here. The code qualifier is
used to interpret the identification code.

This field is disabled for the E2B (R3) profile.
Enables the user to select a message profile.
Enables the user to mark the report for auto submission.

Click this checkbox to auto accept ICSR's. This checkbox is visible only
when case numbering is set to Automatic.

Enables the user to select the acknowledgement profile.

Enables the user to select the primary receiving agency.

Enables the user to select the country, where the imported cases need to
be assigned.

Note: This list comprises the configured Argus sites. The default value
is the site of the importing user.

Enables the user to configure the initial workflow state of the case.

Note: This list comprises Argus workflow states, with the default value
being blank. If you select blank as the workflow state, it is treated as a
new case being booked-in.

The system enables the user to configure the XML Source Classification
and the PDF Source Classifications used for classifications defined
while the Source E2B File / PDF for Initial Intake or E2B Differences
report is classified.

When a case is accepted as an initial or follow-up case, the system
attaches the source XML and the Initial Selection PDF to the case on the
Additional Info tab.

Enables the user to select the source classification from the drop-down.

Click this checkbox to transmit E2B attachments. If this checkbox is
checked in the Reporting Destination Code List, case form attachments
are sent to the specified reporting destination.

Enables the user to select the attachment classification.

Enables the user to enter the company Duns code, a unique
identification code that identifies the trading partner.

Enables the user to enter the company identifier

Enables the user to enter the code qualifier here. The code qualifier is
used to interpret the identification code.

Enables the user to enter the file name

Enables the user to enter the SGML Declaration File.
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Field/Control Name Description

Maximum # of Enables the user to enter the maximum number of reports that will be
reports to includein  transmitted in one message.

the msg

Method Enables the user to select a method here. This field contains E2B ESTRI

Gateway and E2b Media values.

EDI Header Required Enables the user to generate the EDI Header

XML Version Enables the user to enter the XML Version.

URL of Message DTD Enables the user to enter the path where the message DTD resides on

the internet or enter full path if it is located on the disk.

Encoding Enables the user to select the character set encoding used in XML

URL of ACK DTD Enables the user to enter the path where the ACK DTD resides on the

internet or enter the full path if it is located on the disk.

Use the following procedure to configure EDI:

1.

10.
11.

12.
13.
14.
15.

Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section is
populated with information about the selected code list.

You may use the Reporting Destination Filter to make your search specific to an
EDI. The filtering criterion is essential as it helps you to search for specific items.

Select the appropriate Field as the filtering criteria from the drop-down list.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value
Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new EDL

»  Click Copy to make an editable copy of an existing EDL

»  Click Delete to delete a selected EDI.

»  Click Print to print the selected information as a PDF.
Select the format in which the report is to be sent by selecting the SGML and XML
radio buttons.

Click the Mark as Auto Submit checkbox if you wish to mark the report for
auto-submission.

Select the country where the imported cases need to be assigned.
Select the initial workflow state of the case.

Enter the routing ID configured in Cyclone for the sender community under the
Agency Identifier field.

Enter the Agency Duns code under the Identification Code field.
Enter the Code Qualifier under the Code Qualifier field.
Select the message profile from the Message Profile drop-down list.

Select the acknowledgement profile from the ACK Profile drop-down list.
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16.
17.
18.
19.
20.

21.
22,

23.

24.
25.
26.

27.
28.

29.
30.
31.

Enter the Agency Duns Code in the Identification Code field.
Enter the Company Identifier in the Company Identifier field.
Enter the Code Qualifier in the Code Qualifier field.

Enter the name of the file in the File Name field.

When a case is accepted as an initial or follow-up case, the system attaches the
source XML and the Initial Selection PDF to the case on the Additional Info tab.

Select the SGML file in the SGML Declaration File drop-down list.

Enter the maximum number of reports that need to be included in the message
under the Maximum # of reports to include in the msg field.

Select the method from the Method drop-down list. This list contains options like
E2B - Gateway, Physical Media and XML Transmission.

Click the EDI Header checkbox to generate an EDI Header.
Enter the version of XML in which it is coded in the XML Version field.

Enter the path where the message DTD resides on the internet or enter full path if
it is located on the disk under the URL of Message DTD field.

Select the character set encoding used in XML in the Encoding drop-down list.

Enter the path where the ACK DTD resides on the internet or enter the full path if
it is located on the disk in the URL of ACK DTD.

Click Auto Accept ICSR's to auto accept ICSR's.
Click Transmit E2B Attachments to transmit E2B attachments.

Click Save to save the changes made.

Use the following procedure to configure reporting destination.

1.

2.

Select Code Lists --> Argus to view the Code List Maintenance screen.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Select Reporting Destination. The screen appears as shown below.
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SMTP

This section lists the Field Descriptions and configuration steps for the SMTP tab.
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Field Descriptions
The following tables lists and describes the fields on the SMTP tab.
Field/Control Name Description
From Enables the user to enter the email address of the sender.
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Field/Control Name Description

CcC Enables the user to enter the email addresses to send email as CC.
BCC Enables the user to enter the email addresses to send email as BCC.
Delivery Receipt Enables the user to check this box to receive a delivery receipt.
Read Receipt Enables the user to check this box to receive a read receipt.

Use the following procedure to configure SMTP.

1. Select the Agency Name (or row) of the reporting destination displayed under
Total Number of Rows that needs to be modified. The Modify section is
populated with information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an
SMTP. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

5. Enter the search criteria in Value
6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.
Tip: You can alternatively click Add New to create a new SMTP.
s Click Copy to make an editable copy of an existing SMTP.
»  Click Delete to delete a selected SMTP.

»  Click Print to print the selected information as a PDF.

7. Enter the email address of the sender under the From field.

8. Enter the email addresses to send email as CC under the To field. Multiple e-mail
addresses must be separated by a comma (,), and not by a semi-colon (;). If you
separate the email addresses by a semi-colon, the transmission service will fail.

9. Enter the email addresses to send email as BCC under the BCC field. Multiple
e-mail addresses must be separated by a comma (,), and not by a semi-colon (;). If

you separate the email addresses by a semi-colon, the transmission service will
fail.

10. Click the Delivery Receipt checkbox to receive a delivery receipt.
11. Click the Read Receipt checkbox to receive a read receipt.
12. Click Save to save the changes made.

13. Click Save to save the changes made.

Configuring Routes of Administration

This screen enables you to configure the Route of Administration information. This
describes the route of drug administered to the patient. This data is reflected in
Expedited and Periodic regulatory reports.

s The values entered here and marked under Display appear in the in the Route of
Administration list on the Products tab.
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= Select Code Lists --> Argus to view the Code List Maintenance screen.
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Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Click on the Routes of Administration folder in the left panel. The associated data
appears in the Total Number of Rows section in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Administration

Route

Short Name

Description

E2B Code
Display

Displays information about the route of administration. It displays

information about how the drug was administered. This is a required

field.

Displays the short name of the administrator route.

Displays a description of the administrator route.

Displays the E2B Code of the administrator route.

Enables the user to display the record in the Administrator Route in the
Products screen.

Use the following procedure to configure routes of administration.

1. Click the Administration Route (or row) to view the details associated with the
administration route. The details appear in the Modify Administration Route

section.

2. You may use the Routes of Administration Filter to make your search specific to a
route. The filtering criterion is essential as it helps you to search for specific items.
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3. Select the appropriate Field as the filtering criteria from the drop-down list.
4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.
5. Enter the search criteria in Value.
6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.
Tip: You can alternatively click Add New to create a new route.
»  Click Copy to make an editable copy of an existing route.
»  Click Delete to delete a selected route.
»  Click Print to print the selected information as a PDF.
7. Enter information about the administration route in the Enter Administration
Route field.
8. Enter a short name about the administration route in the Short Name field.
9. Enter the E2B Code of the administration route in the E2B field.
10. Select the Display checkbox to display the record in the Add field in the Products
screen.
11. Enter the description about the administration route in the Enter Description
field.
12. Click Save to save the changes made.
Configuring Study Center

This screen enables you to configure the Study Center information. This screen is used
to enter information regarding each Study Center. The Study Centers defined in this
dialog appear on a drop-down list in the Clinical Studies Information dialog under
the Centers tab in List Maintenance. You can create a Study Center with the same
Center ID but with a different name and address. When you select the studies in the
Study Look and Center Lookup in the Console, the system concatenates the Center
Name (Center ID) in the look-up dialog.

Investigators for each Center can also be added via this dialog.
Select Code Lists --> Argus to view the Code List Maintenance screen.

Click on the Study Center folder in the left panel. The associated data appears in
the Total Number of Rows section in the right panel.
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Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions
The following table lists and describes the fields associated with this section.

Field/Control Name Description

Center ID Enables the user to enter the Center ID.
Name Enables the user to enter the name of the center.
Address Enables the user to enter the address of the center.

Copy from Reporters Enables the user to copy the information from Reporters.

# Displays the row count of the number of investigators.
Investigator Enables the user to enter the name of the investigator.

Phone Enables the user to enter the phone number of the investigator.
Fax Enables the user to enter the fax number of the investigator.
Notes Enables the user to enter comments or remarks.

Use the following procedure to configure study center.

1. Click the Center ID (or row) to view the details associated with the administration
route. The details appear in the Modify Study Center section.

2. You may use the Study Center Filter to make your search specific to a center. The
filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.
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10.
11.

12.
13.
14.
15.

Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

Enter the search criteria in Value.

Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new center.
s Click Copy to make an editable copy of an existing center.
»  Click Delete to delete a selected center.

»  Click Print to print the selected information as a PDF.

Enter the ID of the center in the Center ID field.

Enter the name of the center in the Name field.

Enter the address of the center in the Address field.

Select the Copy from Reporters checkbox to copy the information from Reporters.

Enter the name of the investigator in the Investigators field.

Tip: Tip: Click Add to add a new investigator. Click Delete to delete
a selected investigator record.

Enter the phone number of the investigator in the Phone field.

Enter the fax number of the investigator in the Fax field.

Enter comments, if any, under the Notes field.

Click Save.

Configuring Holiday Calendar

This screen enables you to configure the Holiday Calendar information. The Code List
allows the user to define holidays at country level.
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The Country of Reporting Destination will be matched with the Country in the
Holiday Calendar to identify the holidays to be adjusted for the Reporting Destination.

Go to Code Lists > Argus to view the Code Lists page and click the Holiday Calendar
folder in the left panel.

The associated report appears in the Total Number of Rows section in the right panel.

Tip: The code list items are displayed in the left-panel. Click on the
required Code List folder to be configured. The details of this code list
item appear in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Field/Control Name Description

Holiday Name This field displays the unique name for the holiday name.

Date This field displays the date on which the holiday has been
scheduled.

Description This field displays a description of the holiday.

Country This field displays the name of the country (or countries) with

which the holiday is associated.

Use the following procedure to configure study center.

1. Click the Holiday Name (or row) to view the details associated with that Holiday
Calendar. The details appear in the Modify Holiday Calendar section.

2. You may use the Holiday Calendar Filter to make your search specific to a
Holiday Calendar record. The filtering criterion is essential as it helps you to
search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.
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4. Once you have selected the Field, you can specify whether your search should
contain or start with specific alphabets.

5. Enter the search criteria in Value.

6. Click Filter to apply the selected criteria. This displays the search results under
Total Number of Rows.

Tip: You can alternatively click Add New to create a new Holiday
Calendar record.

»  Click Copy to make an editable copy of an existing Holiday
Calendar record.

»  Click Delete to delete an existing Holiday Calendar record.

7. Enter the Holiday Name for the Holiday Calendar.

8. Enter the Date for the record.

9. Enter the Country (or countries) with which the holiday must be associated.
10. Enter the Description for the Holiday Calendar record.

11. Click Save.

Other Code List Items
The following table lists and describes additional code list items that you should be
aware of.
Code List ltem Description

Accidental Exposure  Enables you to capture Accidental Exposure information.
Accidental Exposure is in the Dosage regimen section of the
Products tab as a drop-down list.

Action Taken Enables you to capture Action Taken information. Action Taken
information is required to capture information about steps taken
when an adverse drug event occurs. The values that you enter in
this field are read-only, and appear in the Dosage Regimen section
on the Action Taken drop-down in Case Form > Products tab.

Action Type Enables you to capture Action Type information that describes the
action type required for the case. Values entered in this field are
read-only, and appear in the Code/Description list of the Activities
tab.

Go to Code List Maintenance > Code List > Argus and click Action
Type in the browser tree.

Age Group Enables you to capture Age Group information. An Age Group is
the range of lower and upper age limits. Patients are categorized in
different age groups. This data appears in Expedited and Periodic
regulatory reports. The values that you enter in this field appear on
the Patient Information Screen, and in the Age Group drop-down
list.

Age Unit Enables you to capture Age Unit information. An Age Unit displays
time in periods such as Year, Month, Day, Hours, etc. This data
appears in the Expedited and Periodic regulatory reports. It also
appears in the Age Unit drop-down and Gestation Period unit
drop-down fields on the Patient Information screen, as per the
settings made to the Age unit and Gestation Period unit flags in
the Age unit codelist.
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Code List Iltem

Description

Anatomical Location

Attachment
Classifications

Attachment
Keywords

Birth Type

Case Classifications

Causality Category

Clinical Reference
Type

Condition Type

Contact Type

Enables you to capture information about the location where
vaccinations are given. This data appears in the expedited and
periodic regulatory reports. The values that you enter in these fields
appear on the Anatomical Location drop-down list on the Vaccine
screen.

Enables you to capture the attachment classification that is used to
describe attachment types. The values that you enter in these fields
appear in the Attachment Classification section on the Additional
Information screen. Attachment Classification that are marked as
'E2B Additional Doc' can be configured to be sent as attachments
while transmitting E2B (R2) and E2B (R3) reports.

Enables you to capture information about the attachment keywords
that are used to define an attachment type. The values appear in the
Attachment Keywords section on the Additional Information
screen.

Enables you to capture birth type information when capturing
pregnancy information. This data appears in multiple regulatory
reports and in the Birth Type drop-down list on the Pregnancy
information screen.

Enables you to capture Case Classification to help categorize cases.
This information does not impact any report or screen, but is used
during case searches to narrow the results set.

Enables you to capture information about the causality type. This
data appears in expedited and periodic regulatory reports and on
the Event Causality drop-down list in the Event Assessment section
on the Event screen.

Enables you to capture information about the clinical reference
type. The Clinical Reference Type appears as a drop-down list in
Study Configuration.

Enables you to capture information about the condition of the
patient such as historical condition, current condition, historical
drug, illness at the time of vaccinetion etc,. This data appears in
expedited and periodic regulatory reports and in the Condition
Type drop-down list on the Other Relevant History screen.

Enables you to capture information about the type of contact (such
as Follow-up, Investigator). The values appear in the Contact Type
drop-down list in the Contact Log section of the Activity Tab.
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Code List ltem

Description

Countries

Date Ranges

Delivery Types

Device Preliminary
Comments

Device
Subcomponents

Enables you to capture information about the country where the
adverse event occurred. If you enter A2, A3, or the numeric country
code, the system automatically populates the Country field with the
name of the country.

You can also check a checkbox called ‘Group 2 Country” (unchecked
by default) to enable administrators to add a Group 2 Country. This
is required when the Due Date for expedited reports differ from
country to country, as per their regulations.

For Group 1 countries, the Due Date is based on the Aware Date
received globally for the case. For Group 2 countries, the Due Date
is based on the aware date when the affiliate or a company
representative of that country received information about the case.
Obtain the country name and country codes from the ISO 3166
country code specification.

You may receive the following error messages:

= "A duplicate country name already exists! " -- The country
name you entered already exists in the system.

= "Aduplicate A2 code already exists!" -- The A2 code you
entered already exists in the system.

= "Aduplicate A3 code already exists!" -- The A3 code you
entered already exists in the system.

= "A duplicate country number exists!" -- The country number
you entered already exists in the system.

= "Please enter a valid code (A2)." -- The two-character code is
not specified.

= '"Please enter a valid code (A3)." -- The three-character code is
not specified.

Enables you to capture date range information as follows:

= Description -- Enables you to enter a description of the date
range.

= Duration -- Enables you to specify the exact duration as
opposed to a range of dates. Must be used in conjunction with
Amount and Units. When you select "Duration," the system
disables the "Range" radio button.

= Amount -- The numeric value that specifies the length of the
time period when combined with a value selected from the
Units drop-down list (such as days, weeks, months, years, etc.)

= Units -- The unit of the duration (such as days, months, years)

= Range -- Enables you to select a specific range of dates. Must be
used in conjunction with the Start and End fields. When you
select "Range," the system disables the "Duration" radio button.

= Start -- The initial date of the date range.
= End -- The last date of the date range.

Enables you to capture information about the type of delivery that
occurred during pregnancy. This data appears in expedited and
periodic regulatory reports and on the Delivery Types drop-down
list on the Pregnancy Information screen.

Enables you to capture comments about medical devices. Device
Preliminary Comments appear on the Product screen when the user
selects the Device option.

Enables you to capture information about subcomponents that are
part of a medical device. This information appears on the Product
screen when the user selects the Device option.
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Code List ltem Description

Causality Source Enables you to capture Causality Source information. It appears on
the Case Form Event Assessment tab.The E2B report uses this
information to determine the drug assessment method.

Device Type Enables you to capture information about patient device types. This
data appears in expedited and periodic regulatory reports.

Dosage Frequency Enables you to capture information about how often medication is
given (such as daily, bid, weekly, etc.) This information appears on
the frequency drop-down list on the Products screen.

= Frequency -- Enables the user to specify how often the dose is
given.

= Number of doses per day -- Enables the user to specify the
number of doses administered each day.

= Number of separate dosage -- Enables the user to define the
dosage verbatim.

s Number of units in the interval -- Enables the user to define the
dosage verbatim.

= Definition of Interval -- The length of time between doses such
as year, month, day, week (default), hour, minute.

Dosage Unit Enables you to capture dosage units information. This information
is required when capturing the quantity of drug on sale and also
appears in expedited and periodic reports.

= Unit Name -- The name of the dosage unit.
= E2B Code -- The E2B code associated with the Dosage Unit.

= Dosage Unit -- When checked, it indicates that the current item
is the dosage unit.

s Lab Test Unit -- When checked, it indicates that this is a lab test
unit.

= Display -- When checked, it indicates that the Unit Name is
displayed in the application.

Dose Units This codelist is used to maintain the units of measures used in
Dose.
Ethnicity Enables you to capture information about the ethnic groups/Race

information of the patients. This information appears in periodic
regulatory reports and eVAERS reports and on the Race
drop-down list on the Patient Information screen.

Evaluation Reason Enables you to capture information about why the product is being
evaluated. This information appears in the Evaluation Reason list
on the Case Form > Products tab.

Event Frequency Enables you to capture information about the frequency of the
event. It includes categories such as intermittent, continuous, and
single episode. The values entered in this field appear in the Event
Frequency drop-down list on the Event Information screen.

Event Intensity Enables you to capture information about the intensity of the
adverse event and includes categories such as mild, moderate, and
severe. The values that you enter on this screen appear on the Event
Intensity drop-down list on the Event Information screen.

Event Outcome Enables you to capture event outcome information such as Fatal,
Abortion due to AE/Infection, and Recovered. This data appears in
expedited and periodic regulatory reports and on the Event
Outcome drop-down list on the Event Information screen.
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Code List ltem

Description

Fetal Outcome

Formulation

Gender

Ingredients

Intermediary

Interval Units

Justifications

Lab Assessment
Terms

Lab Test Type

Lab Test Units
Languages
Literary Citations
Local Evaluation
Comment Type

Location

Manufacturer

Enables you to capture information about fetal outcome and
includes information such as abnormal development or pre-natal
complications. This data appears in expedited and periodic
regulatory reports. The values entered here appear on the Fetal
Outcomes drop-down list on the Pregnancy Information screen.

Enables you to capture information about the formulations (cream,
drop, capsule, etc.) available for a product. The values that you
enter here, appear on the Formulation drop-down list on the
Product screen.

Enables you to capture gender information. This information
appears in expedited and periodic regulatory reports.

Enables you to capture information about the ingredients in the

product. This includes the ingredient, the concentration, and the
units of ingredients used to make the product. This information

appears in expedited and periodic regulatory reports.

Enables you to capture information about intermediaries such as
sales representative, licensee, regulatory authority or local affiliate.
The values that you enter here, appear on the Intermediary
drop-down list on the Reporters screen.

This codelist is used to maintain the interval units that are used as
units for Age, Duration, etc.

Enables you to capture justification information. You can enter
reasons for overriding system determinations in the Justifications
dialog box. The values that you enter here, appear in the Action
Justification dialog.

Enables you to capture the lab result assessment terms that define
the terms that describe the patient’s results on various lab tests
(such as elevated, depressed, etc). This data is reflected in expedited
and periodic regulatory reports. The values that you enter here,
appear on the Lab Result Assessment Terms drop-down list on the
Laboratory Data screen.

Enables you to capture the lab test type. This defines test type and
whether it has normal, high, or low values. It can be coded as
defined in the MedDRA dictionary. The values that you enter here,
appear on the Lab Test drop-down on the Patient screen.

This codelist is used to maintain the units of measures used in Lab
test.

This codelist is used to maintain the ISO codes of the languages in
which text data entry can be made.

Enables you to enter information about literary citations.

Enables you to capture the category of a local comment such as
French, German, English, etc. The values that you enter here,
appear in the Analysis, Local Comment type.

This codelist is used to maintain the Anatomical locations in which
Vaccines are administered.

Enables you to capture information about the product
manufacturer.

Manufacturer is required while capturing, adding, or modifying
information on manufacturer sites. This data appears in expedited
and periodic regulatory reports and on the Manufacturer
drop-down list on the Product Configuration screen.
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Code List Iltem

Description

Medical Status

Message Type
Nature of Event

Occupations

Package Units

Product Group

Project ID

Purchased With

Reference Types

Relation

Report Media

Report Types

Reporter Type

Reporting
Destination Type

Enables you to capture medical information about patient status.
This data appears in both the expedited and periodic regulatory
reports. The values that you enter here appear on the Medical
Status drop-down list.

Enables you to enter information about each E2B message type. The
system uses the defined message types when it creates an E2B file.

Enables you to capture information about the type of adverse event
that occurred.

Enables you to capture information about patient and reporter
occupations such as physician, regulatory agent, and journalist.
This data appears in both expedited and periodic regulatory
reports. The values that you enter here, are marked as ICH
Occupation, and appear in the Reporter’s Occupation drop-down
list on the General Screen.

Enables you to capture information about product packaging. The
package units define the number of units in a package.

Enables you to capture information about a specific Product Group.
Users can use the Product group field to categorize Product
Families based on therapeutic area. The values that you enter here
appear in the drop-down list associated with the Project Group
field of the Product Family.

Enables you to capture project ID information used to group similar
studies under a single project. The values that you enter in this field
appear on the Project ID field drop-down on the Study
Configuration.

This code list is used to maintain the Funds from which Vaccine
was purchased.

Enables you to capture reference type information and defines a list
a reference types such as Parent-Child Link, Patient ID, etc. The
values that you enter here, appear in the Type drop-down in the
References section on the Additional Information tab.

This codelist is used to maintain the Reporter relation to the Patient.

Enables you to capture Report Media information. The values that
you enter appear on a drop-down field in the Reporter Information
section.

Enables you to capture information about report types. The report
type describes the type of report and the abbreviation associated
with the specific type. This data appears in expedited and periodic
regulatory reports. The values that you enter here, appear on the
Report Type drop-down list on the General Screen.

The Report Type code list also controls the PBRER 6.2 and 6.3 list
sections under the Summary tab of the ICH PSUR Periodic Report
configuration.

Section 6.2, The Identify Study Cases using Report Type section
considers all the Report Types that have the CASE_TYPE = C and
REPTYPECODE <> M while Section 6.3 displays all report types
that are CASE_TYPE = S.

Enables you to capture information about the person reporting the
adverse event and includes categories such as lawyer, nurse, doctor,
etc. The values that you enter here, appear on the Reporter Type
drop-down list on the Product screen.

Enables you to capture information about the reporting destination.
The values that you enter here, appear on the Reporting
Destination configuration.
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Code List ltem

Description

Routes of
Administration

Study Center

Vaccinated At

Enables you to capture information about how a drug is
administered to a patient such as by shot, by mouth, etc.

Enables you to capture information about the study centers. Values
entered here appear on a drop-down in the Clinical Studies
Information dialog and on the Centers tab in List Maintenances.
You can also add investigators for each center.

You can create a study center with the same center ID but with a
different name and address.

This code list is used to maintain the Vaccination Facility Type
information.

Formulation Factory Data
The following table provides information about the Formulation Factory Data:

Formulation

Formulation

ID Formulation Formulation Name Symbol
38 Aerosol (Spray and Inhalation)  Aerosols AER
13 Alternative Form
23 Cachet (including wafer) Cachet CTS
2 Capsule Capsules CAP
24 Chewable Tablet Chewing Tablet CTB
25 Drop Drops DRO
32 Dusting Powder Dusting Powders DPO
39 Ear Drops Ear Drops EDR
8 Effervescent Tablet
47 Enema Enemas ENM
21 Enteric Table Enteric-coated dosage =~ ENT
forms
49 External Use
12 Extra Formulation External Preparations ~ EXT
of Uncertain Dosage
Form
40 Eye Drops Eye Drops EED
41 Eye Ointment Eye Ointments EOI
20 Grain Granules GRA
18 Granule Fine Granules FGR
46 Implantation Inserting Preparations  IMP
43 Inhalation Gas Gas Inhalant INS
6 Infusion Infusing Preparations ~ INF
9 Inhaler Inhalants INH
5 Injection Injections INJ
48 Jelly Jellies JEL
11 Liquid External Liquids LIQ
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Formulation Formulation
ID Formulation Formulation Name Symbol
33 Lotion (except lotion for eye) Lotions LOT
28 Lozenge (troche and candy too) Lozenges LOZ
45 Mouthwash Throat Washings MWH
17 N/A
42 Nasal Drops/Spray Nose Drops NDF
34 Ointment/Cream Ointments/Creams OIT
31 Oral Drug Unspecified Form Oral Preparations of POR
Uncertain Dosage Form
4 Patch
26 Pill (except tablets) Pills PIL
19 Powder (except DPO) Powders POW
35 Shampoo Shampoos SHP
22 Slow Release Capsules Slow-release Capsules  SRC
30 Slow Release Granule Slow-release Granules  SRG
29 Slow Release Tablet Slow-release Tablets SRT
27 Solution (except Syrup) Solutions for Oral Use ~ SOL
44 Spin Cap Spin Cap SpPC
36 Spray (except Inhalation) Sprays SPR
3 Suppository Rectal Suppositories SUP
7 Syrup Syrups SYR
1 Tablet Tablets TAB
37 Tape (including Poultice) Tapes TAP
16 Unknown Uncertain XXX

Configuring Code Lists > Flexible Data Re-Categorization

The Flexible data re-categorization feature allows Argus Safety and its associated
applications such as Argus Mart and Argus Insight to handle the code list values in a
much more flexible manner, as compared to the previously existing Argus Safety Code
List database design.

Working with Flexible Data Re-Categorization

The Flexible Data Re-Categorization feature allows applications and customers to store
and maintain all types of code list values in a single flat database table structure which
shall be easier to maintain. This code list data storage design can be leveraged to easily
add new and custom code lists or values by applications as well as customers without
adding new database tables and columns. This database structure was added in
previous release of Argus Safety.

Argus Console provides a user interface that displays values for different code list
languages for the flexible data re-categorization code list feature. This user interface
helps add and remove custom languages for an existing code list, present in the
flexible data re-categorization code list tables and also the flexibility of adding new
code list items through this User Interface (UI).

Code List Configuration 5-44



Configuring Code Lists > Flexible Data Re-Categorization

However, this Ul does not allow users to perform any modification for the languages
which are maintained via the Console Code List feature. Any changes done to the
values through this user interface are audit logged.

The Flexible Data Re-Categorization feature allows administrators to manage and
display the existing and new code list items.

Flexible Code Lists

To access Flexible Data Re-Categorization:
1. Go to Argus Console > Code Lists > Argus > Flexible Data Re-Categorization.

The following screen is displayed:
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The following table describes the fields associated with this section:

Field Name Description

Code List Name This is the unique name of code list which can be used in the
application and reporting for fetching the values of a code lists.
This is mostly derived from the source Argus Safety code list
names. However, it can be different in some scenarios as per the
customer need.

Code List Description This is the description of code list which can be used to define the
purpose of this code list.

Source Argus: All the code lists which are part of Argus Safety factory
configuration and can be edited using standard Argus console
code list UI show the source as 'Argus'.

Custom: Any code lists added as part of factory data which cannot
be modified from Argus console standard code list UI are
considered as custom.

Any code list added by customers has source as 'Custom'.

2. This page is used to add the new code list items in Argus Safety and view the
existing Argus code lists.

Click Add New to add a new flexible code list item.
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To make any changes, users can select a code list, modify values in the given text
boxes, and save those changes for modification.

Click Delete to delete an existing flexible list item.
Click Copy to copy an existing flexible list item.

3. Click Save to save the new or existing flexible code list item information.

Flexible Re-Categorization
To access Flexible Re-Categorization:

1. Go to Argus Console > Code Lists > Argus > Flexible Re-Categorization.

The following screen is displayed:
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The following table describes the fields associated with this section.

Field Name Description

Code List Name This is a drop-down list that displays all the available flexible code
lists for selection.
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Field Name

Description

Attribute Name

Code List Display
Value

Add Attribute
Remove Attribute

Attribute Name

Code

<All Language
Attributes>

Right-click > Make
Primary

Right-click > Make
Preferred

This is the language Decode context for selected code list which
can have language code and other properties of code lists.

The following are possible values for this field for the factory data
rows which will be populated based on the current code list
factory data. Customer can add more language/type values for
the new code list items that they create from flexible
re-categorization screen, based on their usage:

i. en: English display value for a code list item
ii. jp: Japanese display value for a code list item
iii. E2B: E2B code value for this code list item
iv. RPT: Display value for Reports
v. ISOA2: A2 country code for the country code list items
vi. ISOA3: A3 country code for the country code list items
vii. EN_ABBRV: This is used for defining abbreviation values.

viii. SM: This decode context is used by Argus Mart while
populating data into the SM tables.

ix. UCUM_CODE: UCUM code value for this code list item. This
is used in E2B (R3) and eVAERS reports.

x. E2B_R3: E2B (R3) value for this code list item. This is used in
E2B (R3) and eVAERS reports.

xi. VAERS_CODE: VAERS Code value for this code list item. This
is used in eVAERS and VAERS report mapping.

xii. NCI_CODE: NCI code value for this code list item. This is
used in eVAERS reports.

This the re-categorized display value for the code. This display
value shall be based on a code list, code, and language
combination.

Enables you to add a language attribute.
Enables you to remove a language attribute.

This is the language Decode context for selected code list which
can have language code and other properties of code lists.

This is the first column in the gird for all flexible code lists. This
column displays the internal id for the existing 'Code' list value.
For custom code list, the application always populates the code
columns with system generated unique sequence value for the
selected code list. It is possible for customers to provide a custom
'Code' value for any of the new rows. This value is always unique
for a code list.

All the language attributes are displayed as a new column in the
grid with Primary attribute being the first one after the Code
column.

Allows you to make the selected language attribute as the primary
attribute. The primary attribute column is moved as the first
attribute in the grid after the 'Code’' column. This configuration is
available every time the user opens the same flexible code list.

Allows you to mark the selected cell values corresponding to
selected language attribute as Preferred in the database. Preferred
values are displayed with an asterisk (*) in the grid for easy
identification. At any given time, only one value can be marked as
preferred within matching values for a language attribute.
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Field Name Description

Export to Excel Enables you to export all the values of selected code list into an
excel file.

Batch Attribute A collapsible interface, this option displays the list of all attributes

Update available for the selected code list in Flexible re-categorization

screen. It also provides a text box called Code List Value, where
users can enter the required display value of the code list for the
selected attribute.

6.

This page is used to to view existing code list and to add or remove attributes in
those code lists.

Click Add New to add a new entry into the custom code lists.
Click Copy to copy a pre-existing flexible code list entry to a new entry.

Click Edit. The grid cells of corresponding row become editable for all the
attributes added in that code list by the user.

On clicking Edit, a green tick mark is displayed, along with a red colored, cross
icon.

Click the green tick mark to temporarily save the grid values (until saved into
database by clicking Save button). The selected row comes out of Edit mode.

Click the red colored cross icon to discard any changes made to the selected row.
The selected row comes out of Edit mode.

On changing the value of a preferred cell, its preferred status is removed upon
saving the grid values.

Click Delete to allow the users to delete an entry from the flexible code lists. The
Delete icon is enabled for only custom code lists, for which protected flag is set to
0in CODE_LIST_CODE_ATTRIBUTES table. Click this icon to delete all the
attribute values corresponding to the selected row from the database.

The Display checkbox is checked by default (except for hidden entries), for a new
row added into the flexible code list.

Click Save to save all the changes made on flexible code list screen.

The following Code Lists are used/provided for BIP Aggregate Reports:

1.

REPORT_TEMPLATE: This code list is used for managing various BIP report
templates available in the system (OOB + Custom) and assign an Argus periodic
configuration (ICH PSUR or CTPR) using which user want to execute this report
template. Whenever a new report template is added in BIP, this code list should be
modified for providing report template name, its path and corresponding Argus
configuration.

ADHOC_LINE_LISTING: All the LISTNAME added in adhoc_line_listing code
list are available in the UD Summaries tab of periodic reports configuration for
attaching the memorized reports to a particular line listing section of periodic
report. User can renames these using flexible re-categorization user interface.
System provides four adhoc line listings by default which can be increased using
this code list if you have more adhoc line listing sections in your report. Once
configured, use Argus Ul for attaching the UD summaries with line listings of
your custom report.

SOC_DISPLAY_ORDER: Use this code list to reorder the printing of SOC in
various tabulations.
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AGGREGATE_REPORT_FORMAT: Use this code list to define the report formats
which you want to use with BIP reports execution. Make sure to use only those
formats which are supported by BI Publisher.

DOSAGE_STRING_FORMAT: This code list can used to restrict/add the dosage
string formats which should be available while BIP report execution. More dosage
string formats can be added with the help of custom code. The following dosage
string formats are provided out of box which print values for dosage string as
mentioned in the EN attribute.

Code EN

Do Dose

DoFo Dose, Formulation

DoFoFr Dose, Formulation, Frequency
DoFoFrRt Dose, Formulation, Frequency, Route
DoFoRt Dose, Formulation, Route

DoFr Dose, Frequency

DoRt Dose, Route

UNIQUE_PATIENT_ID_FORMAT: This code list is used to restrict/add the dosage
string formats which should be available while BIP report execution. More dosage
string formats can be added with the help of custom code. The following dosage
string formats are provided out of box which print values for dosage string as
mentioned in the EN attribute.

Code EN

CePt Center, Patient

InPt Investigator, Patient

Pt Patient

StCelnPt Study, Center, Investigator, Patient

StCePt Study, Center, Patient

StCnCelnPt Study, Country Name, Center, Investigator, Patient
StCnCePt Study, Country Name, Center, Patient

StCoCelnPt Study, Country ISO Code, Center, Investigator, Patient
StCoCePt Study, Country ISO Code, Center, Patient

StInPt Study, Investigator, Patient

LABELING_ALGORITHM: Use this code list to define new labeling algorithm
with the help of custom code. Please see labeling algorithms for more information
on out of the box algorithms.

EventSeriousness: A new code list for EVENTSERIOUSNESS is provided as part
of factory data. This code list is used for printing the actual value of seriousness
defined against a serious event.

ORGAN_IMPAIRED_HLT: This code list is added for defining the high level terms
which needs to be scanned through to find out if event reported falls under organ
impairment section or not. This can be used in custom reports.
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10. BIP_DFLT_VALUES: This code list used for configuring the default values for
some of the important fields which are used in various grouping and tabulations.
For example, how to handle/print an event without and SOC. Value configured in
this code list corresponding to SOC will be used in PBRER/DSUR tabulation for
events with undefined SOC.

The following Code Lists are used in reports, such as E2B(R3), eVAERS, VAERS

reports:

Code List

Description

VACCINATED_AT

ETHNICITY
PURCHASED_WITH

RELATION
LOCATION

INTERVAL_UNITS

LAB_TEST_UNITS

DOSE_UNITS

LANGUAGES

This code list is used to maintain the Vaccination Facility Type
information.

This code list is used to maintain the Race information.

This code list is used to maintain the Funds from which Vaccine
was purchased.

This codelist is used to maintain the Reporter relation to Patient.

This codelist is used to maintain the Anatomical locations in
which Vaccines are administered.

This codelist is used to maintain the interval units that are used as
units for Age, Duration etc.

This codelist is used to maintain the units of measures used in
Lab test.

This codelist is used to maintain the units of measures used in
Dose.

This codelist is used to maintain the ISO codes of the languages in
which text data entry can be made.
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Accessing Tools

This section explains the report (features and purpose) generated when Tools->E2B
Length Check is accessed.

| codelists | Business Configwation | Access Management | System Contigusation Tosls
E2B Lergh Chack

When Argus Code List item length is greater than the E2B field length, the data is
truncated when maximum length is entered and an E2b report is generated.

Report Features

Each profile is printed on a new page of the same report. The report prints the
Code-List items length check and the error messages warnings. The report prints all
terms that are not encoded.

The report contains the following fields as illustrated:

i BCRLICSR VT 1 MESSAGE TEMPLATE
BCHEICSR W2 1 MESSAGE TEMPLATE - EMEA

L] ICHLICSR VT 1 MESSAGE TEMPLATE - FiDd

DT Ebnmal Came Form Fickd Actsal Firor Messags Prolien LM Dats

Viewing the E2B Length Check Report
This section enables you to view the E2B Length Check Report.

Use the following procedure to view the E2B length report.
1. Select Tools->E2B Length Check.

| codelists | Business Configwation | Access Management | System Contigur ation Tosls
E25 Lerigh Chsck
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2. The E2B Length Check PDF report opens in a separate window.
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Tip: This report compares the lengths of the code list elements with
the maximum E2B length allowed for each of the DTD profiles (ICH,
FDA, EMA).

It also displays the elements where the length of the code-list element
is greater than the allowed E2B length.
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Using Advanced Conditions

This section discusses how to create and use Advanced Conditions. If you do not have
access to the advanced conditions on certain screens, the system displays only the
Advanced Condition Names you can access (instead of displaying a blank) and does
not permit you to modify or view the advanced condition details. The system displays
a warning message stating that you do not have permissions to update the advanced
conditions. The following screens are affected by this change:

= Expedited Reporting Rules

= Auto Signals

= Batch Reports

s Letters

= Studies

n  Case Priority

= Field Validation

= Narrative Templates

= Profile Switches | Auto Archiving

This option is available from the Advanced Conditions icon.

Argus Safety provides a powerful search tool that enables complex queries to be built
in order to retrieve data from the system. Detailed knowledge of the database schema
is not required.

Complex or non-standard queries are constructed by means of the Advanced
Conditions dialog, that enable users to define field level search criteria.

Sets of search criteria (advanced conditions) can be saved and retrieved from the
Advanced Conditions dialog. These conditions may then be added, edited, or deleted.

Access rights and permissions can be assigned to individual advanced conditions. You
can execute and modify rights to one or more groups on a per-advanced condition
basis.
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Features within Advanced Conditions

By default, the Advanced Conditions drop-down list enables you to view only the
New, None and already selected Advanced Conditions.

1. Select New or None from the drop-down list and click the AC button to create a
new advanced condition.

2. Click the lookup icon to filter for existing advanced conditions.

3. Execute the steps below to filter for existing Advanced Conditions:

4. Click Lookup in the Case Search Criteria section. The Advanced Conditions

Lookup dialog is displayed.
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Select one of the following options from the drop-down list under Filter.

= Contains - Enables you to filter for advanced conditions that contain the
entered criteria.

= Starts With - Enables you to filter for all advanced conditions that start with
the entered criteria.

6. Enter the search criteria for the advanced conditions in the text box, as applicable.
7. Click Filter.
The advanced conditions matching the specified filtering criteria are displayed.
8. Select an advanced condition from the list, as per your search requirements.
9. Execute any of the actions below, as applicable:

s Click OK. The selected advanced condition is listed in the Advanced
Condition drop-down list.

»  Click AC. The details of the selected advanced condition are displayed in the
Advanced Conditions dialog.
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s Click Cancel. The Advanced Condition Lookup dialog is closed without
saving any changes.

»  Select a previously selected advanced condition from the drop-down list to
apply the search criteria for that condition.

Using Advanced Conditions

Use the following procedure when using advanced conditions.

1. Click the Select lookup to view/edit/create the Advanced Condition in the
Advanced Condition dialog.

2. IMPORTANT!!: Only trusted users should be given access to the Advanced
Condition, as users with this access will have complete access to the information in
the Argus schema.

3. To use advanced conditions, the following options are available, depending on
how the set of criteria is to be used:

= To use a set of previously saved criteria, select the appropriate set of criteria from
the Advanced Condition list

s To add a new condition to a set of criteria, select the set of criteria from the
Advanced list and click the adjoining Advanced Condition icon.

= To enable the creation of new advanced conditions by associating logical operators
(like AND, OR) with items from the Case Form, refer to Creating Advanced
Conditions.

s To create an advanced condition query set from existing advanced condition
search criteria, refer to Creating a Query Set of Advanced Conditions.

Creating Advanced Conditions

Use the following procedure to create advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced
Conditions icon

2. This displays a confirmation dialog.

f Doy s il By b n chvanced conailion queny sel7

| VaE Mo | Cancel |

3. Select whether you wish to create a query set by using previous advanced
condition query sets or by creating one through logical operators.

s Click Yes to create a new advanced condition query set.

s Click No to create a new advanced condition by associating logical operators
(like AND, OR) with items from the Case Form.

4. If you select No, an Advanced Condition Set dialog is displayed.
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Note: The Advanced Condition Set dialog enables you to search for those
entities under the Properties tree-list, which are from either the case data or
from the code list. For this, the dialog provides two radio buttons - From
Code List and From Case Data.

= Select the relevant entity and one of the radio buttons, as applicable.

»  This searches the entity based from the code list or case data, as
specified.

s The radio buttons are displayed only if the selected entity belongs to a
code list.

s If the selected entity is part of the code list, and the user selects:

= From Code List - If this option is selected, the
Value drop-down list displays the list of all values
configured in the Code List.

= From Case Data - If this option is selected, the
Value drop-down list displays the list of only
those values, which are actually present in the
cases.

5. Select a property type from the Properties tree list.

The items available under the folders in the Properties list represent those fields on
the Case Form that can be used to perform the search in the advanced conditions.
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10.
11.

12.

Note: When a Property for which terms can be encoded is selected, the
Select button is enabled. You can use the MedDRA Browser to select
(possibly) multiple terms for the property.

An SMQ icon is enabled when the SMQ-related properties are selected
from the Properties tree-list. Click this icon to view the SMQ Info dialog.
The SMQ Info dialog contains details about the selected SMQ.

In the Conditions list, select a condition that must apply to the item selected
above.

"non "non "non "non

The available conditions are "equal to", "contains", "less than", "greater than", "not
equal to", "missing", "greater than or equal to", "less than or equal to", "exists",
"does not contain" or "begins with".

Under Value, enter the value which will apply to the property, or select an
appropriate value from the list, as applicable.

If the condition created in steps 4 through 6 above is to be linked with another
condition, select the appropriate logical operator in the list adjoining Value.

Tip: The logical operators that can be used to link the existing
condition to a new condition are AND/OR.
Click Add to add the newly created condition to the advanced condition.
Repeat steps 3 through 7 to add more conditions to the advanced condition.

When each of the required conditions for the advanced condition is entered, click
Save.

Enter a name for the advanced condition and click OK.
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Note: To enable other users to use the advanced condition, the Share with
other users check box should be selected. More about sharing advanced
conditions

s If an Advanced Condition is not shared with other users, it does not
appear in the Advanced Condition list for any user except the
Administrator and the user that created it.

s If the Advanced Condition is shared, all users can view the advanced
condition, but they cannot modify it.

s Not allowed if the Advanced Condition is in use
in the system.

= The Console manages access to the Advanced
Condition Library screen.

s The Advanced Condition Library option has been
added to enable or disable (default) access to the
following screen:

Access Management --> Argus --> Groups> Menus> Utilities (subarea)
section

IMPORTANT!! Customers should cleanup the aggregate case series data
(such as cfg_adv_cond_hitlist and related tables) from the Advanced
Condition Library which are no longer used or are not likely to be required
in future.

With each periodic execution, the number of aggregate case series can keep
growing in the system and it is up to the customers to manage these case
series either by deleting them manually or by deploying an Oracle job.

Tip: To enter a customized date range, select Custom Date Range
from the list. Enter an appropriate date range in the custom date range
dialog and click OK.

Creating a Query Set of Advanced Conditions

The user can configure the Action Items type to be scheduled based on the Advanced
Conditions rules as shown in the following.

New Action Type Fields and Field Description

Field/Control Name Description Property

Query Action Defines the Action Item as a Query Action used to ~ Checkbox
generate the letter and used as a placeholder.

Advanced Enables the user to configure an Advanced User Selectable

Conditions Conditions Rule for creating the Query Type Action

Item in the case.

User Group Enables the user to define a User group (undeleted Type Ahead
user groups in Access Management) for the Action
Item created in the case.

Letter Placeholder Enables the user to enter Letter Text that printsin ~ Text (1000
Content the letter using the Open Query placeholder. characters)
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Due In (days) When the action item is created on the Case form, -
this option enables the user to define the number of
days until the Action Item is due..

Be aware of the following;:

s The Advanced Conditions, User Group, Letter Placeholder Content, and Due In
fields are enabled only if Query Action is checked.

»  The system tracks any changes made to the profile switch in the audit log.
»  The Action Type report prints any additional fields.

»  The system has a profile switch to enable the user to generate open queries when
he/she saves the case.

— No (Default) - When the user clicks No, the system does not generate open
queries in the case when the user saves the case.

- Yes - When the user clicks Yes, the system generates all action items with a
query action type based on the advanced conditions defined for the Action
Taken due in xxx days for User group yyy

where:

xxx is the number of action items defined + the System Date for the defined
user group

yyy is the user group
—  The system tracks changes made to the Profile Switch in the audit log.
Use the following procedure to create a query set of advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced
Conditions icon

2. A dialog that prompts for the creation of an advanced condition query set opens.

3. Click Yes to create a set of advanced conditions by linking together those
advanced conditions that have been defined previously.

4. The Advanced Condition Set dialog opens.

In this dialog, previously-created advanced conditions can be linked together
using set operators like UNION, MINUS, and INTERSECT.
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Click Add to add an advanced condition to the query set. A new row opens in the
advanced condition selection area. In this row, select an appropriate advanced
condition from the Advanced Condition list.

Tip: To modify, open, or delete advanced conditions, click Open in
the Advanced Conditions dialog. A list of all the advanced conditions
will be displayed. In this list, select the appropriate advanced
condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced
condition, click Show SQL. Make the required modifications to the
SQL statement, if necessary.

Select an appropriate set operator from the Set Operator list. This set operator will
link this advanced condition to the next advanced condition.

To add the next advanced condition to the query set, click Add.

Repeat steps 5 through 7 for each advanced condition that must be entered in the

query set.

Tip: If the required advanced condition is not already present in the
list, it can be created by selecting (New) from the list.

s If an existing advanced condition requires modification, select it
and click Edit.

s The advanced condition can be edited by a user only if it was
created by that user.

9. When each of the advanced conditions for the query set is entered, click Save.

10. Enter a name for the advanced condition and click OK.
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Tip: Tip: To view or modify the SQL statement associated with an
advanced condition, click Show SQL. Make the required

modifications to the SQL statement, if necessary.

The Hit List Tab

The Hit List tab in the Advanced Condition Set dialog can be used to search for cases
that match the query set criteria.
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1. Click Find Now in the Hit List tab of the Advance Conditions dialog.

This runs a search based on the selected query set criteria and displays a list of
cases (if any) that satisfy the advanced condition query set.

2. Perform these operations to do the following:

To... Click...

%\/[anually add an existing case to the hit Add and enter the Case ID
ist

Remove a case from the hit list Remove

Save the hit list result for future use Store Hit List

Retrieve results of the saved hit list Retrieve Hit List

Save the hit list as a text file Export

View SQL for Query Show SQL

Run a Query Find Now
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Best Practices

This chapter provides best practices for features such as eVAERS and E2B (R3), the
administrator of a multi-tenant environment best practice information.

Overall switching the system to eVAERS

Implement the following best practices in eVAERS:

Configuring Reporting Destination for eVAERS Profile

It is recommended to configure a Reporting Destination with the following settings to
enable reports to be sent in eVAERS format:

= Message profile to be selected as 'CBER eVAERS V1.0 MESSAGE TEMPLATE"
(standard profile for eVAERS)

= Acknowledge profile to be selected with any of the standard E2B (R2)
acknowledgement templates

= When eVAERS profile is selected, Message type is automatically set as XML and
‘Maximum # of reports to include in the msg' is set to 1 as batching of report in an
xml is not supported in this release

When vaccine reporting is being done using VAERS for Regulatory reporting and
eVAERS for Pilot testing, then it is recommended to create a new Reporting
Destination for eVAERS.

When vaccine reporting is switched over from the VAERS to eVAERS, then it is
recommended to configure eVAERS to the Reporting Destination that was used for
sending VAERS report.

Configuring Business Logic For Data Elements Without Default Logic Using UDF Fields

The default export logic is not provided for the some of eVAERS data elements in this
release.

Companies can send data for such data elements using customization as per the steps
defined below:

Step 1: Define UDF Field

User Defined Fields can be used as per the following table, and users can input data in
those fields from the Case Form UL
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Length as per

eVAERS Data Description of UDF eVAERS
Element Data Element UDF in Ul Type Specification Comments
patientprefix =~ Patient Prefix = Patient>Patient Text 50
Information
patientfax Patient FAX Patient > Patient Text 18
Information
patientemailad Patient Email ~ Patient>Patient Text 100
dress Address Information
patientrace2 Patientrace2  Patient>Patient Number 50
Information (Drop
Down)
patientethnicity Patient Patient >Patient Number 50
group Ethnicity Information (Drop
Group Down)
parentprefix Parent Prefix ~ Patient>Patient Text 50
Information
parentgivenam Parent First Patient > Patient Text 35
e Name Information
parentmiddlen Parent Middle Patient>Patient Text 15
ame Name Information
parentracel Parent race 1 Patient > Patient Number 50
Information (Drop
Down)
parentrace2 Parent race 2 Patient > Patient Number 50
Information (Drop
Down)
parentethicityg Parent Patient > Patient Number 50
roup Ethnicity code  Information (Drop
Down)
hospitalname  Hospital Name Events > Event Text 200 Field length
Information of 200
characters
cannot be
accommoda
ted using a
UDF, hence
a maximum
of 100
characters
can be
supported.
hospitalcity Hospital City ~ Events > Event  Text 35
Information
hospitalstate Hospital State ~ Events > Event  Text 40

Information
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Length as per
eVAERS Data Description of UDF eVAERS
Element Data Element UDF in Ul Type Specification Comments

vaccadmintitle Title Vaccine Text 50 It is not
recommend
ed to
custom map
this data
element as
vaccineadmi
nistration
block will be
repeatable
block in the
next release

vaccadminfna  First Name Vaccine Text 35 Itis not

me recommend
ed to
custom map
this data
element as
vaccineadmi
nistration
block will be
repeatable
block in the
next release

vaccadminmna Middle Name  Vaccine Text 15 Itisnot

me recommend
ed to
custom map
this data
element as
vaccineadmi
nistration
block will be
repeatable
block in the
next release

vaccfacilityfax  Facility Fax Vaccine Text 18 It is not

Number recommend
ed to
custom map
this data
element as
vaccineadmi
nistration
block will be
repeatable
block in the
next release
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Length as per
eVAERS Data Description of UDF eVAERS
Element Data Element UDF in Ul Type Specification Comments

vaccfacilityema Facility Email ~ Vaccine Text 100 It is not

iladdress Address recommend
ed to
custom map
this data
element as
vaccineadmi
nistration
block will be
repeatable
block in the
next release

respphysicianti Title Vaccine Text 50 Itis not

tle recommend
ed to
custom map
this data
element as
responsiblep
hysician
block will be
repeatable
block in the
next release

respphysicianf ~ First Name Vaccine Text 35 Itis not

name recommend
ed to
custom map
this data
element as
responsiblep
hysician
block will be
repeatable
block in the
next release

respphysician ~ Middle Name  Vaccine Text 15 It is not

mname recommend
ed to
custom map
this data
element as
responsiblep
hysician
block will be
repeatable
block in the
next release
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Length as per
eVAERS Data Description of UDF eVAERS
Element Data Element UDF in Ul Type Specification Comments

phyfacilityfax  Facility Fax Vaccine Text 18 It is not

Number recommend
ed to
custom map
this data
element as
responsiblep
hysician
block will be
repeatable
block in the
next release

phyfacilityemai Email Address Vaccine Text 100 Itis not

laddress recommend
ed to
custom map
this data
element as
responsiblep
hysician
block will be
repeatable
block in the
next release

vaccfacilitymili Military Site Products > Number 50
nd Indicator Product Vaccine (Drop
Down)

patmilstatus PatientMilitary N/A Number 10 It is not
Status (Drop recommend
Down) ed to

custom map
this data
element as
this data
element will
be moved to
Patient
block in the
next release

spprodcategory FDA Products > Number 100
Specialized Product Vaccine (Drop
Product Down)
Category

Since the length of the standard UDF Text field is 100 characters, the maximum length
of data that can be sent for hospital name data element is 100 characters. The system
will be enhanced to capture hospital name data through a standard field and this
limitation will be taken care in a future release.

If the length of a data element is less than 100 characters as per eVAERS guidelines
and if data is entered upto 100 characters, then system displays error while generating
eVAERS report, hence it is recommended to enter by considering the length specified
in the 'Length as per eVAERS specification' column of the above table.

Step 2: Provide custom export logic for the required data element
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eVAERS standard profile can be copied to create a copy of custom profile and SQL for
the required data element can be modified to map the data element to the
corresponding UDF.

Step 3: Configure a Reporting Destination with the Custom eVAERS profile

The custom eVAERS profile created in Step 2 to be specified in the Reporting
Destination that is identified for sending eVAERS reports.

Configuring Reporting Rules

When vaccine reporting is being done using VAERS for Regulatory reporting and
eVAERS for Pilot testing, then it is recommended to create a new Reporting Rules for
eVAERS.

When vaccine reporting is switched over from the VAERS to eVAERS, then it is
recommended to configure eVAERS to a new Reporting Rule and to de-activate the
rule for VAERS report.

Configuring Codelists

It is recommended to configure Codelist data using Flexible Data Re-categorization
codelist to ensure legacy Vaccine data is properly represented in eVAERS report.

The values allowed for some fields in eVAERS is slightly different from VAERS report,
hence it is recommended to configure the existing codelist values with appropriate
NCI_CODE in the Flexible Data Re-categorization Codelist so that appropriate data is
sent in eVAERS reports.

Relation to Patient

Codelist List Value NCI_CODE
Vaccine Provider C102430
Patient/Parent C16960 or C42709

Anatomical Location

Anatomical Locations codelist is now provided with Factory data along with NCI_
Codes. If Companies already have entered data in this codelist and if this data has
been used in the Vaccine cases prior to upgrade to 8.0 release, it is recommended to do
the following:

= update the NCI codes for the existing data in Anatomical Location codelist using
Flexible Data Re-categorization codelist

= set 'Display' to No, for the new factory data provided in Codelist > Anatomical
Location

Ethnicity

Ethnicity codelist is now provided with Factory data along with NCI_Codes. If
Companies already have entered data in this codelist and if this data has been used in
the Vaccine cases prior to upgrade to 8.0 release, it is recommended to do the
following:

= update the NCI codes for the existing data in Ethnicity codelist using Flexible Data
Re-categorization codelist
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= set 'Display' to No, for the new factory data provided in Codelist > Ethnicity

Vaccination Funds

Vaccination Funds codelist provides separate options for Others and Unknown.
However prior version of the application had factory data as 'Other/Unknown' in
LM_PURCHASED_WITH table. If customers have cases with 'Other/Unknown' data
then it is recommended to customize the mapping of the data element
<vaccpurchased> to consider the existing 'Other/Unknown' as 'Other’ or 'Unknown'.

Vaccination Facility

Vaccination Facility codelist provides distinct options for facility types. However prior
version of application had factory data as follows in LM_VACCINATED_AT table. If
there are legacy cases with any data same as the value provided in the below table, it is
recommended to update the NCI codes for these codelist values as per NCI_CODE

column.

Codelist List Value NCI_CODE
Private Doctor's C16988 or C16696
Office/Hospital

Public Health (51282 or C16696
Clinic/Hospital

Military Clinic/Hospital C51282 or C114861 or C16696 or any other appropriate NCI_CODE

Setting up the Application Type in Business Configuration > Products and Licenses

FDA requires the use of a prefix to determine the application type associated with
suspect products. For licensed vaccines, include the appropriate acronym "BLA" "STN"
or "PLA" followed by the primary six-digit number. Hence, it is recommended to
update the newly added column in Business configuration > Products and Licenses >
License > Application type with appropriate license types.

Optional upgrade scripts for data migration to new fields

This section describes optional scripts for data migration to new fields.

lliness at the time of Vaccination

Illness at the time of Vaccination data is used in eVAERS report and this data is
captured in Case Form > Patient > Other Relevant History > Condition Type = 'Illness
at Vac'.

LLT code and MedDRA version of the ORH record with Condition Type as 'Illlness at
Vac' is transmitted in data elements illnessatvaccination and
Illnessatvaccinationmeddraversion respectively.

VAERS report continues to map Illness at the time of Vaccination with the
corresponding field in Vaccine tab.

If Illness at time of Vaccination in Vaccine tab has data in legacy cases, then this data
can be copied to Case Form > Patient > Other Relevant History by executing the
optional upgrade scripts providing along with this release. It is recommended to keep
this data in ORH and Vaccine tab in sync so that same data is presented in VAERS and
eVAERS report.
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Emergency Room Visit

Emergency Room Visit data is used in eVAERS report and this data is captured in Case
Form > Event > Emergency Room Visit (checkbox). If this checkbox is checked, then
seriousnesservisit data element is transmitted as true. If this checkbox is unchecked,
then null flavor NI is transmitted.

VAERS report continues to map Emergency Room visit data with the field Required
ER visit in Vaccine tab.

If Required ER visit checkbox is ticked in Vaccine tab in legacy cases, then this data can
be copied to Case Form > Event > Emergency Room Visit by executing the optional
upgrade scripts providing along with this release. It is recommended to keep this data
in Event tab and Vaccine tab in sync so that same data is presented in VAERS and
eVAERS report.

Prior Adverse Event

eVAERS report transmits LLT code and MedDRA version data from Case Form >
Product > Vaccine > Prior Adverse Event. VAERS report continues to print the
verbatim text entered for Adverse Event in box 21 as per existing functionality.

It is recommended that customers manually encode the Adverse Events in Case Form
> Product > Vaccine > Prior Adverse Event using Encode button so that required
information is populated in eVAERS report.

Validation of Case Prior to Generation of eVAERS

E2B check feature is used to validate the case against E2B profiles and E2B check
report provides a list of validations that are failing which enables user to correct case
data prior to actual report generation.

In this release, E2B check will not validate the case against eVAERS profilem hence it is
recommended to perform E2B check on the case prior to eVAERS report generation
and check for validation messages that are listed for E2B (R3) profile, as the data
elements in E2B (R3) profile is a subset of data elements in eVAERS profile.

Configuring E2B (R3) Reports

This section lists the ways to configure E2B (R3) Reports.

Configuring Reporting Destination for E2B (R3) Profile

It is recommended to create separate Reporting Destination for E2B (R3) profile. The
configuration of Reporting Destination for E2B (R3) is same as that of E2B (R2) profile
except for the following changes:

= Message profile to be selected as 'ICH-ICSR V3.0 MESSAGE TEMPLATE'
(standard profile for E2B (R3)) or any customized E2B (R3) Profile.

= Acknlowledge profile to be selected with any of the standard E2B (R2)
acknowledgement templates.

s When E2B (R3) profile is selected, Message type is automatically set as XML and
‘Maximum # of reports to include in the msg' is set to 1 as batching of report in an
xml is not supported in this release.

The system verifies the file format of the incoming xml files and will either proceed
with import or reject files based on the type of files that are expected by the Reporting
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Destination, i.e. if a E2B (R3) file is received for a Reporting Destination configured
with E2B (R2) profile, the file will be rejected and vice versa.

Configuring Common Profile Switches for E2B (R3) Reports

The Common Profile switch 'Default viewing format of the E2B report (used with
Interchange)' and 'Default DTD ' are used for both E2B (R2) and E2B (R3) reports.

The following are the recommended Common Profile Switch settings:

s Default view switch can be set to SGML or Decoded View as these views are
common for E2B (R2) and E2B (R3) reports

s Default DTD can be configured with only profile so either E2B (R2) or E2B (R3)
report can be generated using Draft tool button

Configuring Common Profile Switches for E2B (R3) Reports

When E2B (R3) report is received from a Partner or an Agency, the report is
downgraded from E2B (R3) to E2B (R2) format using BFC xslts and then imported to
Argus database using the profile that is set in the Internal Common Profile Switch
'E2B_R3_IMPORT_PROFILE'. By default, the switch is set to TCH-ICSR V2.1
MESSAGE TEMPLATE'. An Acknowledgement is generated by the system in E2B (R2)
format using Ack profile configured for that Reporting Destination. The
acknowledgment is then upgraded to E2B (R3) format and sent to the sender of the
report.

H.1 (Case Narrative) data in E2B (R3) report can be upto 100,000 characters, while
importing E2B (R3) report with H.1 data element having 100,000 characters, the
downgraded reports retains the complete data and it is imported to Narrative field.
Please refer to the Backwards and Forwards Compatibility Recommendations in the 3_
ICH_ICSR_BFC_Specification_v2.00_clean.pdf provided by ICH.

Attachments in E2B (R3) and eVAERS Reports

ICSR Attachments can be sent in E2B (R3) and eVAERS reports. Reporting Destination
for E2B (R3) / eVAERS needs to be configured for sending attachments by marking
‘Transmit E2B Attachments' and selecting the 'Attachment classification' that are
required to be sent as inline attachments in these reports.

Attachments within E2B (R3) and eVAERS reports are encoded using B64 format.

For E2B (R3) reports, attachments are compressed in the format specified in the
Internal Common Internal Profile switch 'ZIPSTREAM_COMPRESSION _
ALGORITHM'. DF (Deflate) is the default compression algorithm used for
compressing attachments; other options supported are GZ and ZL.

Attachments file size are not checked for E2B (R3) reports during report generation or
transmission, hence it is recommended for the users to review the size of the
attachments that will be included in E2B (R3) report prior to Report generation.

For eVAERS reports, the following Common profile switches with default settings
allows the file types that can be added as attachment and overall size of eVAERS
report:

»  File attachments allowed for eVAERS for determining the appropriate file type
that can be included as inline attachments. Default value of this switch is
pdfjpeg,jpg bmp, png,gif tif tiff rtf, txt,xIs,xlsx,doc, docx,wpd as per file format
recommended in eVAERS guidelines.
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= Allowed file size for eVAERS (in MB) for determining the maximum file size
(inclusive of attachment data and Case data) of eVAERS report and default value
of this switch is 20 MB.

As per eVAERS guidelines, attachments sent in the previously submitted reports
should not be sent again in the follow-up or Amendment reports. In this release, check
to verify if the attachments were sent in previous version is not built. Hence we
recommend users to select the Attachment classification that does not qualify for
eVAERS reporting in the follow-up revision of the case so that it is not sent again or
alternate method would be to customize the mapping logic for the data elements
C4r2and C.1.6.1.r.2.

Creating and Managing Amendments for eVAERS and E2B (R3) Reports

When to create Amendments?

If an Initial / Follow-up eVAERS / E2B (R3) reports are submitted to a Reporting
Destination/Agency and then if there is a request from Agency to send the
attachments, amendments can be created by unlocking the case as significant
follow-up and ticking the 'Amendment' checkbox in Case Form > General Tab >
Follow-up section and provide the reason for creating Amendments.

Users can include Attachments and provide the details of the attachments in Case
Summary.

Auto-scheduling of Amendment Report

Auto-scheduling will then schedule Amendment reports for the Reporting Destination
configured for eVAERS / E2B (R3). Follow-up reports are scheduled for Non E2B,
E2B (R2) reports if the case satisfies Reporting Rules configured for those reports.
These reports are not capable to handle Amendments hence Follow-up reports are
scheduled.

Manual Scheduling of Amendment Report

Amendment reports for eVAERS / E2B (R3) can be manually scheduling using
'Scheduling New Expedited Report' dialog. Users can select the Aware date pertaining
to the Amendment and schedule an eVAERS / E2B (R3) report. Aware date pertaining
to an Amendment can be identified by text ' (A)' appended to the Aware date. It is
recommended to have only one amendment for an Aware date, else it may be difficult
to identify the latest amendment from Aware date drop down in the 'Scheduling New
Expedited Report' dialog.

If a user manually schedules Non E2B or E2B (R2) reports for an Amendment Aware
date, then system schedules follow-up report if there is a previously submitted report
of the same report type to the same agency, else will schedule an Initial report.

Other Recommendations

It is not recommended to create Amendments for minor Case Form changes as
Amendments are meant for significant changes without new aware dates. Capability
to allow users to create Amendments for Non-significant changes will be provided in
Future releases based on inputs from Agencies and Customers.

Amendments can be created only when there is a previously submitted eVAERS / E2B
(R3) report.

Best Practices in a Multi-Tenant Environment

This section lists the the best practices to follow in a multi-tenant environment.
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Single Sign-on
Single Sign-on needs to be enabled to have the capability to switch client context and
to open the Argus Safety application from the Global Worklists/ Application Access

Portlet. If SSO is enabled, then it becomes mandatory for a user to be configured as an
LDAP user in all the enterprises where the data displays on the screen/portlet.

Accessing Argus Safety Directly via URL

It is expected that the you will pass the internal Enterprise ID as a URL parameter for
the Argus Safety application to open with the appropriate Enterprise context. If
Enterprise ID is not passed, the user is validated against the default enterprise.

For ESM Mapping Utility and EOSU Tool which are client-server applications and do
not have a mechanism to specify the Enterprise ID, will always validate users against
the default enterprise. Hence, users that are expected to login into these applications
are configured with appropriate access/roles within default enterprise. For this reason,
"Active" checkbox for the default enterprise is always marked checked and disabled in
Global Enterprise Management screen.

Global Homepage and Portlets

Set up appropriate Portal user and user group privileges to restrict access to Portlets
and the Global Homepage. It is recommended that you configure the out-of-the-box
Portlets so these (specified below) are accessible to all multi-tenant users who need to
access data across multiple enterprises, except the ones specifically recommended for
administrators.

= Global Worklist - New

= Global Worklist - Open

= Global Worklist - Action Items

= Global Worklist - Contacts

= Global Enterprise Management: Recommended for Administrators
= Global User Management: Recommended for Administrators

= Application Access Portlet

Global Worklists Columns

The system allows flexibility to hide some of the fields/columns in the Global Worklist
Portlets through the Global Worklist grid/menu XML(s) which resides on the Web
Server(s). It is advisable to hide only those fields/columns which are not updated nor
referred by any Worklist context menu actions.

Global User Management

In order to apply updates to the "Synchronizable" fields to all the enterprises in the
system, you should maintain some administrative users with the Console'Access
Management 'Groups' Menus 'Console: Access Management: User menu access
enabled for all enterprises in the system.

User-Enterprise Association

When a user is copied from one enterprise to another, it is expected that you have set
up the appropriate site and the usergroups in the target enterprise. Otherwise the
user-association with fail with the appropriate error message.
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New User Creation/Association

Argus Console allows same UserlD to be used to create different users across multiple
enterprises. It is recommended that this feature is only be used if users are not
expected to be shared across enterprises. Otherwise, if users are expected to be shared
across multiple enterprises, then same UserID will not be used to create different users
across different enterprises. Instead of that, a user created in one enterprise is
associated to other enterprises through Global User Management.

Inactivating an Enterprise

It is recommended that you first archive all the cases belonging to the Enterprise
before inactivating the Enterprise.

New Enterprise Setup

It is expected that you create and choose the appropriate Enterprises with generic
configuration data which can be used as source for copying the configuration data for
creation of a new enterprises. Following is a list of items that the you are
recommended to ensure that the values being copied from the source enterprise are
appropriate for the newly created enterprise:

= Advanced Conditions used within any configuration item
= Reporting Destination Code List ' Company identifier field values
= System Numbering and LAM System Numbering Formats

= ESM Mapping Utility ' Setup INI File Setup ' Service DB Setup ' Outgoing and
Incoming folders for each Agency.

Common Profile Switches
= MedWatch Configuration
= Documentum configuration

= Lot Number Web Service Configuration

Segregated by Enterprise

Following is the list of items that are segregated by enterprises. It is recommended that
you configure distinct values across enterprises to ensure proper data segregation
across enterprises

= Literature Intake folder: Argus Console ' Common Profile Switches ' Argus J '
Shared Path for the Literature Intake

»  Case Intake folder: Argus Console ' Code List ' User Sites ' Intake File Path

= Path for New Case from Image: Argus Console ' Common Profile Switches ' Case
Processing ' Default Network directory for scanned images

= E2B Incoming Folder: ESM Mapping Utility ' Setup INI File Setup ' Service DB
Setup ' Incoming Folder

= Site Printers: Argus Console ' Code List ' User Sites ' Site Printers ' Path

Maintaining Consistency Across Enterprises

The following is the list of items that are segregated by enterprises but the CRO is
recommended to maintain consistent across all enterprises:

s  Common Profile Switches ' Argus Insight URL
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s Common Profile Switches ' Argus Safety Load Balancer Server

= System Configuration ' Enabled Modules

Shared Across Enterprises

Following is the list of items that are common for all enterprises

= MedDRA and WHO Web Services

s Common Profile Switches ' Security ' LDAP ' Enable/disable LDAP

s Common Profile Switches ' Security ' LDAP ' LDAP Server configuration
s Common Profile Switches ' Security ' Enable/disable SSO

s Common Profile Switches ' Security ' SSO Header Configuration

s Common Profile Switches ' Case Processing ' Where to store temporary case
information during data entry

s Common Profile Switches ' Case Processing 'Auto Archiving ' The database job
and its frequency - "Execution Period (in Days)"

n  Default Enterprise

The common profile switches (related to SSO, LDAP, Auto Archiving job &
frequencyand Temporary Case Data Storage) which are common for all enterprises
will only be displayed, updated and audit logged in DEFAULT enterprise. This is
because any update to global level profile switches impacts all enterprises and is
controlled. Also, such an update will also require propagation of the audit log to all
other enterprises where the current user may not even exist or may not have proper
access.

Pre-upgrade Considerations for Existing Databases

Make sure that all the AG Service users (login user id) in all the databases that are to
be merged into single database are in sync with the DEFAULT ENTERPRISE. If there
are AG Service users in other enterprises which do not exist in the DEFAULT
ENTERPRISE, then you can either rename their login user IDs to map them to existing
AG Service users in the DEFAULT ENTERPRISE or delete them. If extra users are
found in other enterprises during multi-tenant database migration, then they will be
marked disabled and you will not be enable them later.

Make sure that all the event & indication and who-drug encoding dictionaries used in
Argus Console ' System Configuration 'Common Profile Switches '‘Case Form
Configuration 'Auto Encoding, Dictionary and Central Encoding section and Argus
Console ' Business Configuration 'Studies 'Enable Study Specific Encoding 'Auto
Encoding dialog, in all databases that are to be merged into single database are already
loaded in the target database with the same name. This is required to enable the
automatic linking of dictionaries configured in the separate databases to the already
existing dictionaries present in the target database during the database merge
script/process.

Post-upgrade Considerations for Existing Databases

E2B Outgoing and Incoming folders is configured again in ESM Mapping Utility
because various folders for different transmission methods are now merged as one
pair of folders for all transmission methods. Now these are saved into database rather
than the ESM Service INI file.

Best Practices 8-13



Best Practices in a Multi-Tenant Environment

Document Type field value from ESM Service configuration and AG Service
configuration tool is now be configured again into Argus Console ' Common Profile
Switches ' Documentum configuration as these fields are now moved to Argus
Console.

Make sure that all the event & indication and who-drug encoding dictionaries used in
Argus Console ' System Configuration 'Common Profile Switches '‘Case Form
Configuration 'Auto Encoding, Dictionary and Central Encoding section and Argus
Console ' Business Configuration 'Studies 'Enable Study Specific Encoding 'Auto
Encoding dialog, in the newly migrated enterprises are linked properly to the global
dictionaries already present in the target database. This is required to correct any
dictionary configuration linking that could not be done automatically by the database
merge script due to mismatch in dictionary names in the source and target databases.

Documentum Migration

Existing single-tenant as well as multi-tenant Documentum users upgrading to AS 7.0
release, and are migrating /keeping all the documents in the Documentum server, is
also add additional attributes- "enterprise_id" and "enterprise_short_name" and
populate these appropriately for all their documents that are to be accessed by Argus
Safety in Documentum server.

Existing single-tenant as well as multi-tenant users which are upgrading to AS7.0
release, and have configured "Use Logged in User's Username/Password" for Argus
Console ' System Configuration ' Common Profile Switches ' Document Management
for Case Attachments will switch to Common Username/Password for Documentum
login if not already configured for E2B, Expedited and Periodic Reports.

MedDRA and WHO Webservices: As MedDRA and WHO webservice is common for
each enterprise, it will use only single version for encoding events and drugs.
However, as these web services use the dictionaries configured in Argus Console '
System Configuration 'Common Profile Switches 'Case Form Configuration 'Auto
Encoding, Dictionary and Central Encoding section for the respective enterprises for
populating dictionary id and dictionary version information for the encoded items,
configure these dictionaries as same across all enterprises.
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